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Preface

Purpose of the Manual

Target Audience

Scope

Technical Support
If you have any further questions regarding  , do not hesitate to contact your local Siemens representative.
Assistance with queries regarding   is also available on the following Internet site:

Training Courses
Further training material is available on the following Internet site:

Notes on Safety
This manual is not a complete index of all safety measures required for operation of the equipment (module or
device). However, it comprises important information that must be followed for personal safety, as well as to
avoid material damage. Information is highlighted and illustrated as follows according to the degree of
danger:

! WARNING
WARNING means that death or severe injury may result if the measures specified are not taken.

² Comply with all instructions, in order to avoid death or severe injuries.

! CAUTION
CAUTION means that medium-severe or slight injuries can occur if the specified measures are not taken.

² Comply with all instructions, in order to avoid moderate or minor injuries.

ii
NOTE
Important information about the product, product handling or a certain section of the documentation
which must be given particular attention.
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Security Information

Siemens provides products and solutions with industrial security functions that support the secure operation
of plants, systems, machines and networks.
In order to protect the plants, systems, machines and networks against cyber threats, it is necessary to imple-
ment – and continuously maintain – a holistic, state-of-the-art industrial security concept. Siemens’ products
and solutions only form one element of such a concept.
Customer is responsible to prevent unauthorized access to its plants, systems, machines and networks.
Systems, machines and components should only be connected to the enterprise network or the internet if and
to the extent necessary and with appropriate security measures (for example, use of firewalls and network
segmentation) in place.
Additionally, Siemens’ guidance on appropriate security measures should be taken into account. For more
information about industrial security, please visit http://www.siemens.com/industrialsecurity.
Siemens’ products and solutions undergo continuous development to make them more secure. Siemens
strongly recommends to apply product updates as soon as available and to always use the latest product
versions. Use of product versions that are no longer supported, and failure to apply latest updates may
increase customer’s exposure to cyber threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed under http://
www.siemens.com/industrialsecurity.
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Description
After you install powermanager, you can view the powermanager online help in CHM format.

1.1

Help on Help
1.1 Description
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CHM Help
The Help consists of 3 windows (frames):

Display of Topics
The individual pages are displayed on the right-hand side. For more information, see 1.3 Typography.
There are linked pages with explanations for the subchapters for the main chapter.

3 Tabs on the Left-Hand Side

• Contents: Tree-structured overview of the contents. Folders marked with a + contain subdirectories or
individual pages. If you prefer help in a logical, book-like form, click from top to bottom through the
directory or use the browse sequences (see sequential topics).

• Search: Here you can perform full-text searches. Enter the term you want to search for in the Type in the
word(s) to search for field. If the word exists, an appropriate page is displayed. Click Options > Search
Highlights On to highlight the search terms. The search terms are sorted by frequency of occurrence.
You can also alphabetically sort the topics by clicking the table header of the display.
Initially, activate Search titles only in the check box below. Only when the required result is not found,
click Match similar words. You can also use wildcards such as * (for any number of characters) or ? (for
one character). You can restrict your search result by using terms in quotation marks (for example, Insert
config).

• Favorites: Here you can use Add to add the current page to your favorites. Select Remove to remove the
page again or Display or double-click to display the pages.

Sequential Order of Topics
A window where the topic pages of the chapter in question are displayed is found above the topic. The current
page is always marked blue. You can use the Previous and Next arrows to go to the previous or next page
within the chapter. You can select the main chapters of the documentation from the list box under the naviga-
tion arrows.
You can therefore read adjacent chapters and sections of chapters in sequential order as in a book.

The Icon Bar
The icon bar largely corresponds to the Internet standard:

• Hide: Hides the left pane with the tabs. Select Display to display it again.

• Find: Displays the location of your page in the contents.
This command is important for navigation. You can continue scrolling from the displayed location of the
contents.

• Back, Forward: Jumps to the pages in the order of display.

• Cancel: Stops the page from loading.

• Refresh: Updates the page.

• Start page: Takes you back to the start page of the help.

• Print: Prints the displayed page.

• Options: A menu of the previously listed buttons, Internet options, and print options can be set here.

1.2

Help on Help
1.2 CHM Help
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Typography
The following font types are used in this online help:

ii
NOTE
The background of the text is highlighted. This option is available only with Windows.

Commands (for example, command line) use the following font:
WCCILdata –snd 2
Examples (for example CTRL scripts) use the following font:
main ()
{
...
}
File names within a paragraph use the following font:
config
Buttons, names, or menu options use the following font:
Cancel

ii
NOTE
Contains useful tips, as well as, further information.

1.3

Help on Help
1.3 Typography
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Prerequisites for powermanager

Hardware Requirements

Hardware requirements depend on the size and dynamics of the projects. A large number of statistical data-
point functions (for example, compression of readings, and A/C) have a negative impact on start time and
capacity, and must be considered.
The following items have a decisive effect on the hardware requirements:

• Respective computer (for example, UI client only)

• Number of managers running

• number of managers linked (for example, user interfaces)

• External software running
In general, a high capacity of memory and CPU power improve the overall performance of the powermanager
projects.

ii
NOTE
Hard disk storage capacity refers to the powermanager installation only and to the space required to start a
minimum project (without going into the Emergency mode). For larger projects, recording historical data,
alert archives, log files, and others, you must calculate the possibility for more storage capacity.
The size of the swap file must be 1 or 2 times the size of the working memory (RAM) and should not be
floating. This file is hidden under Windows to store the program components and data files that were
swapped out because of very low working memory. A similar size should be used for the /swap partition of
a Linux system.

Depending on the planned usage, powermanager supports a wide range of input devices (for example,
mouse, keyboard, touchscreen, and trackball).
For controlling a development system (image creation, scripting, configuration, and so on), it is highly recom-
mended to use a mouse with at least 2 buttons and a standard keyboard.

Network Requirements
When setting up the hardware for powermanager project, perform benchmark tests before installing power-
manager to avoid problems due to insufficient hardware performance (perform the tests when using redun-
dant systems).

Network Connection
The network connection between the servers and clients must be at least 100 MBit. A fast connection
between the servers in redundant system is necessary. Additionally, a time synchronization is required within
the network.

Performance Test of the Copy Process
In redundant systems, database files are copied during the recovery. Therefore, a sufficient read and write
performance must be guaranteed. To check if the network can handle the workload, you must check the
transfer rate.
Measure the time of the following processes:

• Copy large files (for example, HDB-datasets > 500 MB) from one system to another.

• Copy the same files to the local disk to test the local disk performance without network overhead.
The transfer rate in a standard system must be 50 MB/s to 100 MB/s.

2.1

2.1.1

Installation
2.1 Prerequisites for powermanager
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Use of Multi-Core Processors
The CPU development of the last few years has increasingly brought real multi-core processors in the market
which are able to run multiple processes at the same time. Thus, the achievable total performance could be
significantly increased.
Intel has done this with the Core2Duo/Core2Quad models and the new i3/i5/i7 series, and AMD with the
Athlon/Phenom(II) X2/X3/X4 models.
By design, powermanager is realized in a single-threaded way which means that a powermanager manager
uses only one of these threads (also known as HW strands). The most important and the most claimed
managers of a powermanager project are the Eventmanager and the Data manager, wherein each one of
them claims only one thread. According to the case mentioned, only 2 of the 128 available threads are used,
wherein, the system at full load on the Event/Data manager uses only 1/64 of the total CPU performance.
Starting from one core (with one thread) up to 4 cores (each with one thread), powermanager achieves an
increasingly better performance. In case of further cores, the performance gain per additional core/thread is
relatively low. In addition, powermanager benefits from a higher clock rate of the CPU. For example, 4 cores
each with one thread (= 4 threads) clocked with 3 GHz, powermanager uses much better than 8 cores with 8
threads (= 64 threads) clocked with 1 GHz.

Minimum Hardware Requirements (Local System)
The following hardware requirements are for a small project without a high level of dynamics and with one or
no user interface. The enumerated hardware components correlate with each of the following configurations,
only the difference in the specification is mentioned.
The following recommendations describe the minimum hardware configuration that is required for power-
manager in specific use cases:

• powermanager General:
The minimal recommended hardware for using powermanager

• Development System:
Development workstation for creating new powermanager projects

• Small Server:
Server configuration for a small powermanager system

• Large Scale System Server:
Server configuration for large plant projects

• Remote Client:
Minimal hardware recommendation for remote user interface clients

ii
NOTE
A personal computer with x86_64 architecture is required.

Additional information that should be considered for planning your powermanager system:

• Siemens SIMATIC Nanobox PCs

• Network requirements

• Use of multi-core processors

Minimum Recommendation (powermanager General)

Hardware Component Specifications
Processor Intel Atom Dual Core 1.6 GHz (or equivalent)
RAM 2 GB
Hard disk HDD with 5 GB free disk space
Graphics Resolution: 1024 x 768 pixels

Installation
2.1 Prerequisites for powermanager
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Hardware Component Specifications
Network adaptor 10/100 MBit/s
USB interface For the licensing of powermanager with a hardware dongle, a free USB port

is required.

Minimum Recommendation - Remote Client

Hardware Component Specifications
Processor Intel Atom Dual Core 1.6 GHz or equivalent
RAM 2 GB RAM
Hard disk HDD with 5 GB free disk space
Graphics Resolution: 1280 x 1024 pixels
Network adaptor 10/100 MBit/s

Minimum Recommendation - Small Server and Large Scale System Server

ii
NOTE
With an additional server, the PC load can be reduced. The system configuration is based on the default
system settings (number of polled and archived datapoints).

Table 2-1 Small - 20 devices (Number of servers: 1)

Server Hardware Hardware Component Specifications
Processor Intel i5/i7 /Xeon Quad Core with 2.4 GHz

or equivalent
RAM 8 GB
Hard disk space for installation 10 GB free disk space
Hard disk space for archive 5
years (default settings)

15 GB

Graphics Resolution: 1280 x 1024 pixels
Network adaptor 1 GBit/s

Configuration Polling time for Instantaneous
values

1 s

Polling time for Energy values 10 s
Driver Smoothing No

Conditions Maximum number of data-
points

200000

Table 2-2 Small - 50 devices (Number of servers: 1)

Server Hardware Hardware Component Specifications
Processor Intel i5/i7 /Xeon Quad Core with 2.4 GHz

or equivalent
RAM 8 GB
Hard disk space for installation 10 GB free disk space
Hard disk space for archive 5
years (Default settings)

30 GB

Graphics Resolution: 1280 x 1024 pixels
Network adaptor 1 GBit/s

Installation
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Configuration Polling time for Instantaneous
values

1 s

Polling time for Energy values 10 s
Driver Smoothing No

Conditions Maximum number of data-
points

200000

Table 2-3 Small - 100 devices (Number of servers: 1)

Server Hardware Hardware Component Specifications
Processor Intel i5/i7 /Xeon Quad Core with 2.4 GHz

or equivalent
RAM 8 GB
Hard disk space for installation 10 GB free disk space
Hard disk space for archive 5
years (Default settings)

50 GB

Graphics Resolution: 1280 x 1024 pixels
Network adaptor 1 GBit/s

Configuration Polling time for Instantaneous
values

1 s

Polling time for Energy values 10 s
Driver Smoothing No

Conditions Maximum number of data-
points

200000

Table 2-4 Medium - 200 devices (Number of servers: 1)

Server Hardware Hardware Component Specifications
Processor Intel i5/i7 /Xeon Quad Core with 2.4 GHz

or equivalent
RAM 8 GB
Hard disk space for installation 10 GB free disk space
Hard disk space for archive 5
years (Default settings)

100 GB

Graphics Resolution: 1280 x 1023 pixels
Network adaptor 1 GBit/s

Configuration Polling time for Instantaneous
values

2 s

Polling time for Energy values 10 s
Driver Smoothing No

Conditions Maximum number of data-
points

200000
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Table 2-5 Large - 500 devices (Number of servers: 1)

Server Hardware Hardware Component Specifications
Processor Intel i7/Xeon Quad Core with 3 GHz or

equivalent
RAM 16 GB
Hard disk space for installation 10 GB free disk space
Hard disk space for archive 5
years (Default settings)

250 GB

Graphics Resolution: 1280 x 1024 pixels
Network adaptor 2 x 1 GBit/s

Configuration Polling time for Instantaneous
values

5 s

Polling time for Energy values 20 s
Driver Smoothing 1 %

Conditions Maximum number of data-
points

200000
Import address reduction should be
performed for all devices.

Table 2-6 Very Large - 1000 devices (Number of servers: 1)

Server Hardware Hardware Component Specifications
Processor Intel i7/Xeon Quad Core with 3 GHz or

equivalent
RAM 16 GB
Hard disk space for installation 10 GB free disk space
Hard disk space for archive 5
years (Default settings)

500 GB

Graphics Resolution: 1280 x 1024 pixels
Network adaptor 2 x 1 GBit/s

Configuration Polling time for Instantaneous
values

10 s

Polling time for Energy values 20 s
Driver Smoothing 1 %

Conditions Maximum number of data-
points

200000
Import address reduction should be
performed for all devices.

Software Requirements

Operating Systems
powermanager supports the following Siemens AG tested specifications list configurations.
Operating System Version Supported
Windows 7 Ultimate/Enterprise/Professional with SP1 (64-bit)
Windows 10 CB Version 1703 64-bit, LTSB Version 1607 64-bit, Enterprise/Professional

(64-bit)
Windows Server 2012 R2 Server 2012 R2 (64-bit)
Windows Server 2008 R2 Server 2008 R2 (64-bit)
Windows Server 2016 Server 2016 (64-bit)

2.1.2
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Operating System Version Supported
VMware • Workstation Pro (supported with all operating systems that are listed in

the table)
• ESXi Version 6.0/6.5 (supported with all operating systems that are

stated above)
• vSphere Cluster (HA) with ESXi 6.0 and ESXi 6.5

ii
NOTE
Install the TCP/IP protocol on the platforms, because managers use TCP protocol to communicate in the
powermanager.
For more information on vSphere HA Cluster, refer to the Extended help.

Name Resolution
Working name resolution is required for powermanager. If the name resolution does not work, a process is
momentarily blocked.
Ensure that the mapping of IP addresses to computer names and the mapping of computer names to IP
addresses works properly (this is also valid for computers in the network, where a remote user interface is
running).
Use an entry in the hosts file (which contains the mappings of IP addresses to host names) or use a DNS server
that allows forward (using a domain name to find an IP address) and reverse (using an IP address to find a
domain name) search.
The host file is located in:
<SystemRoot>\system32\drivers\etc

ii
NOTE
The same host names in different domains are not supported in powermanager. Use the function getHost-
name() to view the host name without domain.

VMware Workstation
To ensure the integrity and operation of the powermanager application, the powermanager systems running
on VMware follow certain hints:

• powermanager must be properly shutdown before a virtual machine is stopped.

• An online backup (snapshot) of a virtual machine is not supported.

• A snapshot of a virtual machine cannot be restored.

• The clock of the virtual machine must never make an unexpected jump (forward or backward) while
powermanager is running.

• Redundant powermanager systems must run on physical redundant hardware and network configura-
tions.

• powermanager must not run on a virtual machine for safety critical systems.

Office Packages and Excel
powermanager supports the following Excel versions for reporting tasks:

• Excel 2013 (32-bit)

• Excel 2016 (32-bit/64-bit)

• Excel 365

Installation
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ii
NOTE
Excel is used only in advanced reports and not in the Reports view.

Antivirus
Antivirus software decreases the system performance.

Add-ons

Reporting

Hardware Component Specifications
Processor Intel Pentium III 400 MHz processor (or equivalent)
RAM 256 MB
Hard disk 300 MB
Graphics VGA with at least 1024x768 pixels and 256 colors (or more)
CD-ROM drive Required for installation
Network Adaptor Required to connect to other powermanager systems or remote worksta-

tions
Monitor
2-button mouse with trackball
Keyboard

Infoserver

ii
NOTE
If the Infoserver database is running on the same computer as powermanager (not recommended except
for Access and higher data rates), consider these additional requirements into account when selecting the
hardware.

The Infoserver can send values to the following relational database systems:
Database Specifications
Microsoft Access Access 97 SR 2, Access 2000, Access 2002, Access 2003
Microsoft SQL Server
MySQL Version 4.0
Oracle 10, 11

2.1.3
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Windows

Installing Siemens Automation License Manager (ALM)

ALM is installed during the installation of powermanager.

ii
NOTE
If a lower version of ALM is found on the system during installation, it will be upgraded to the latest
version.

ALM V6.0 SP3 manages the license keys for operating powermanager.
You can operate powermanager based on the conditions of use of the installed license.

Installing powermanager

Installation Prerequisites
Ensure that the following prerequisites are met before you start the powermanager installation.

Minimum Hardware and Software Requirements
The minimum hardware and software requirements for installing powermanager are available in readme.pdf.
Microsoft Excel
Ensure that Microsoft Excel is installed on the system for viewing reports.
The minimum required Microsoft Excel version is available in readme.pdf.

Windows Group Membership
All powermanager users must be members of the Microsoft Windows users group Power Users.

Administration Rights
You must have administrator rights on the system where the powermanager is installed.

No Spaces in Path Name
There should not be any spaces in the path name.

Installation Steps
Upgrading powermanager:

• If the previous version of powermanager is found on the system during installation of powermanager
V3.5, it will be upgraded to latest version automatically.

To install powermanager, proceed as follows:
² Close all active applications before you start powermanager installation.

² Insert the installation disk in the DVD.

² Open the DVD drive and double-click the Setup.exe file.
The powermanager V3.5 Setup window appears to select the language.

2.2

2.2.1

2.2.2
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[sc_pm_setup1, 3, en_US]

² Select the desired language and click OK.
The powermanager V3.5 Setup wizard appears.

[sc_pm_setup2, 3, en_US]

² Click Next >.
The powermanager V3.5 Setup screen appears displaying the default destination path for installation.

Installation
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[sc_pm_setup3, 3, en_US]

² To change the installation path, click Browse..., select the desired path in the Browse For Folder
window, and click OK.

² Click Next >.
The Ready to Install screen is displayed.

[sc_pm_setup4, 3, en_US]

² Click Install.
The powermanager V3.5 Setup screen appears displaying the installation status.

Installation
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[sc_pm_setup5, 3, en_US]

² Click Finish.
If the powermanager installation is successful, the following path is created in the Start menu: Start > All
Programs > SENTRON > powermanager V3.5.

ii
NOTE
As part of the powermanager installation, the powermanager installer creates a certificate in the computer
name and places it under the certificate store of the local computer. If you want to create your own certifi-
cate, refer to the SSL certificated section of extended help.

Silent Installation

Silent installation is an unattended installation via the command prompt. It is performed by running the
Setup.exe with the following parameters:

• Source

• Language

• Reboot

• Installation Directory path
If the previous version of powermanager is found on the system during installation of powermanager V3.5, it
will be upgraded to latest version automatically.

Running Setup.exe
To execute the Setup file:

2.2.3
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² Execute the Setup.exe by using either of the following commands:
<Source>\Setup.exe /si /L <lang ID> or <Source>\Setup.exe -si /L <lang ID>
where:
<Source> indicates the location at which the Setup folder is copied on the local computer.
L <lang ID> indicates the language ID that is passed as a command line argument for the language
parameter.The IDs for English and German language are 1033 and 1031 respectively.
INSTALLDIR=<installation path> Installation location, default value: %SystemDrive%\Siemens\SENTRON
\powermanager
For example, E:\Setup\Setup.exe /si /L 1031 INSTALLDIR=”D:\Sentron”.
The system restarts automatically to complete the installation.
If you want to avoid the restarting of the system, enter /noreboot as a command line argument. Restart
the system manually to complete the installation.

ii
NOTE
The command line argument si is case-sensitive.
powermanager is localized as per the language ID. If the language parameter is not passed, English is the
localized language by default.
If the command is executed with wrong command line arguments, the installer starts in the user-interac-
tive mode.
Installation path should not include backslash (\) at the end of the command.

The notification icon  and the respective notifications in the taskbar display the installation progress of
the powermanager application.

² Verify the installation in the log files generated at:
%programdata%\Siemens Energy\powermanager\Logs\Setup

ii
NOTE
During the installation of powermanager, if any of the installation prerequisites is not met, the installation
is aborted. Also, the prerequisite that was not met is displayed in the log file.

Transferring the License Keys

The license keys are included on the USB drive supplied with the installation disk. Additionally, you receive
multiple USB drives, each containing different license keys for optional or expansion packages.

Transferring the Licenses
To transfer the license key to the system where powermanager is installed.
² Insert the USB drive in the USB port of the system.

² Click Start > All Programs > Siemens Automation > Automation License Manager.
ALM opens.

² In the ALM window, click View > Management.

² Select and copy the required license keys from the USB drive.

² Paste the license key in the system.
The required license keys become available on the powermanager system.

2.2.4
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Uninstalling powermanager

You can uninstall powermanager in the following three ways:

• Using the powermanager setup file and selecting the Remove option.

• Using the Windows start menu location of powermanager. Click Start > All Programs > SENTRON >
powermanager V3.5 > Uninstall to start powermanager uninstallation.

• Using the Uninstall or change a programs dialog from the Control Panel in Windows.

ii
NOTE
Do not delete the powermanager installation directory to uninstall powermanager.

[sc_pm_uninstall_pm, 3, en_US]

Figure 2-1 Control Panel - Programs and Features

To access the Uninstall or change a programs dialog, click Start > Control Panel. In the Control Panel, click
Uninstall a program.
In the Programs and Features dialog, select the powermanager installation, and select Uninstall/Change
from the context menu..
Ensure that only the following files are deleted:

• Empty folders that did not exist before the installation

• Registry items that did not exist before the installation

• Items in the start menu that did not exist before the installation

• Files that did not exist before the installation, apart from directories log/, bin/, config/, install/,
and the shield file in the powermanager installation
Delete these files explicitly.

• Entire directory structure for the powermanager installation up to the first not empty directory
After uninstalling powermanager, the following directories and registry items will be available:

• Registry and directories of powermanager projects
Uninstall these from the console before you uninstall powermanager.

• Registry-Key: HKEY_LOCAL _MACHINE/SOFTWARE/Siemens AG/powermanager

2.2.5
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• Shared DLLs installed by other applications
They are visible under
HKEY_LOCAL _MACHINE/SOFTWARE/Microsoft/Windows/CurrentVersion/SharedDLLs.

ii
NOTE
Additional program components (for example, ALM and powermanager Web client) are not uninstalled
with the uninstallation of powermanager. Uninstall these additional components separately in the Add or
Remove Programs dialog from the Control Panel in Windows.

Uninstallation of Patches
Uninstall powermanager completely to uninstall all the patches. You cannot uninstall patches individually.

Silent Uninstallation

Silent uninstallation is an unattended uninstallation via the command prompt.

Silent Uninstallation
To uninstall powermanager via command prompt, proceed as follows:
² Navigate to the installation directory and open the Setup folder.

For example: C:\Siemens\SENTRON\powermanager\Setup
² Execute the Setup.exe with the following parameters:

C:\Siemens\SENTRON\powermanager\Setup\Setup.exe /arp /sx
powermanager is removed successfully.

ii
NOTE

The notification icon  and the respective notifications in the taskbar display the uninstallation progress
of the powermanager application.

2.2.6
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Licensing

Automation License Manager (ALM)

powermanager is fully functional only with a valid license. The Automation License Manager (ALM) is required
to install the license on the system.
The licenses are supplied on a USB drive. Copy the licenses to disk using the ALM interface or operate them
directly with the USB drive.
Refer to the Automation License Manager Help for the range of functions, and details on how to link the
license.

ii
NOTE
The TRIAL version of the powermanager contains a test license that is valid for 60 days. powermanager
automatically shuts down 30 mins after the 60 days free license period.
If a valid license is installed and detected via the ALM, powermanager continues to work without runtime
restriction.

License Packages

ii
NOTE
Check the log file if you receive a warning of the following nature when starting the user interface:
WCCOAui (..), ...., SYS, FATAL,....
The log file contains information about the nature of the problem, for example, client licenses are unavail-
able.

Licenses
The following licenses are available for powermanager:
License Range of Functions (Validity)
3ZS2711-0CC30-0YA7 Trial version
3ZS2711-0CC30-0YA0 Basic package
3ZS2 711-0CC30-0YD0 Device pack (20)
3ZS2712-0CC30-0YD0 Device pack (50)
3ZS2713-0CC30-0YD0 Device pack (100)
3ZS2714-0CC30-0YD0 Device pack (200)
3ZS2715-0CC30-0YD0 Device pack (500)
3ZS2716-0CC30-0YD0 Device pack (1000)
3ZS2711-0CC30-0YE0 LEAN upgrade to device package (10)
3ZS2712-0CC30-0YE0 STANDARD upgrade to device package (50)
3ZS2713-0CC30-0YE0 ADVANCED upgrade to device package (100)
3ZS2714-0CC30-0YE0 MAXIMUM upgrade to device package (200)
3ZS2710-3CC0-00YD0 Client (5)
3ZS2710-2CC20-0YH0 Expert
3ZS2 718-1CC00-0YH0 Distributed Systems (2)
3ZS2 718-2CC00-0YH0 Distributed Systems (5)
3ZS2 718-3CC00-0YH0 Distributed Systems (10)

2.3

2.3.1
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Overview
System Overview

powermanager is used to acquire, monitor, evaluate, represent, and archive measuring values of the meas-
uring devices 7KT PAC1200, PAC1500, PAC1600, 7KM PAC2200, PAC3100, PAC3200, PAC3200T, PAC4200,
power quality devices 7KM PAC5100, PAC5200, SICAM P850/855 and the circuit breakers 3VA, 3VA27, 3VL,
3WL, 3WL10, and any Modbus TCP enabled measuring devices.
powermanager has the following functions to perform the mentioned tasks:

• Tree view of the system (project tree)

• Measured value display with predefined user views

• Alarm management

• Demand curve

• Reporting, integrated report engine with predefined report templates, like Energy analysis or Cost Center
report and individual reports based on EXCEL.

• Load monitoring

• Reaction plans

• Power peak analysis

• Support for distributed systems

• Archiving system

• Key Performance Indicators (KPI)

• User management
You can enhance powermanager at any time and tailor it to your requirements.
Possible expansions include:

• Increased number of devices.

• Increased number of client applications.

• Expert option package: Graphical representation of plants with predefined graphics objects for all meas-
uring devices and switches, as well as its own script language.

Device Integration

7KT PAC1200
The 7KT PAC1200 multi-channel current-measuring system supplements the product range of the power
monitoring system. It provides a low-cost solution for the transparent representation of energy consumption
and also enables the resulting costs to be displayed. The current values themselves are measured by means of
sensors that are fitted above the miniature circuit breakers. The simple cost center allocation enables
maximum transparency over the entire application.
The 7KT PAC1200 multi-channel current-measuring system monitors and displays the energy consumption of
up to 96 outgoing feeders. You can configure 12 sensor bars for a maximum number of 8 times (always 8 bars
with the respective combination). Up to eight different selectable consumption sources can be compared with
each other. The system can be scaled to individual needs and application scenarios. The individual sensors can
be named individually and compared with each other. The system can be configured flexibly as the number of
Sensor bars can be varied.
For more information, refer to the PAC1200 manual.

3.1
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7KT PAC1500
The 7KT PAC1500 is an E-counter for measuring consumption values in three-phase systems. This unit regis-
ters exported or imported energy and it stores active and reactive energy.
The device has a pulse output (S0), and so it is designed for two tariff measurements. Communication
modules can be interfaced via the integrated optical interface (IrDA).

7KT PAC1600
The 7KT PAC1600 is a family of E-counters for measuring consumption values in three-phase systems. This
unit registers exported or imported energy and it stores active and reactive energy.
The following variants are available for PAC1600:

• 7KT PAC1651

• 7KT PAC1652

• 7KT PAC1661

• 7KT PAC1662

• 7KT PAC1665

• 7KT PAC1666

• 7KT PAC1682

7KM PAC3100
The 7KM PAC3100 is a power monitoring device for displaying basic electrical variables and energy acquisition
values (counters) in low-voltage power distribution. It performs single-phase, two-phase, and three-phase
measurement and can be used in three-wire or four-wire TN, TT, and IT systems.
The minimum supported firmware version for 7KM PAC3100 is 1.0. You can use the gateway functionality of
the PAC4200 to connect the device to powermanager. You can also use any Modbus gateway to establish the
connection.
With the help of the basic measured variables (for example, voltage, currents, energy values), extensive evalu-
ations can already be undertaken in the powermanager.
For more information, refer to the PAC3100 manual.

7KM PAC3200
The 7KM PAC3200 is a power monitoring device for displaying all the relevant line parameters. It collects all
the basic measured variables and the extended measured variables (for example, THD). Limit values are avail-
able for line monitoring. It performs single-phase, two-phase, or three-phase measurement and can be used in
two-wire, three-wire, or four-wire TN, TT, and IT systems. The 7KM PAC3200 with multi-range power supply
can thus be connected direct in every low-voltage system up to a line voltage of 690 V.
Connect 7KM PAC3200 power monitoring device to powermanager through the integral Ethernet interface
using Modbus TCP.
In addition to the measured value display, powermanager supports the following device functionality:

• Synchronization of the period

• Support for the digital inputs in the different modes

• Option for resetting the counters and the min/max values

• Evaluation of the status bytes and generation of the relevant messages
For more information, refer to the PAC3200 manual.
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ii
NOTE
For more information on the special features of the digital inputs, see 8.2.3 Inputs and Outputs.

7KM PAC3200T
The 7KM PAC3200T is a power monitoring device for displaying all the relevant line parameters. It collects all
the basic measured variables and the extended measured variables (for example, THD). Limiting values are
available for line monitoring. The 7KM PAC3200T performs 1-phase, 2-phase, or 3-phase measurement and
can be used in 2-wire, 3-wire, or 4-wire TN, TT, and IT systems. The 7KM PAC3200T with multi-range power
supply can thus be connected directly in every low-voltage system up to a line voltage of 690 V.
Connect the 7KM PAC3200T power monitoring device to powermanager through the integral Ethernet inter-
face using Modbus TCP.
In addition to the measured value display, powermanager supports the following device functionality:

• Synchronization of the period

• Support for the digital inputs in the different modes

• Option for resetting the counters and the min/max values

• Evaluation of the status bytes and generation of the relevant messages
For more information, refer to the PAC3200T manual.

ii
NOTE
For more information on the special features of the digital inputs, see 8.2.3 Inputs and Outputs.

7KM PAC4200
7KM PAC4200 is a power monitoring device for displaying, storing, and monitoring all relevant line parame-
ters in low-voltage power distribution. Compared to 7KM PAC3200, the 7KM PAC4200 has extended meas-
uring functions (> 800 measured variables), an integral memory for buffering the load profile and events, as
well as, gateway functionality. It performs single-phase, two-phase, or three-phase measurement and can be
used in two-wire, three-wire, or four-wire TN, TT, and IT systems.
The minimum supported firmware version for 7KM PAC4200 is V1.2. Connect the 7KM PAC4200 power moni-
toring device to powermanager through the integral Ethernet interface using Modbus TCP.

ii
NOTE
On creation of a new PAC4200 device with firmware version 2.1.1 or above, it is recommended to restart
the project so that all the properties of the devices could be polled.

You can connect any Modbus enabled measuring devices to powermanager through the Ethernet or gateway
using the RS485 interface.
Along with the measured value display, powermanager supports the following device functionality:

• Reading out the device memory (load profile)

• Gateway functionality

• Graphical display of harmonics

• Time synchronization

• Support for the digital inputs in the different modes

• Option for resetting the counters and the min/max values
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• Evaluation of the status bytes and generation of the relevant messages

• Support for the two optional external DI/DO modules
For more information, refer to the PAC4200 manual.

ii
NOTE
For more information on the special features of the digital inputs, see 8.2.3 Inputs and Outputs.

ii
NOTE
Load profile data is displayed in the powermanager only if the time difference between the PAC device and
the PC lies within specific tolerances. Synchronize the times between the PC and the device if load profile
data is not collected.

PAC2200
The PAC2200 is a power monitoring device for displaying all the relevant line parameters. It collects all the
basic measured variables and the extended measured variables (for example, THD). Limit values are available
for line monitoring. It performs single-phase, two-phase, or three-phase measurement and can be used in
two-wire, three-wire, or four-wire TN, TT, and IT systems. The PAC2200 with multi-range power supply can
thus be connected directly to every low-voltage system up to a line voltage of 690 V. Connect the PAC2200
power monitoring device to powermanager through the integral Ethernet interface using Modbus TCP.
In addition to the measured-value display, powermanager supports the following device functionalities:

• Synchronization of the period

• Support for the digital inputs in the different modes

• Option for resetting the counters and the min/max values

• Evaluation of the status bytes and generation of the relevant messages

3VA27
The 3VA27 molded case circuit breaker is a current-limiting circuit breaker with IEC certification and is an addi-
tion to the existing 3VA IEC portfolio.
Current-limiting molded case circuit breakers are defined as:

• Circuit breaker that, within a specified range of current, prevents the let-through current from reaching
the prospective peak value and which limits the let-through energy (I2t) to a value less than the let-
through energy of a half-cycle wave of the symmetrical prospective current.

These are the positive characteristics of a protection device that is most frequently used on the outgoing side
and that, like the 3VA27 molded case circuit breaker, is dynamically selective and current limiting in the event
of a fault. Current limiting means that the peak value of the prospective impulse short-circuit current Ip is
limited to a smaller let-through current iD. Effective current limitation means that the circuit breakers and
busbar trunking systems can be constructed more compactly. In the event of a short-circuit, the molded case
circuit breaker substantially reduces the magnitude of the let-through currents, wherein, it reduces the load
reaching downstream equipment (less thermal load, lower dynamic forces). The let-through energy is also
significantly reduced. 3VA molded case circuit breakers are designed to be current limiting. It has the
following characteristics:
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• Frame size 1600 A with a rated current In of 800 A to 1600 A

• Choice of 2 designs:
– As a toggle operating mechanism (for example, as an additional manual operating mechanism).
– As a stored energy spring mechanism for integration of internal spring charging motors (external

dimensions are not affected by this). Optionally available either as a fixed-mounted version or as a
withdrawable version. An especially high Icu value (up to 110 kA @ 415 V) and an Icw value (up to
20 kA 1s).

PAC5100/PAC5200 and SICAM P850/P855 multifunctional devices
The PAC5100/PAC5200 and SICAM P850/P855 multifunctional devices are used to collect, display and transmit
measured electrical variables according to IEC 61000-4-30 Power Quality (PQ) standard.
The PAC5100/PAC5200 and P850/P855 devices record the following measured variables:

• Alternating voltage and alternating current

• Unbalanced alternating voltage and alternating current

• Active, reactive, and apparent power

• Active, reactive, and apparent energy

• Power frequency

• Phase angle

• Power factor and active power factor

• Total Harmonic Distortion (THD) of alternating voltage and alternating current

• Harmonics of alternating voltage and alternating current

• Flicker according to IEC 61000-4-15 standard (only PAC5200 and SICAM P855)
Connect the PAC5100/PAC5200 or P850/P855 multifunctional devices to powermanager via Ethernet inter-
face.
Fault records for PAC5200 and P855 devices are displayed in the Web tab on the base panel. Use the SIGRA
plug-in or COMTRADE viewer to view the fault records. For more information, refer to 6.1.10 Web.
For more information, refer to the PAC5100/PAC5200 manual and SICAM P850/P855 manual.

3VL (with COM21)
3VL are molded-case circuit breakers. They can acquire and forward status information, warning messages,
tripping information, and threshold-value violations (for example, overcurrent).
Connect the 3VL molded-case circuit breakers to powermanager via the gateway functionality of the PAC4200.
You can use any other gateway to establish the connection.
The current circuit-breaker status is also displayed in the powermanager as well as the measured values. The
circuit breaker can be switched with the relevant authorization.
There are three switching functions:

• ON - Select ON when the circuit breaker status is OFF.

• OFF - Select OFF when the circuit breaker status is ON.

• RESET - Select RESET when the circuit breaker status is TRIPPED.
For more information, refer to the 3VL system manual.
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ii
NOTE
powermanager does not detect the specific circuit breaker version and the available measured values auto-
matically. In the device engineering for the circuit breaker, select the measured values that are available in
your circuit breaker. For this purpose, activate the check box for Address, and if necessary, set archiving on
the Configuration tab.

State Symbols of the Molded-case Circuit Breaker
Different states of the molded-case circuit breaker are represented as a circuit-breaker symbol. The state
symbol of the molded-case circuit breaker indicates the position of the molded-case circuit breaker in the
frame. You can see whether the molded-case circuit breaker is open or closed. The background color desig-
nates the status of the relevant message.

Table 3-1 Colored background of the molded-case circuit breaker symbol for designating the status of
messages

Color Message Status Meaning
Green Green No messages pending.
Yellow Yellow At least one warning message or one threshold warning is pending.
Red Red At least one trip message is currently pending.
White White No information available about the existence of messages.

Table 3-2 State symbols of the molded-case circuit breaker:

State Symbol without Guide
Frame

Description of the State

The circuit breaker is not available.

The circuit breaker is opened. At the moment, neither tripping nor warning
or setpoint messages are present.

The circuit breaker is opened. At the moment, a tripping message is present.

The circuit breaker is opened. At the moment, at least one warning or
setpoint message is present.

The circuit breaker is closed. At the moment, neither tripping nor warning or
setpoint messages are present.

The circuit breaker is closed. At the moment, a tripping message is present.
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State Symbol without Guide
Frame

Description of the State

The circuit breaker is closed. At the moment, at least one warning or
setpoint message is present.

It is unknown, if the circuit breaker is closed or opened. At the moment,
neither tripping nor warning or setpoint messages are present.

It is unknown, if the circuit breaker is closed or opened. At the moment, a
tripping message is present.

It is unknown, if the circuit breaker is closed or opened. At the moment at
least one warning or setpoint message present.

The circuit breaker has tripped. At the moment, neither tripping nor warning
or setpoint messages are present.

The circuit breaker has tripped. At the moment, a tripping message is
present.

The circuit breaker has tripped. At the moment, at least one warning or
setpoint message is present.

offline The molded-case circuit breaker is offline.

3VA molded-case circuit breakers
Connect the 3VA molded-case circuit breakers to powermanager via COM800 gateway.
The 3VA series is designed for use in applications with higher technical requirements and a rated current of up
to 630 A.
In addition to an increased switching capacity of up to 150 kA, these MCCBs come with an electronic trip unit
(ETU), and an integration capability for metering and communication functions.
The current-limiting contact system furthermore ensures a very high switching capacity. ETUs guarantee reli-
able overload protection, short-term delayed or instantaneous tripping in case of a short-circuit, neutral
conductor protection, and fault protection against ground.
Mobile test devices allow the checking and parameterization of ETU functions in MCCBs on site.

State symbols of the molded-case circuit breaker
Different states of the molded-case circuit breaker are represented as a circuit-breaker symbol. The state
symbol of the molded-case circuit breaker indicates the position of the molded-case circuit breaker in the
frame. You can see whether the molded-case circuit breaker is open or closed. The background color desig-
nates the status of the relevant message.
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Table 3-3 Colored background of the molded-case circuit breaker symbol for designating the status of
messages:

Color Message Status Meaning
Green Green No messages pending
Yellow Yellow At least one warning message or one threshold warning is pending
Red Red At least one trip message is currently pending
White White No information available about the existence of messages

Table 3-4 State symbols of the molded-case circuit breaker:

State Symbol without
Guide Frame

State Symbol with
Guide frame

Description of the State

The circuit breaker is not available.
Note: At the moment, neither tripping nor warning or
setpoint messages are pending.

The circuit breaker is not available.
Note: At the moment, at least one warning or setpoint
message is pending.

The circuit breaker is not available.
Note: At the moment, a tripping message is pending.

The circuit breaker is opened. At the moment, neither trip-
ping nor warning or setpoint messages are present.

The circuit breaker is opened. At the moment, a tripping
message is present.

The circuit breaker is opened. At the moment, at least one
warning or setpoint message is present.

The circuit breaker is opened. At the moment, neither trip-
ping nor warning or setpoint messages are present.

The circuit breaker is opened. At the moment, a tripping
message is present.

The circuit breaker is opened. At the moment, at least one
warning or setpoint message is present.
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State Symbol without
Guide Frame

State Symbol with
Guide frame

Description of the State

The circuit breaker is in the disconnected position.

The circuit breaker is in disconnected position. The circuit
breaker is closed. At the moment there are neither tripping
nor warning or setpoint messages present.

The circuit breaker is in disconnected position. The circuit
breaker is closed. At the moment a tripping message is
present.

The circuit breaker is in disconnected position. The circuit
breaker is closed. At the moment, at least one warning or
setpoint message is present.

The circuit breaker is in disconnected position. The circuit
breaker is opened. At the moment, neither tripping nor
warning or setpoint messages are present.

The circuit breaker is in disconnected position. The circuit
breaker is opened. At the moment, a tripping message is
present.

The circuit breaker is in disconnected position. The circuit
breaker is opened. At the moment, is at least one warning
or setpoint message is present.

The circuit breaker is closed. At the moment, neither trip-
ping nor warning or setpoint messages are present.

The circuit breaker is closed. At the moment, a tripping
message is present.

The circuit breaker is closed. At the moment, at least one
warning or setpoint message is present.

The circuit breaker is closed. At the moment, neither trip-
ping nor warning or setpoint messages are present.
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State Symbol without
Guide Frame

State Symbol with
Guide frame

Description of the State

The circuit breaker is closed. At the moment, a tripping
message is present.

The circuit breaker is closed. At the moment, at least one
warning or setpoint message is present.

It is unknown, if the circuit breaker is closed or opened. At
the moment, neither tripping nor warning or setpoint
messages are present.

It is unknown, if the circuit breaker is closed or opened. At
the moment, a tripping message is present.

It is unknown, if the circuit breaker is closed or opened. At
the moment, at least one warning or setpoint message is
present.

It is unknown, if the circuit breaker is closed or opened. At
the moment, neither tripping nor warning or setpoint
messages are present.

It is unknown, if the circuit breaker is closed or opened. At
the moment, a tripping message is present.

It is unknown, if the circuit breaker is closed or opened. At
the moment, at least one warning or setpoint message is
present.

The circuit breaker is in test position and has tripped. At
the moment, neither tripping nor warning or setpoint
messages are present.

The circuit breaker is in test position and has tripped. At
the moment a tripping message is present.

The circuit breaker has tripped. At the moment, at least
one warning or setpoint message is present.

offline offline The circuit breaker is in test position and has tripped. At
the moment, at least one warning or setpoint message is
present.
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3WL (with COM16)
3WL are air circuit breakers. They can transfer important information to the software to carry out diagnostics
management, fault management, maintenance management, and cost center management.
Connect the 3WL air circuit breakers to powermanager via the gateway functionality of the PAC4200. You can
use any other gateway to establish the connection.
The circuit breaker status is displayed in powermanager and the measured values and can be switched with
the appropriate authorization.
There are two switching functions:

• ON - Select ON when the circuit breaker status is OFF or TRIPPED.

• OFF - Select OFF when the circuit breaker status is ON.
For more information, refer to the 3WL/3VL system manual.

State symbols of the molded-case circuit breaker
Different states of the molded-case circuit breaker are represented as a circuit-breaker symbol. The state
symbol of the molded-case circuit breaker indicates the position of the molded-case circuit breaker in the
frame. You can see whether the molded-case circuit breaker is open or closed. The background color desig-
nates the status of the relevant message.

Table 3-5 Colored background of the molded-case circuit breaker symbol for designating the status of
messages:

Color Message Status Meaning
Green Green No messages pending
Yellow Yellow At least one warning message or one threshold warning is pending
Red Red At least one trip message is currently pending
White White No information available about the existence of messages

Table 3-6 State symbols of the molded-case circuit breaker:

State Symbol with Guide
Frame

Description of the State

The circuit breaker is not available.

The molded-case circuit breaker is in the connected position and open. At
the moment, neither trip messages nor warning messages or threshold
messages are pending.

The molded-case circuit breaker is in the connected position and open. A trip
message is pending.

The molded-case circuit breaker is in the connected position and open. At
least one warning message or one threshold warning is pending.
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State Symbol with Guide
Frame

Description of the State

The circuit breaker is in test position and opened. At the moment, neither
tripping nor warning or setpoint messages are present.

The circuit breaker is in test position and opened. At the moment, a tripping
message is present.

The circuit breaker is in test position and opened. At the moment, at least
one warning or setpoint message is present.

The circuit breaker is in disconnected position.

The circuit breaker is in connected position and closed. At the moment,
there are neither tripping nor warning or setpoint messages present.

The circuit breaker is in connected position and closed. At the moment, a
tripping message is present.

The circuit breaker is in connected position and closed. At the moment, at
least one warning or setpoint message is present.

The circuit breaker is in the test position and closed. At the moment, neither
trip messages nor warning messages or threshold messages are pending.

The circuit breaker is in the test position and closed. A trip message is
pending.

The circuit breaker is in the test position and closed. At least one warning
message or one threshold warning is pending.

The circuit breaker is in connected position. It is unknown whether the
switch is closed or opened. At the moment, neither tripping nor warning or
setpoint messages are present.
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State Symbol with Guide
Frame

Description of the State

The circuit breaker is in connected position. It is unknown whether the
switch is closed or opened. At the moment, a tripping message is present.

The molded-case circuit breaker is in the connected position. It is not known
whether the molded-case circuit breaker is open or closed. At least one
warning message or one threshold warning is pending.

The circuit breaker is in test position. It is unknown whether the switch is
closed or opened. At the moment, neither tripping nor warning or setpoint
messages are present.

The circuit breaker is in test position. It is unknown whether the switch is
closed or opened. At the moment, a tripping message is present.

The circuit breaker is in test position. It is unknown whether the switch is
closed or opened. At the moment, at least one warning or setpoint message
is present.

The circuit breaker is in test position and has tripped. At the moment there
are neither tripping nor warning or setpoint messages present.

The circuit breaker is in test position and has tripped. At the moment, a trip-
ping message is present.

The circuit breaker is in test position and has tripped. At the moment, at
least one warning or setpoint message is present.

offline The molded-case circuit breaker is offline.

3WL10
The air circuit breaker is an integral part of an economically efficient power distribution system that is
designed to protect personnel and material assets. The 3WL10 air circuit breaker is an IEC circuit breaker
(3WL1) with frame size 0 (3WL10) and is an addition to the existing 3WL1 IEC portfolio.
The 3WL10 air circuit breaker meets the following requirements:

• High breaking capacity

• Selective protective response

• Integrated metering function with internal voltage tap and expansion module MF Basic/MF Advanced
(with electronic trip units of the 6-series)

• Connection to a fieldbus communication system or Ethernet-based IP communication (with electronic trip
units of the 6-series)
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Generic Modbus Devices
You can connect any Modbus-enabled measuring device directly to powermanager via Ethernet (Modbus TCP)
or gateway (7KM PAC4200) and RS485 interface. For these devices, you can configure up to 50 measured vari-
ables and 10 status information items.

! DANGER
Use of generic switches:

If ignored, it results in death or serious injury.

² Lock the circuit breaker against undesired/unauthorized operation and against the Tripped status.
There is no software locking mechanism for the circuit breaker.
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SEM3

Overview

The new Siemens Embedded Micro Metering Module (SEM3) is a modular metering solution for energy moni-
toring, data analysis, and sub billing applications. The flexible design allows for low, medium, and high density
metering requirements to be met efficiently and economically using only a few standardized components inte-
grated into Siemens Panelboard and Switchboard products.
The SEM3 system is made up of the following components and options:

• Controller

• Meter modules

• Meter racks

• Current transformers (CT)

• Communication cables
For more information about SEM3, refer to the respective SEM3 manuals.

Creating SEM3 Device Type

To work with the respective SEM3 devices, you must create the SEM3 device type.
To create the SEM3 device type, proceed as follows:
² In the project tree view, right-click the project tree root.

² In the context menu, click System settings.
The System settings page opens.
² Click the Device tab.

² In the Device tab, under Create SEM3 device type, click Import.
The Import SEM3 device type window opens.

3.2

3.2.1

3.2.2
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² Enter the valid IP address, SEM3 device type name, User name, and Password.

[sc_pm_importsem3_values, 1, en_US]
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² Click Start import.
powermanager starts creating the SEM3 device type and after creation, the Import results field shows the
following message:
All steps passed.

Additionally, a green circle is displayed next to the Import results field.

ii
NOTE
In case of any error message, you must resolve the issue and try to import the file again.

² Close the Import SEM3 device type window.
After successful creation of the SEM3 device type, the newly created device type is visible in the Create device
context menu.

Creating the SEM3 Device

To create an SEM3 device, proceed as follows:
² Right-click the area or sector in which you want to create the device.

3.2.3
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² Click Create device > SEM3 > SEM3.

² Assign a name to the device.

² Click Create.
Wait until the powermanager creates the device. Creation of the new device takes some time depending on
the device type and on the project size. The new device is now displayed in the project tree. By default, the
Communication and units tab is opened.

² Enter the IP address in the Communication area.

² Set the parameters in the Units and Factors area if necessary.

² Click Save.
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² Right-click SEM3 > Communication > Start communication to start the communication with the device.
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² Select the 8.2.1.3 Configuration Tab.

² Configure the data points in the Configuration tab.

² Select the 8.2.1.5 Extended Configuration Tab.
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ii
NOTE
You can change the names of the measured variables for all the languages supported by the powerman-
ager. The Element column shows the modified names.

² Click Save.

² Right-click the SEM3 device and select Start communication in the context menu to start the communi-
cation with the device.

Additionally, a green circle is displayed next to the Communication field indicating successful communica-
tion.

Monitoring Online Values

It is possible to access the SEM3 device in the system tree and to monitor the online values in a similar way to
the existing devices in the powermanager application. The runtime view displays the following tabs for moni-
toring online values:

• Overview

• kWh

• Meter values

• Energy

• Status and Commands

• Parameters

3.2.4
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Start Communication
Right-click SEM3 and select Communication > Start communication in the context menu to start the
communication with the device.
Additionally, a green circle is displayed next to the Communication field indicating successful communica-
tion.

[sc_pm_startcomm, 1, en_US]
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[sc_pm_comm_unit_connected, 1, en_US]
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Overview

This tab displays the Meter name, CT Rating, and Connection status of the meters with respect to the
different phases of the device.
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kWh

This tab displays the energy-consumption details of the respective meters.
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Meter Values

This tab displays the online monitoring values of the meters. The meter values are categorized according to
the phases (1-Pole, 2-Pole, and 3-Pole).
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Energy

This tab displays the energy-consumption details. This tab enables you to compare the energy consumption
between 2 different time ranges.
For more information, see 6.1.7 Energy.

Status and Commands
This tab enables you to send commands to the connected devices at a device level and at a meter level.
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• Device-level Commands

[sc_pm_sem3_status_commands, 1, en_US]

You can reset the command for Under voltage alarm and Over voltage alarm.
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• Meter-level Commands

You can reset the commands for the following alarms under the tabs 1-Pole, 2-Pole, and 3-Pole:
– Phase loss alarm
– Phase over current pre-alarm
– Phase over current alarm
– Monitor over kw demand alarm
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Parameters

This tab displays the Firmware version and Device serial number.
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Overview

[sc_pm_dashboard, 1, en_US]

Standard Interface Dialogs
Select a device, a sector, or an area in the project tree to view the associated data.
Depending on the device type, the following tabs are available:

• Dashboard

• Overview

• Selected values

• Harmonics

• Energy

• Trend

• Operations

• Web

• Parameters

ii
NOTE
For more information, see 6.1.1 Tabs in Standard View.

4.1
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Alerts
This area allows you to acknowledge alerts.
To acknowledge an alert:

• Right-click the alert you want to acknowledge.

• Click Acknowledge.

ii
NOTE

You can also acknowledge the alerts and warnings in the alert screen. Click  to open the alert screen.
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Menu Bar
View

Standard Opens the Standard view. For more information refer to 6.1.1 Tabs in
Standard View.

KPI Opens the KPI view. For more information refer to 6.2.1 Overview.
Input Opens the Input view. For more information refer to 6.3.1 Overview.
Reaction plan Opens the Reaction plan view. For more information refer to 6.4.1 Overview

of Reaction Plans.
Reports Opens the advanced Reports view. For more information refer to

6.5.1.1 Report View.

Tools

Trends Opens the Trends dialog. For more information refer to 6.1.8 Trend.
Alerts Opens the Alerts dialog. For more information refer to 7.2 Alert Classes.
Advanced Report Opens the excel Report. For more information refer to 7.3.2.1 Overview

powermanager Excel Report.
Topology export Opens the Topology export dialog. For more information, refer to 7.4.1 Over-

view of Topology Export.
Power peak analysis Opens the Power peaks dialog. For more information refer to 7.5.1 Overview

of Power Peak Analysis.
Mass parameterization Opens the Mass parameterization dialog. For more information refer to

7.6 Mass Parameterization.
Graphics editor Opens the Graphics editor dialog. For more information refer to 8.9.1 Range

of Functions.

Settings

System management Opens the System management window. For more information, refer to
7.3.14.2 Starting powermanager Excel Report.

Mail configuration Opens the Mail configuration dialog. For more information, refer to
8.3 Configuring E-Mail Server Settings.

E-mailing list Opens the E-mailing list dialog. For more information, refer to 8.4 E-mailing
List.

OPC server configuration Opens the OPC server configuration dialog. For more information, refer to
8.5 OPC Server Configuration.

Panels

Start panel Takes you back to the start panel (Standard view).
. . . New panel, takes you to a blank panel.

Help

powermanager help Opens the powermanager online help.
Memory/Disk resources The Memory/Disk resources dialog opens.

The Disc space tab displays the status of the disk space of the system.
The RAM space tab displays the status of the RAM space of the system.

License information Opens the License information dialog, it displays the number of device
licenses available and used.

Support & Service Opens the powermanager support website.
About Opens the About dialog. It displays the current version of powermanager.

4.2
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Functions on the Tool Bar

Standard view

In this view, devices can be created and configured. It also displays all the created
devices.

KPI view

In this view, the KPIs can be created and configured. It also displays all the created
KPIs.

Report view

In this view the report templates can be created and configured. Reports can be
created out of the configured templates. You can also view all the created report
templates and reports.

Variable trend

In this view, the variations in the values of a device over a specific time range can
be represented. A trend can contain any number of hierarchical areas for repre-
senting curves, with scales and legends. Value-over-time and value-over-value
representations are also possible.

Alert screen

In this view, the alerts and events are displayed in the form of a table. You can sort
and filter alerts for display.

Online Help

Opens the powermanager Online Help.

The new icons can be added to the tool bar.
To add new icons to the tool bar:

• Right-click the tree root.

• Select System settings.
The system settings section opens.

• Select the User interface tab.

• In the Language settings section, select the languages for which you want the icon to be enabled.

• In the Toolbar settings section, select the number of Additional toolbar buttons you want to add, from
the drop-down list.

• Click Save.

 will be added to the toolbar.

• Right-click , to assign a panel for the newly created icon.
The Reference parametrization dialog opens.

• Select a panel from the Please select a panel section.

• Click OK.
The panel is assigned to the selected panel.

4.3
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ii
NOTE
Expert license is required to add additional tool bar buttons.
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Creating a New Project
A new project can be created by using powermanager: Project Administrator.

ii
NOTE
The name of the powermanager project must not contain any spaces.

Creating a New Project
To create a project:
² Click Start > All Programs > SENTRON > powermanager V3.4 > Project Administration.

The powermanager: Project Administrator window opens.

[sc_pm_admin, 1, en_US]

² Click .
The New project dialog opens.

Step 1: Project type settings
There are two types of projects, which can be created:
Server project: A server project contains all managers on the same machine.
Client project: Client project is associated with a remote user interface. The remote project is connected to
another project on a server. The remote project is created and started on the client. On the client, a directory
structure and config file are automatically created (copied from the sever). In case of a configuration UI, only
configuration and log files are created and where as for visualization UI, all parts are created except the data-
base. Note: The changes in the configuration file are not copied to the server automatically. To access the
panels on the server, the project path has to be shared. The sever project can be selected in the New project
panel (see figure below). Note: The non-executable projects cannot be selected. The project administration
panel of the client allows you to view the status of the project (running, stopped, and so on).
² Select a project type from the Selecting project type section.

5.1
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[sc_SelectProjType, 1, en_US]

² Click Next.
Step 2: General settings
² In the General settings section, enter a unique Project name.

² Click  to, open the Choose a Folder dialog.
In the Choose a Folder dialog, browse to the folder where you want to save the new project.

[sc_GeneralSettings, 1, en_US]
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² Click Next.

Step 3: UI settings
This step is only applicable if you have selected Client project in the Project type setting step.

[sc_ServerProj, 1, en_US]

² Click  to browse to a location where a server project already exists.

² Select the Language of the project.

² Click Next.

Step 4: Create project
The Creating new project section displays the settings of the new project.
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[sc_CreatingNewProj, 1, en_US]

² Click Ok, to create the project.
The Information dialog opens to confirm the creation of the project.

² Click Ok.
The project is created and it is available for selection in the powermanager console.
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Starting the Project via Console
To start the powermanager V3.5 project:
² Click Start > All Programs > SENTRON > powermanager V3.5 > Console to open the powermanager

console.
The powermanager: Console window is opened.

[sc_pm_console, 1, en_US]

The powermanager: Console window lists the processes that powermanager uses.
The St column indicates the status of each process.
0 (Red) - Process is stopped.
1 (Yellow) - Process started.

5.2
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2 (Green) - Process started and is currently running.
² Select the powermanager project you want to start from the Project list box.

²
Click  to start the project.

After all the processes in the selected project is started, the project Log in window is displayed.

[sc_pm_basepanel, 1, en_US]

² Enter root in the User name field.
Leave the Password field blank.
Select the language from the Language list box.

² Click Login.
The Base Panel window is displayed.

ii
NOTE
When powermanager is installed, the root user account has no password assigned to it. If required, assign a
password to the root user.
The processes visible in the powermanager console are background processes. Opening or closing the
powermanager console has no effect on the state of the process. Data acquisition continues to run even
when the console is closed.

After starting the project, you can add devices in the project tree.
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Starting a Project as a Service

² Click Start > All Programs > SENTRON > powermanager V3.5 > Project Administration.
The powermanager: Project Administrator window opens.

[sc_pm_startpro, 1, en_US]

² Select the project to be started and click  to run the project as a service.
A desktop shortcut is created for the selected project and the project is started.

² Double-click the shortcut to run the powermanager application.

ii
NOTE
When the project is deleted, the corresponding shortcut is deleted.
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Starting a Project via Project Administration
To start the powermanager V3.5 project:
² Click Start > All Programs > SENTRON > powermanager V3.5 > Project Administration.
The powermanager: Project Administration window opens.

[sc_pm_pm_admin, 1, en_US]

²
Click  to start the project.

5.3
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Project Operations
Areas

You can divide the project tree root into different areas based on your requirements.

[sc_pm_projecttree, 1, en_US]

The "no area" Area
You can accommodate the devices that cannot be assigned clearly to an area for No area. A device created in
the project tree root is automatically moved to the no area .
Creating an Area
To create an area:
² Right-click the project tree node.

[sc_pm_createarea, 1, en_US]

² Click Create area.
The Create area dialog is displayed.

5.4
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[sc_pm_create_area, 1, en_US]

² Assign a unique name to the new area.

ii
NOTE
Only the following characters are allowed in the naming of a area/sector/device:

• A-Z, , , ‘ ‘, ‘-‘,’_’

• a-z

• 0-9

• (Space)

• - (Hyphen)

• _ (Underscore)

The new area is visible in the project tree.
Copying an Area
To copy an area:
² Right-click the area which you want to copy.

[sc_pm_copyarea, 1, en_US]

² Click Copy area from the context menu.
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ii
NOTE
Copy area is not supported on distributed systems.
A copied area can be pasted only at the system level.
Only one area can be copied at a time.
No Area cannot be copied.
Copied area is not available for paste if either the UI language or the user is changed.

Pasting an Area
To paste the area:
² Right-click the system.

[sc_pm_pastearea, 1, en_US]

² Click Paste area form the context menu.
The Paste area dialog is displayed.

[sc_pm_paste_area, 1, en_US]
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By default when you paste devices/sector/area, _1 is added as a suffix to the name of the devices. This is done
to give a unique name to all the copied devices. This name can be changed manually in the New device name
column.

Table 5-1 Paste Devices Dialog

Name Description
Status Indicates if the new name is unique or not.
Source location Shows the location from where the device/area/sector is copied from.
Original device name Shows the original name of the device/area/sector.
Destination location Shows the location where the device/area/sector is being pasted to.
New device name Used to give a new name to the pasted devices.

Sectors
An area can be divided into sectors and sectors can be sub-divided into other sectors. You can create up to 5
levels of sectors.

[sc_Sectors, 2, en_US]

Creating a Sector
To create a sector:
² Right-click the area or sector for which you want to create the sector.

² Click New Sector.
The Create sector dialog is displayed.

[sc_pm_createsector, 1, en_US]

² Assign a name for the new sector.

² Click Create.
The sector is displayed in the project tree.
Cutting a Sector

Working with Projects
5.4 Project Operations

powermanager,  , Help 83
E50417-H1076-C550-A7, Edition 06.2019



To cut a sector:
² Right-click the required sector from the selected area.

[sc_pm_cutarea, 1, en_US]

² Click Cut sector from the context menu option.
Copying a Sector
To copy a sector:
² Right-click the sector that you want to copy.

² Click Copy sector from the context menu option.

ii
NOTE
Copy sector is not supported on distributed systems.
Only one sector can be copied at a time.
Copied area is not available for paste either, if the UI language or the user is changed.

Pasting a Sector
To paste the sector:
² Right-click the area/sector in which you want to paste the copied sector.

² Click Paste sector from the context menu option.
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ii
NOTE
A sector can be pasted under the same area in which it is already available.
A sector cannot be pasted under itself.
A sector cannot be pasted into No Area.

Devices
You can create devices in an area or a sector.

[sc_Devices, 2, en_US]

Creating a Device
To create a device:
² Right-click the area or sector in which you want to create the device.

² Click create device.
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[sc_pm_createdevice, 1, en_US]

² Click the device type.
The Create new device dialog opens.
² Assign a name to the device.

² Click Create.
Wait until powermanager creates the device.
Creation of the new device takes some time depending on the device type and the project size.
The new device is now displayed in the project tree.

Cutting a Device
To cut the devices:
² Select the devices that you want to cut from project tree.
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[sc_pm_cut_device, 1, en_US]

² Right-click the selected devices and select Cut devices from the context menu.

ii
NOTE
THe cut operation can be performed only on the same type of entity, for example, you cannot cut a device
and a sector at the same time.

Copying Devices
To copy the devices:
² Select the devices that you want to copy from project tree.

² Right-click the selected devices and select Copy devices from the context menu.

ii
NOTE
Copy device is not supported on distributed systems.
Copied area is not available for paste if the UI language or the user is changed.

Pasting Devices
To paste the devices:
² Right-click the area or sector in which you want to paste the copied devices.

² Select Paste devices from the context menu.
The Paste devices dialog opens.
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[sc_pm_pastedevice, 1, en_US]

ii
NOTE
A device can be pasted into any area/sector including the same sector/area in which it is already present.

Communication
You can view the communication status from the icon beside the device:

•  - Device connected (communication active)

•  - Device not connected (communication inactive)

Renaming a Device/Sector/Area
To rename a device/sector/area:
² Right-click the device/sector/area which you want to rename.

² Click Rename device/sector/area from the context menu.
The Rename: Device/Sector/Area dialog opens.

[sc_pm_renamedevice, 1, en_US]

² Enter a New device name.
You can change the device name according to the language by using the Text for every language dialog.
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²
Click .
The Text for every language dialog opens.

[sc_pm_language, 1, en_US]

² Enter the desired name in the Text column for the device for the required languages.
The device name entered for each language will be displayed according to the language selected in the
UI.

² Click Ok, to confirm.

² Click Apply.

Table 5-2 Device Shortcut Menu

Menu Items Description
Device engineering See 8.2.1.5 Extended Configuration Tab.
Cut device Click Cut device to cut the selected device.
Copy device Click Copy device to copy the selected device.
Rename device Click Rename device to rename the selected device.
Delete device Click Delete device to delete the selected device.
Start communication Click Start communication to start communication between the software and the

device. If communication is already in progress between the software and the
device, this option will not be disabled.

Stop communication Click Stop communication to stop communication between the software and the
device. If communication is already stopped between the software and the device,
this option will not be disabled.

Table 5-3 Sector Shortcut Menu

Menu Items Description
Create device Click Create device to create a device in the sector.
Paste devices Click Paste devices to paste the copied devices into the sector.
Create sector Click Create sector to create a sector in the sector.
Cut sector Click Cut sector to cut the selected sector.
Copy sector Click Copy sector to copy the selected sector.
Paste sector Click Paste sector to paste the copied sector into the area/sector.
Rename sector Click Rename sector to rename the selected sector.
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Menu Items Description
Delete sector Click Delete sector to delete the selected sector.
Start communication
for all devices

Click Start communication for all devices to start communication between the
software and all the devices present in the sector. If communication is already in
progress between the software and the devices, this option will not be disabled.

Stop communication
for all devices

Click Stop communication for all devices to stop communication between the soft-
ware and all the devices present in the sector. If communication is already stopped
between the software and the devices, this option will not be disabled.

Table 5-4 Area Shortcut Menu

Menu Items Description
Create device Click Create device to create a device in the area.
Paste devices Click Paste devices to paste the copied devices into the sector.
Device engineering See 8.2.1.5 Extended Configuration Tab.
Create sector Click Create sector to create a sector in the sector.
Paste sector Click Paste sector to paste the copied sector into the area/sector.
Copy area Click Copy area to copy the selected area.
Rename area Click Rename area to rename the selected area.
Delete area Click Delete area to delete the selected area.
Start communication
for all devices

Click Start communication for all devices to start communication between the
software and all the devices present in the area. If communication is already in
progress between the software and the devices, this option will not be disabled.

Stop communication
for all devices

Click Stop communication for all devices to stop communication between the soft-
ware and all the devices present in the area. If communication is already stopped
between the software and the devices, this option will not be disabled.

Table 5-5 System Shortcut Menu

Menu Items Description
Create device Click Create device to create a device in the system.

The new device is added in the no area area.
Device engineering See 8.2.1.5 Extended Configuration Tab.
Create area Click Create area to create a new area.
Paste area Click Paste area to paste a copied area into the system.
Area administration Click Area administration to get an overview of the available areas.

You can see which devices in the individual areas have their own area settings.
You can also create new areas.

Filter administration Click Filter administration to create individual filters for measured value display in
the Selected Values tab.
For more information, see 8.2.9.1 Overview of Filter Administration.

System settings Click System settings to modify the settings for the project. For more information,
see 8.1.1 Configuring Project Settings.

Start communication
for all devices

Click Start communication for all devices to start communication between the
software and all the devices. If communication is already in progress between the
software and the devices, this option will not be disabled.

Stop communication
for all devices

Click Stop communication for all devices to stop communication between the soft-
ware and all the devices. If communication is already stopped between the software
and the devices, this option will not be disabled.
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Upgrading and Updating a Project
Upgrading a Project

ii
NOTE
Ensure that you back up the project before upgrading.

Install powermanager V3.5 on the system and upgrade the project in 2 steps.

Step 1

² Click Start > All Programs > SENTRON > powermanager V3.5 > Project Administration to launch
powermanager Project Administration.

² Double-click Doubleclick for list of older projects.
The Project Adminstrator window is displayed.
This window lists all the previous projects from powermanager V3.4 and earlier, which are not yet
upgraded.

²
Select the project you want to upgrade and click .

The Upgrade project window opens.

[sc_pm_update_confirm, 1, en_US]

² Enter the User name and Password.

² Click Confirm.
powermanager upgrades the project.

5.5
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Step 2

² Start the upgraded project with powermanager V3.5.
An older version of a project is automatically updated to the latest version, when it is started in powermanager
V3.5.

[sc_pm_update, 1, en_US]

ii
NOTE
If the update fails, restart powermanager to update the project.
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Standard View

Tabs in Standard View

The Standard view contains the following tabs:

• Dashboard

• Overview

• Selected values

• Power quality

• Harmonics

• Energy

• Trend

• Operations

• Web

• Parameters

Dashboard

The Dashboard tab displays the values of the data points, which are configured in the Dashboard configura-
tion tab corresponding to the selected device.

[sc_Dashboard, 1, en_US]

6.1

6.1.1

6.1.2
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Overview

The Overview tab is available for all devices except virtual devices. This tab displays the summary of different
data point values measured by the devices.
The color next to Alarm field displays the current status of the alarm. The color next to the Communication
field shows the communication status between the device and powermanager.

[sc_pm_4200_overviewtab, 1, en_US]

Figure 6-1 Overview Tab

Selected Values

The selected values tab lists all preselected measured variables with description, current measured value, and
defined unit.
You can preselect the measured values in the Display column of the Configuration tab in the Device Engi-
neering view.

ii
NOTE
By default, the values for the following items are displayed in the Selected values tab.

• Collective active power

• Active energy import tariff

• (EM) cumulated active power import

6.1.3

6.1.4
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[sc_pm_selected_values, 1, en_US]

Figure 6-2 Selected Values Tab

The parameters for Selected values tab are set on the device or on the device type (inheritance). You can
create filters in the system.
If a measured value is highlighted in red, it indicates that the address is deactivated in the configuration.
To add additional measured values:

• Right-click a system, an area, or a device.

• Select Device engineering and click the device or device type.

• Select the measured values for the device or device type.

• Select Display.

• Click Save.

ii
NOTE
When selecting at area level or system level, select the device type from the shortcut menu.
Area level: Inheritance of the list by all devices of the selected device type within the area.
System level: Inheritance of the list by all devices of the selected device type within the station.

Power Quality

The Power quality tab is available only for the PAC3200/3200T/4200/5100/5200 and P850/P855. This tab
displays actual, minimum, and maximum values of the power factor and frequency.
This tab also displays the actual and maximum distortion in the voltage and current values.

[sc_pm_powerquality, 1, en_US]

Figure 6-3 Power Quality Tab

Harmonics

The values of the harmonics are displayed in a bar chart. This tab is only available for the 3WL, P855, P850,
PAC1600 (1681/1682), PAC4200, PAC5100, and PAC5200 devices.

6.1.5

6.1.6
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[sc_pm_harmonics, 1, en_US]

Figure 6-4 Harmonics Tab

Select any one of the following values to display the data:

• Voltage L-N: Harmonics voltage l-n (in %).

• Voltage L-L: Harmonics voltage l-l (in %).

• Current: Harmonics current I (in A).
Select a harmonic to view the detailed values (including time stamp) of the harmonic. The bar chart shows the
harmonic proportions related to the basic oscillation up to the 17th or 31st harmonic.
By default, you see the instantaneous values of the harmonics. Click show maxima to view the maximum
values of the harmonics.

Energy

The Energy tab displays the energy consumption details. This tab enables you to compare the energy
consumption between two different time periods.
To compare the energy consumption between two different time periods:
² Select a Data point, from the drop-down list.

² Select an Interval, from the drop-down list.

² Select an Duration, from the drop-down list.

² Select the Compare option.

6.1.7
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² Click Apply, to compare the energy consumption between two selected time periods.
The comparision is displayed in the form of a graph.

Trend

The Trend tab is available for all devices.
This tab is similar to the Trend window.
The Trend tab displays Voltage, Current, Power, Power interval, Power factor, THD, and Custom. The
custom graph is configured in the Trend configuration tab.
For more information on trending in powermanager, see 7.1.1 Overview.

Status and Commands

The Status and Commands tab consists of 3 sections Digital outputs, Digital inputs, and Commands for
measuring devices. The State of the breaker is displayed for circuit breakers.

Status and Commands Tab

[sc_pm_status_commands, 1, en_US]

Figure 6-5 Status and Commands Tab

You can switch the digital outputs of the PAC3200, PAC3200T, and PAC4200 devices on the Digital outputs
section. For this purpose, configure the digital outputs as remote output in the device.
A lamp icon indicates the switching state:

6.1.8

6.1.9
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Icon State
Signal of the digital output is high (1).
Signal of the digital output is low (0).

Use the button to the right of the lamp icon to switch on or off the digital output.

Digital Inputs
This section displays the digital input and its type of use.

Commands
The commands section contains buttons that can be used to change device settings during runtime.
The commands can only be transferred if password protection is switched off on the device.
The following commands are available:
PAC1665 • Reset energy counter

• Reset work hour counter
• Reset maximum demand values

PAC1682/1661 • Reset energy counter
• Reset work hour counter
• Reset maximum demand values
• Reset maximum/minimum

PAC2200 • Acknowledge diagnostics
• Reset counter

PAC3100 • Acknowledge diagnostics
• Reset maxima
• Reset minima
• Reset counter

PAC3200/PAC3200T • Acknowledge diagnostics
• Reset maxima
• Reset minima
• Reset counter

PAC4200 • Reset operating hours counter
• Reset maxima
• Reset minima
• Reset counter
• Reset event

3VL/3WL • Breaker ON
• Breaker OFF
In addition to the circuit breakers, a symbol indicates the current status.

3VA • Reset min/max

Web

The Web tab is only visible for the PAC1200/PAC2200/PAC3200T, PAC5100/PAC5200, and P850/P855 devices.
This tab displays the Web interface for the PAC5100/PAC5200 and P850/P855 device connected to powerman-
ager.
Use the COMTRADE viewer to view the saved fault records. The COMTRADE view is installed in the following
location:

6.1.10
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C:\Program Files (x86)\Siemens\Energy\ComtradeViewer\V4_58\
For more information about the individual tabs, refer to the respective manuals for PAC1200/PAC2200/
PAC3200T, PAC5100/PAC5200, and SICAM P850/P855.

Parameters

Parameters tab displays the device information. This includes manufacturer, firmware version, module infor-
mation, and so on.

[sc_pm_parameters, 1, en_US]

Figure 6-6 Parameters Tab Display

6.1.11
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KPI

Overview

In this view, you can generate the Key Performance Indicators (KPI) of any building or industry. The view
consists of a tree where you can add KPIs. KPIs can be calculated according to time ranges like day, week,
month, and year.
A cluster of KPIs forms a group. Group1 is available by default. A maximum of 9 KPIs can be created in a group.

Creating a Group

[sc_pm_creategroup_kpiview, 1, en_US]

To create a group:
² Right-click the tree root.

² Click Create group.
The Create group dialog is displayed.

[sc_pm_create_group, 1, en_US]

² Enter a Group name.

² Click Create.
The created group is displayed in the project tree.
For more information on naming a node in the project tree, refer to 5.1 Creating a New Project.

Copying a Group
² Right-click the group.

² Click Copy group.
The copied group can be used for pasting later.

Pasting a Group
A previously copied or cut group can be pasted in the tree root.
² Right-click the tree root.

² Click Paste group.
The Paste group dialog is displayed.

6.2

6.2.1
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[sc_pm_paste, 1, en_US]

² You can enter a New KPI name.

² Click OK.
The pasted group is displayed in the project tree.

Renaming a Group
² Right-click a group.

² Click Rename group.
The Rename group dialog is displayed.
² Enter a New group name.

² Click Apply to confirm.
The group name is changed.

Deleting a Group
² Right-click a group.

² Click Delete group.
The Delete group dialog is displayed.

² Click Yes, to delete the group.
Pasting a KPI
² Right-click the group, where you want to paste the KPI.

² Click Paste KPI.
The Paste KPI dialog is displayed.

² You can enter a New KPI name.

² Click OK to confirm.
The KPI is displayed under the group in the project tree.

Editing the KPI configuration
² Right-click a KPI.

² Click KPI engineering.
The KPI configuration is displayed.

² Make the required changes to the configuration.
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² Click Save to apply the changes made.
Cutting a KPI
² Right-click a KPI.

² Click Cut KPI.
The KPI will be removed from the group once it is pasted into another group.

Copying a KPI
² Right-click a KPI.

² Click Copy KPI.
The copied KPI can be pasted into another group.

Renaming a KPI
² Right-click a KPI.

² Click Rename KPI.
The Rename KPI dialog is displayed.

[sc_pm_renamekpi, 1, en_US]

² Enter a New KPI name.

² Click Apply, to confirm.
The KPI name is changed in the project tree.

Deleting a KPI
² Right-click a KPI.

² Click Delete KPI.
The Information dialog is displayed.

² Click Yes, to confirm.
The KPI will be deleted from the project tree.

Creating a KPI
To create a KPI:
² Right-click a group from the tree.
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[sc_pm_kpi, 1, en_US]

² Select Create KPI.
The Create new KPI dialog is displayed.

² Enter a unique New KPI name.

² Click Create.
The KPI is displayed in the project tree and the KPI engineering view is displayed.
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[sc_pm_data_source, 1, en_US]

²
In the Data source section, click .

The Selection tree for energy values dialog is displayed.
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[sc_pm_sel_tree, 1, en_US]

² Select the required data point.

² Click OK.
The selected Dividend is displayed.
The Units are displayed according to the data point selected.
You can enter a Unit divisor and Converted Unit for the Dividend.
For example, if the data point Active energy import is selected and its Unit is kWh. You can enter 1000
as the Unit divisor and MWh as the Converted unit. This converts 1000 kWh to 1 kMWh.

ii
NOTE
If you do not enter any value for Unit divisor and Converted Unit, by default, the value 1 is taken as Unit
divisor and Unit is taken as Converted Unit.

² Select Manual value or Data point for the Divisor.

² If you select Manual value, you will have to enter a Value and Unit for the KPI calculation.
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- or -

² If you select Data point, the default value (1) is taken and if the selected data point is not a counter
value, the instantaneous value is used for the KPI calculation.

The unit is displayed according to the selected value.

[sc_pm_cost_factor, 1, en_US]

² In the Cost factor settings section, if you select the option Use cost factor, you will have to enter a Cost
factor for the KPI calculation.

² Enter a Currency associated with the cost factor.

[sc_pm_general_settings, 1, en_US]

² In the General settings section, select a Calculation interval from the drop down menu.
According to the selected interval, the KPI will be calculated every hour, day, week, month, or year.

² Enter a Target value.
The target value acts as a reference value for the KPI.

ii
NOTE
The target value is not used for any KPI calculations, but is used in configuring the range associated with
the KPI.

² Select Archive KPI, if you want to archive the KPI calculation results, if not clear it.
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[sc_pm_alarmsettings, 1, en_US]

In the Alarm/Gauge settings section, you can set a range at which you will get an alarm.
These ranges are indicated by three colors:

• Green: The color green indicates the good threshold value range.

• Yellow: The color yellow indicates the warning threshold value range.

• Red: The color red indicates the out of threshold value range.

² Select Enable alert to get an alert when the KPI value is in the red range or above the red range. You can
clear the Enable alert to turn off alerts.

² Click Save, to save the KPI configuration.

² Select the newly created KPI from the KPI tree, its gauge, and bar chart will be displayed.
The gauge is displayed with values, units, and ranges.
If a KPI group is selected from the KPI tree, all its gauges are displayed.

KPI System View

This view lists all the configured KPIs.

Views
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KPI Group View

[sc_KPI_Group_View, 1, en_US]

This view displays all the KPIs in the selected group in the form of gauges. A maximum of 9 KPIs can be
displayed.

• Click More, to display the runtime view of the KPI.

KPI Runtime View

[sc_KPI_View, 1, en_US]

This view displays the selected KPIs bar chart and gauge.
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KPI Data Point Selector

[sc_KPI_Data_pt_Selector, 1, en_US]

The KPI data point selector is used to select data points via KPI measuring groups.

Views
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Input View

Overview

The Input view enables you to add measured values for the manual measuring devices.
In the menu bar, click View > Input to switch to input mode.

ii
NOTE
In the Input view, only the manual measuring devices are visible at the sector, area, and project tree root
level.
The sector, area, and project tree root level display:

• The list of manual measuring devices.

• The latest measured value entered for each device and the timestamp associated with the measured
value.

To enter a measured value for a device:
² Click on the project tree root, an area, or a sector to view the list of available manual measuring devices.

- or -

6.3

6.3.1
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² Click the device to see the list of previous 50 measured values.

² At the sector, area, or project tree root level, double-click the device name in the table for which you
want to add the measured value.
- or -

² Click  on the right-side of the table.
The Input panel window opens.

[sc_pm_inputpanel, 1, en_US]
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² In the Input measured value window, enter the following details:
Date: The date on which the measured value was recorded.
Hour: The hour of the day when the measured value was recorded.
Minute: The quarter of the hour when the measured value was recorded.
Value: The measured value of the device.

ii
NOTE

• The date and time entered in the Input panel dialog must be between the date and time of creation
of the device and the current date and time.

• If the overflow limit set for the device is 0, then ensure that the measured value that you enter is
higher than the measured value entered for the previous timestamps.

² Click OK. The measured value is added to the device.
The updated time and value are now visible under <last time> and <last value> columns respectively.

ii
NOTE
After you add the measured value, the time and value entered is visible under <new time> and <new
value> columns respectively.

² Click  on the right-side of the table, to edit the input Value.
The Input panel dialog opens.
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Reaction Plans

Overview of Reaction Plans

Automated Switching of Digital Outputs
powermanager switches the digital outputs of the interfaced devices automatically. Automation requires
configuration of so-called reaction plans.

Target, Function, and Source
A reaction plan consists of three parts:

• Target
The target of a reaction plan is a digital output. On the device, configure the output as Remote output to
enable switching.

• Function
The function denotes the type of triggering.
The switching operation can be triggered as follows:
– Digital input of a device
– Alert of a measured value
– Switching bit of a load monitoring device

• Source
Any datapoint element (DPE) that provides the selected function serves as the source.
Together, the function and the source are the switching condition.

Assigning the Target and Condition
Prepare a separate reaction plan to switch a digital output automatically.
A maximum of one condition can be assigned to one target. However, you can assign a single condition to
multiple targets.

Validity
The system checks the validity of the source and target when a reaction plan is configured.
The reaction plan is not checked during the runtime. Later changes in the system lead to incorrect parameteri-
zation. When you reopen the configuration view for reaction plans, messages pointing out such arising param-
eterization errors are displayed.

Opening and Closing Reaction Plans

Opening Reaction Plans
To open reaction plans:
² In the menu bar, click View > Reaction plan, to open the reaction plans.

² In the project tree, click an area, a sector, or a device to view all the digital outputs in that object.
Root: Displays digital outputs of all devices in the system.
Area: Displays digital outputs of all devices in the selected area.
Sector: Displays digital outputs of all devices in the selected sector.
Device: Displays digital outputs of the selected device.

²

In the tool bar, click  to return to the Standard view.

6.4

6.4.1

6.4.2
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Configuring Reaction Plans

The reaction plans are listed in tables in 2 tabs:

Parameterize outputs tab
This tab shows:

• Assignment of the target, function, and source

• Switching status of the source
The status of the source can be inverted with a switching command.

[sc_ParameterizeOutputs_tab, 2, en_US]

Figure 6-7 Parameterize Outputs

Switching outputs tab
This tab shows the switching status of the target.
You can force the switching of the digital output using a switching command.

Scope
The reaction plans table lists the existing digital outputs. Additionally, incorrectly parameterized, deactivated,
or reaction plans that can still be configured are visible.
The scope is limited to the level selected in the project tree. All digital outputs existing in the system are listed
when the project tree root is selected.
A digital output only appears once in the list. Therefore, you can assign only one condition to one output.

6.4.3
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Sorting
When you open the reaction plans table, all the columns are automatically sorted in ascending order based on
the digital outputs, that is, the first two columns: output area.sector(s) and Output.
Sorting is possible for all columns.
Click the column header to sort the table in descending order. Click once again to sort the table in ascending
order.

Active Reaction Plan
A reaction plan is created and active in the runtime system when a function and a source are assigned to a
digital output.
The Function column provides the following functions:

• Digital input

• Alert

• Load monitoring
Select a source whenever you select a function. The system opens a corresponding selection window. A func-
tion can be reassigned at any time. The source for a selected function can be changed later.
An existing reaction plan is deactivated by selecting the No function function.
The columns for sources that are not assigned are blank.

Remote Output Prerequisite
The Type of use column shows the type of use of the digital output that has been set on the device, either
directly or with configuration software.
Digital outputs can only be parameterized if they have been configured as a Remote output. The Function
column only offers functions for selection if this prerequisite is met. Otherwise, the Function and Source
columns are blank.

Nonexecutable Parameterization
A configured reaction plan becomes nonexecutable if the type of use of the digital output is modified later,
either directly on the device or via the powerconfig configuration software. In this case, a different value is
visible in the table instead of the Remote output type of use.
The system uses color coding to identify reaction plans that have become nonexecutable. The existing assign-
ment of the target, function, and source is retained.
Color Error class Meaning
Red 1 The output is configured as Rotation. It cannot be switched.
Yellow 2 An alert is selected as the source, but the associated alert handling is not activated.

The alert cannot arrive, and so the reaction plan is not executed.
Grey 3 The address of the source or of the target is deactivated. In this case, the system

does not register the changes or the switching command is not forwarded to the
device.

Executing the Reaction Plan
Switching commands are executed until the reaction plan is deleted. The "No function" function cancels
assignment of the source.
The output remains in its last known state if communication with the source is interrupted. The output status
changes accordingly as soon as communication with the source is established again and its status changes.
The digital output remains in its last known state if communication with the digital output is interrupted. The
output status changes accordingly as soon as communication with the output is established again and the
status of the source changes.
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Logical Inversion
In the Inverted column, you can invert the switching state. Inverting the switching state also inverts the
output status.

Tabs in Reaction Plans

Parameterize Outputs Tab
The columns of the Parameterize outputs tab are sorted according to Targets, Functions, and Sources.
The Parameterize outputs tab has the following columns:

• Digital output location and Digital output
These columns display the digital output of the device that is attached in the designated area and sector
of the project tree.

• Type of use
This column displays the configured type of use of the digital output. Configuration of a reaction plan
requires the Remote output type of use.

• Function
This column is used to set the trigger for the switching operation of the digital output.
You can set one of the following triggers:
– Digital input of the device
– Alert of a measured value
– Switching bit of a load monitor

Click the table cell to open a list box. You can select the trigger types from this list.
Click on a list entry to open the corresponding dialog for selection of the source.

• Source location and Source
These columns display the datapoint element attached in the designated area and sector of the project
tree. This provides the selected function.
Click a cell to open a selection window.

• Source state
This column displays whether the source is switched on or off.

• Inverted
You can invert the switching state using this column.
If this column is set to YES, then logical inversion is switched on.
If this column is set to NO, then logical inversion is switched off.

Switch Outputs Tab
The Switch outputs tab shows the switching status of the digital output. You can change the switching status
using a switching command.
The Switch outputs tab has the following columns:

• Digital Output location and Digital output
These columns display the digital output of the device that is attached in the designated area and sector
of the project tree.

• Switching group
This column displays the switch group.

• Type of use
This column displays the configured type of use of the digital output. Configuration of a reaction plan
requires the Remote output type of use.

6.4.4

6.4.4.1

6.4.4.2
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• State
This column displays the switching state of the digital output.
If the switching state is OFF, then the digital output is low.
If the switching state is ON, then the digital output is high.

• Switch
This column displays the command for switching the digital output.
Change the command to OFF to switch the signal of the digital output to low.
Change the command to ON to switch the signal of the digital output to high.
Based on the change in the switching status in this column, the values in the Status columns are
updated.

Selecting a Source

Digital Input Function
The Digital input function forwards the status of the digital input to the digital output:

• The digital output switches to the ON status if the digital input switches to the ON status.

• The digital output switches to the OFF status if the digital input switches to the OFF status.
Digital inputs of all devices in the source system are offered as a binary input, regardless of their parameteriza-
tion:

• PAC2200: 1 digital input and 1 digital output

• PAC4200: At least two digital inputs. Up to 10 digital inputs if 2 DI/DO modules are fitted.

• PAC3200/PAC3200T: 1 digital input

• PAC3100: 2 digital inputs

• Generic Modbus device: 10 digital inputs
A filtered view of the project tree serves to select the source. Click Digital input value in the Function column
to open the Selection tree for digital inputs dialog.

6.4.5
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[sc_pm_dig_input, 1, en_US]

Figure 6-8 Selection Tree for Digital Inputs

Click OK button to transfer the selected source to the table of reaction plans and closes the dialog. Click
Cancel to cancel selection.

Selection Tree for Alert
Depending on the alert triggered by a specific event, the Alert function switches the digital output.
You can select the high and low limits of the analog values that have an alert configuration, regardless of
whether the alert itself is activated.
Alerts that are not activated are shown in gray in the list of reaction plans. They do not trigger a reaction plan.
Use a filtered view of the project tree to select the source. Click the Alert value in the Function column to
open the Selection tree for alerts window.
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[sc_SelectionTree_Alerts, 2, en_US]

Figure 6-9 Selection Tree for Alerts Window

Click OK to transfer the selected source to the reactions plan table and close the window.

Selection Tree for Load Monitoring
The Load monitoring function switches the digital output depending on the switching recommendation of the
assigned load monitor.
The following switching bits represent the switching recommendation:

• switchNo
The SwitchNo bit is set when the correction power is within the configured limit curve.

• switchOff
The switchOff bit is set when load has to be deactivated to avoid exceeding the setpoint in the tariff
interval and the correction power lies outside the limit curve.

Views
6.4 Reaction Plans

120 powermanager,  , Help
E50417-H1076-C550-A7, Edition 06.2019



• switchOn
The switchOn bit is set when load is connected without exceeding the setpoint in the tariff interval and
the correction power lies within the limit curve.

Use a filtered view of the project tree to select the load monitoring function and switching bits. Click the Load
monitoring value in the Function column to open the Selection tree for load monitoring window.

[sc_SelectionTree_LM, 2, en_US]

Figure 6-10 Selection Tree for Load Monitoring Window

Saving the Configuration

Click Save, to save the configurations made in database.
If the configuration contains errors, a dialog appears with a warning.

6.4.6
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Restoring the Configuration

Click Reset, to restore the last save configuration in the tables.

Deleting Devices

Before deleting a device from the system, check whether any of its elements is used as a source or target in a
reaction plan.
If an element is being used, then the system displays a message with instructions to resolve the issue.
You cannot delete the device until the corresponding reaction plans have been deleted.

6.4.7

6.4.8
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Data Evaluation - Basic Report

Basic Report

Report View

[sc_pm_reportview, 1, en_US]

The Report view is used to create, view, and configure reports and report templates. It consists of 4 tabs,
Create report, View report, Template management, and Schedule.
The reports created can be saved to an external server via a web client.

ii
NOTE
Report license is not required for working with Report view.

Tabs in Report View

Create report
The Create report tab displays all the available report templates in the form of a template tree. Each report
template can be configured to create a different report. Reports can be scheduled to be created in regular
intervals of time.

View reports
The View reports tab displays the type, file name, and the last modified time of all the created reports.

6.5

6.5.1

6.5.1.1

6.5.1.2

Views
6.5 Data Evaluation - Basic Report

powermanager,  , Help 123
E50417-H1076-C550-A7, Edition 06.2019



Template management
The Template management tab displays the following types of report templates, which can be created:
Types of Reports, which can be created:

• Absolute energy

• Cost center allocation

• Energy analysis

• Energy export

• KPI

• Load duration curve

• Load variance analysis

• Sankey

• Standard

• Top 10 energy

• Total energy

Settings
The Settings tab is used to configure the medium configuration, cost center configuration, and display the
schedule of the reports to be generated.

Creating Report Templates and Reports

Creating a Report Template

² In the Report view, select the Template management tab.

² Right-click a node from the template tree.

[sc_pm_add_template, 1, en_US]

² Select Add template.

6.5.2

6.5.2.1
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The Add template dialog is displayed.

[sc_pm_createtemplate, 1, en_US]

² Enter a Template name.

² Click Create.
The newly created template is added under the corresponding node and its configuration is displayed.

ii
NOTE
Report scheduling is not possible in a client project.

Absolute Energy
This report gives an overview of the absolute energy consumption of the data points for the selected time
intervals. It shows the data point which has the most influence on the total energy consumption. The report
can be created with a bar chart or an area chart.

Creating an Absolute Energy Report Template

²

Click  to add a data point.

The Selection tree for energy values dialog is displayed.

6.5.2.2

Views
6.5 Data Evaluation - Basic Report

powermanager,  , Help 125
E50417-H1076-C550-A7, Edition 06.2019



[sc_pm_selectiontree, 1, en_US]

² Select a data point from the tree.

² Click OK.

The data point is added to the list.

Views
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[sc_pm_absoluteenergy, 1, en_US]

You can add, delete, or edit data points using the respective buttons.
You can deselect the Use engg settings option in the Use engg settings column. This enables you to change
the Divisor and Converted Unit values for each data point in the corresponding column.
² To delete a data point from the list, select a data point.

²
Click  to delete the data point from the list.
You can select Create Min/Max/Avg values option to view the minimum, maximum, and average values
in the report. These values will be displayed in the form of a graph.
You can also select Highlight Min/Max value option to highlight the minimum and maximum values in
the report.

² Click Save, to save the template.

Creating an Absolute Energy Report

² In the Report view, select the Create report tab.
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[sc_pm_absolute_energy_Create_rep, 1, en_US]

² Select the required absolute energy template from the template tree.
The Create report tab is displayed in the Absolute energy section.

² Select a value for Duration.
The report values will be displayed based on the duration selected.

² Click  select a period.

² Select an interval accordingly.
The report values will be generated at the selected interval.
For example, if you select the interval as 15 mins then report values are generated for every 15 mins.

² Select a Chart type.
The report values can be represented in the form of a stacked area, stacked bar, or bar chart.

² Select the File type, either Excel or Pdf.
²

Select a Path by clicking .
The Choose a File dialog is displayed.

ii
NOTE
If the default path is changed, the created report will not be listed in the View reports tab list.

² Enter a File name.

² Click Save, to save the file name.

² Click Create report, to create the report in the selected path.
To schedule the creation of the report at regular intervals:
² Select the Schedule tab.

Views
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[sc_pm_absolute_energy_Sche, 1, en_US]

² In the Schedule parameters section, select a Schedule interval.
² Click  and select the Next trigger.

The next report will be generated on the displayed time.

² Select the Status as Active, if you want the report to be generated.

² In the Data parameters section, select the value for Duration.

² Select an Interval accordingly.

² Select a Chart type.
The data parameters report is generated according to the schedule parameters configuration.
² In the Report parameters section, select a File type, either Excel or PDF.
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²
Select a path by clicking .
The Choose a Folder dialog is displayed.

² Click Select Folder.
The selected folder path will be displayed.

² You can select the Email option to Email the report.
Click Save to schedule the creation of the report.
For more information on how to configure an Email ID, refer to 8.3 Configuring E-Mail Server Settings.

Cost Center Allocation
The cost center report calculates the total energy consumption and costs for different mediums associated
with each cost center. The report can be used for internal cost allocation by any company.

Creating an Cost Center Allocation Report Template

²

Click  to add a data point.
The Selection tree for energy values dialog is displayed.

² Select a data point in the tree.

² Click OK.
The data point is added to the list.

[sc_pm_costcenter, 1, en_US]

You can add, delete, or edit data points using the respective buttons.
You can deselect the Use engg settings option in the Use engg settings column. This enables you to change
the Divisor and Converted Unit values for each data point in the corresponding column. You can change the
Medium, Cost center, and Weighting factor column values. The weighting factor is the proportional assign-
ment of the counted consumption values for the selected cost center, expressed as a decimal factor.
For more information on medium, refer to 6.5.3 Settings Tab.
² To delete a data point from the list, select a data point.

6.5.2.3

Views
6.5 Data Evaluation - Basic Report

130 powermanager,  , Help
E50417-H1076-C550-A7, Edition 06.2019



²
Click  to delete the data point from the list.
You can select Create Min/Max/Avg values option to view the minimum, maximum, and average values
in the report. These values will be displayed in the form of a graph.
You can also select Highlight Min/Max value option to highlight the minimum and maximum values in
the report.

² Click Save, to save the template.

Creating an Cost Center Allocation Report

² In the Report view, select the Create report tab.

[sc_pm_cost_center_create_rep, 1, en_US]

² Select the required cost center allocation template from the template tree.
The Create report tab is displayed in the Cost Center Allocation section.

² Select the value for Duration.
The report values will be displayed based on the duration selected.

² Click  to select a period.

² Select an interval accordingly.
The report values will be generated at the selected interval.
For example, if you select the interval as 15 mins then report values are generated for every 15 mins.

² Select a Chart type.
The report values can be represented in the form of a bar or pie chart.

² Select the File type, either Excel or Pdf.
²

Select a Path by clicking .
The Choose a File dialog is displayed.
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ii
NOTE
If the default path is changed, the created report will not be listed in the View reports tab list.

² Enter a File name.

² Click Save, to save the file name.

² Click Create report to create the report in the selected path.
To schedule the creation of the report at regular intervals:
² Select the Schedule tab.

[sc_pm_cost_center_Sche, 1, en_US]

² In the Schedule parameters section, select a Schedule interval.
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² Click  and select the Next trigger.
The next report will be generated on the displayed time.

² Select the Status as Active, if you want the report to be generated.
In the Data parameters section,
² Select the value for Duration.

² Select a Chart type.
The data parameters report is generated according to the schedule parameters configuration.

² In the Report parameters section, select a File type, either Excel or PDF.

²
Select a Path by clicking .
The Choose a Folder dialog is displayed.

² Click Select Folder.
The selected folder path will be displayed.

² You can select the Email option to Email the report
Click Save to schedule the creation of the report.
For more information on how to configure an Email ID, refer to 8.3 Configuring E-Mail Server Settings.

Energy Analysis
This report analyses the energy consumption and the corresponding power demand value for a time period of
a year. It gives an overview of the power demand curves for the year and each month. Also the report shows
the energy consumption value of each month and the corresponding power demand peak value. Two years
can also be compared.

Creating an Energy Analysis Report Template

²
Click  to add a data point.
The Selection tree for energy values dialog is displayed.

² Select a data point from the tree.

6.5.2.4
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² Click OK.
The data point is added to the list.

You can deselect the Use engineer settings option. This enables you to change the Divisor and
Converted Unit values for each data point in the corresponding column.
To delete a data point from the list:

² Select a data point from the list.
You can select Create Min/Max/Avg values option to view the minimum, maximum, and average values
in the report. These values will be displayed in the form of a graph.
You can also select Highlight Min/Max value option to highlight the minimum and maximum values in
the report.

² Click Save to save the template.

Creating an Energy Analysis Report

² In the Report view, select the Create report tab.
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[sc_pm_Energy_Analysis_Create_Rep, 1, en_US]

² Select the required Energy Analysis template from the template tree.
The Create report tab is displayed in the Energy Analysis section.

² Select the value for Duration.
The report values will be based on the duration selected.

² Click  select a period.

² Select Compare.

² Click  select a period.
The data point values between two selected periods will be compared and a report will be generated.

² Select the File type, either Excel or Pdf.
²

Select a Path by clicking .
The Choose a File dialog is displayed.

ii
NOTE
If the default path is changed, the created report will not be listed in the View reports tab list.

² Enter a File name.

² Click Save, to save the file name.

² Click Create report, to create the report in the selected path.
To schedule the creation of the report at regular intervals:
² Select the Schedule tab.
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[sc_pm_Energy_Analysis_Sche, 1, en_US]

² In the Schedule parameters section, select a Schedule interval.
² Click  and select the Next trigger.

The next report will be generated on the displayed time.

² Select the Status as Active, if you want the report to be generated.

² In the Data parameters section, select the value for Duration.

² Select an interval accordingly.

² Select a Chart type.
The data parameters report is generated according to the schedule parameters configuration.

In the Report parameters section,
² Select a File type, either Excel or PDF.

²
Select a Path by clicking .
The Choose a Folder dialog is displayed.
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² Click Select Folder.
The selected folder path will be displayed.

² You can select the Email option to Email the report.
Click Save to schedule the creation of the report.
For more information on how to configure an Email ID, refer to 8.3 Configuring E-Mail Server Settings.

Energy Export
The Energy export report is available for exporting energy and power demand values with an interval of 15
min. This report displays all the values of the selected data points for a selected time range in the table.

Creating an Energy Export Template

²

Click  to add a data point.
The Selection tree for energy values dialog is displayed.

[sc_pm_selectiontree_ee, 1, en_US]

6.5.2.5
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² Select a data point from the tree.

² Click OK.
The data point is added to the list.

You can add, delete, or edit data points using the respective buttons.
You can deselect the Use engg settings option in the Use engg settings column. This enables you to
change the Divisor and Converted Unit values for each data point in the corresponding column.
To delete a data point from the list, proceed as follows:

² Select a data point in the list.

²
Click  to delete the data point from the list.
You can select the Create Min/Max/Avg values in a report option to view the minimum, maximum, and
average values in the report. These values will be displayed in the form of a graph.
You can also select the Highlight Min/Max values in a report option to highlight the minimum and
maximum values in the report.

² Click Save to save the template.

Creating an Absolute Energy Report

² In the Report view, select the required energy export template from the template tree.
The Create report tab is displayed in the Energy export section.
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[sc_pm_ee_createreport, 1, en_US]

² Select a value for the Duration.
The report values will be displayed based on the duration selected.

² Click  to select a period.

ii
NOTE
By default, the interval is set as 15 min. It indicates that the report values are generated for every 15 min.

² Select the File type, either Excel, PDF, or CSV.

²
Select a Path by clicking .
The Choose a File dialog is displayed.

ii
NOTE
If you change the default path, the created report will not be listed in the View reports tab list.

² Enter a File name.

² Click Save to save the file name.

² Click Create report to create the report in the selected path.
To schedule the creation of the report at regular intervals, proceed as follows:
² Select the Schedule tab.
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[sc_pm_ee_schedule, 1, en_US]

² In the Schedule parameters section, select a Schedule interval.
² Click  and select the Next trigger.

The next report will be generated on the selected time.

² Select the Status as Active, if you want the report to be generated.

² In the Data parameters section, select the value for Duration.
The data parameters report is generated according to the schedule parameters configuration.
² In the Report parameters section, select a File type, either Excel, PDF, or CSV.

²
Select a Path by clicking .
The Choose a Folder dialog is displayed.

² Click Select Folder.
The selected folder path will be displayed.
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² You can select the Email option to e-mail the report.
Click Save to schedule the creation of the report.
For more information on how to configure an e-mail ID, refer to 8.3 Configuring E-Mail Server Settings.

Key Performance Indicator (KPI)
This report displays the values of the KPI data points for a selected time range in a table and a bar chart.

Creating a KPI Template

²

Click  to add a data point.
The Select data point dialog is displayed.
You can select the required KPI data points via the KPI data point tab.

To select the data points via the KPI data point tab:

² Select the required data point from the selection tree.

6.5.2.6
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² Click OK, to add the data point to the data-points list.

You can add, delete, or edit data points by using the respective buttons.
To delete a data point from the list, proceed as follows:

² Select a data point from the list.

²
Click  to delete the data point from the list.

² Click Save to save the template.

Creating a KPI Report

² In the Report view, select the required KPI template from the template tree.
The Create report tab is displayed in the KPI section.

[sc_pm_createreport, 1, en_US]

² Select the value for Duration.
The report values will be based on the duration selected.
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² Click  to select a period.

² Select the File type, either Excel, PDF, or CSV.

²
Select a Path by clicking .
The Choose a File dialog is displayed.

ii
NOTE
If you change the default path, the created report will not be listed in the View reports tab list.

² Enter a File name.

² Click Save to save the file name.

² Click Create report to create the report in the selected path.
To schedule the creation of the report at regular intervals, proceed as follows:
² Select the Schedule tab.
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[sc_pm_kpischedule, 1, en_US]

² In the Schedule parameters section, select a Schedule interval.
² Click  and select the Next trigger.

The next report will be generated for the displayed time.

² if you want the report to be generated, select the Status as Active.
In the Data parameters section, select the value for Duration.
² In the Report parameters section, select a File type, either Excel, PDF, or CSV.

²
Select a Path by clicking .
The Choose a Folder dialog is displayed.

² Click Select Folder.
The selected folder path will be displayed.

² You can select the Email option to mail the report.
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² Click Save to schedule the creation of the report.
For more information on how to configure an Email ID, refer to 8.3 Configuring E-Mail Server Settings.

Load Duration Curve
This report displays the power demand values and the duration of each power demand value used in the
selected time period. It displays a detailed view of the 50 highest power demand values of the selected time
interval and also and analysis of these values over the day.

Creating an Load Duration Curve Report Template

[sc_Load_Duration_Curve_Data_pt_Selection, 1, en_US]

²
Click  to add a power period data point.
The Data point selector for energy values dialog is displayed.

² Select a power period data point from the tree.

6.5.2.7
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²
Click .
The name of the selected data point is displayed in the Data point field.

You can deselect the Use engineering settings, it enables you to change the Unit, Divisor, and
Converted Unit values.
You can select Create Min/Max/Avg values option to view the minimum, maximum, and average values
in the report. These values will be displayed in the form of a graph.
You can also select Highlight Min/Max value option to highlight the minimum and maximum values in
the report.

² Click Save, to save the template.

Creating an Load Duration Curve Report

² In the Report view, select the Create report tab.

[sc_pm_Load_Duration_Curve_Create_Report, 1, en_US]

Views
6.5 Data Evaluation - Basic Report

146 powermanager,  , Help
E50417-H1076-C550-A7, Edition 06.2019



² Select the required Load Duration Curve template from the template tree.
The Create report tab is displayed in the Load Duration Curve section.

² Select the value for Duration.
The report values will be based on the duration selected.

² Click  select a period.

² Select File type, either Excel or Pdf.
²

Select a Path by clicking .
The Choose a File dialog is displayed.

ii
NOTE
If the default path is changed, the created report will not be listed in the View reports tab list.

² Enter a File name.

² Click Save, to save the file name.

² Click Create report, to create the report in the selected path.
To schedule the creation of the report at regular intervals:
² Select the Schedule tab.
In the Schedule parameters section,
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[sc_pm_Load_Duration_Curve_Sche, 1, en_US]

² Select a Schedule interval.
² Click  and select the Next trigger.

The next report will be generated on the displayed time.

² Select the Status as Active, if you want the report to be generated.
In the Data parameters section,
² Select the value for Duration.

The data parameters report is generated according to the schedule parameters configuration.

² In the Report parameters section, select a File type, either Excel or PDF.

²
Select a Path by clicking .
The Choose a Folder dialog is displayed.

² Click Select Folder.
The selected folder path will be displayed.
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² You can select the Email option to e-mail report.
Click Save, to schedule the creation of the report.
For more information on how to configure an Email ID, refer to 8.3 Configuring E-Mail Server Settings.

Load Variance Analysis
This report shows the power demand values for the selected time period and shows the range of the power
demand values for each time. Based on this you will see how wide the variance of the load for a certain time
period.

Creating an Load Variance Analysis Report Template

²
Click  to add a power period data point.
The Data point selector for energy values dialog is displayed.

² Select a power period data point from the tree.

²
Click .
The name of the selected data point is displayed in the Data point field.

You can deselect the Use engineering settings, it enables you to change the Divisor and Converted
Unit values.
You can select Create Min/Max/Avg values option to view the minimum, maximum, and average values
in the report. These values will be displayed in the form of a graph.
You can also select Highlight Min/Max value option to highlight the minimum and maximum values in
the report.

² Click Save, to save the template.

Creating an Load Variance Analysis Report

² In the Report view, select the Create report tab.

6.5.2.8
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[sc_pm_Load_Variance_Cre_Rep, 1, en_US]

² Select the required Load Variance Analysis template from the template tree.
The Create report tab is displayed in the Load Variance Analysis section.

² Select the value for Duration.
The report values will be based on the duration selected.

² Click  select a period.

² Select an interval accordingly.
The report values will be generated at every interval.

² Select a Chart interval.
For example: If Days is selected, the report values will be generated every day.

² Select File type, either Excel or Pdf.
²

Select a Path by clicking .
The Choose a File dialog is displayed.

ii
NOTE
If the default path is changed, the created report will not be listed in the View reports tab list.

² Enter a File name.

² Click Save, to save the file name.

² Click Create report, to create the report in the selected path.
To schedule the creation of the report at regular intervals:
² Select the Schedule tab.
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[sc_pm_Load_Variance_sche, 1, en_US]

² In the Schedule parameters section, select a Schedule interval.
² Click  and select the Next trigger.

The next report will be generated on the displayed time.

² Select the Status as Active, if you want the report to be generated.
In the Data parameters section,
² Select the value for Duration.

² Select a Chart interval.
The data parameters report is generated according to the schedule parameters configuration.

² In the Report parameters section, select a File type, either Excel or PDF.
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²
Select a Path by clicking .
The Choose a Folder dialog is displayed.

² Click Select Folder.
The selected folder path will be displayed.

² You can select the Email option to e-mail the report.
Click Save to schedule the creation of the report.
For more information on how to configure an Email ID, refer to 8.3 Configuring E-Mail Server Settings.

Sankey
This report gives an overview of the energy consumption of the data points for the selected time intervals. You
can view the total energy consumption at each level in terms of percentage.

Creating a Sankey Report Template

² Select the option Add template in the context menu for Sankey.
The Add template dialog is displayed.

[sc_pm_addtemplate, 1, en_US]

² Enter the Template name.

ii
NOTE
You can change the template name according to the language by using the Text for every language
dialog.

²
Click .

The Text for every language dialog opens.
² In the Text column, enter the desired name for the template in the required languages.
The template name entered for each language will be displayed according to the language selected in the UI.
² Click Ok to confirm.

² Click Create.
The template is created and the Source Parameter assignment area is displayed in the UI.

6.5.2.9
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[sc_pm_sankey_template, 2, en_US]

ii
NOTE
The Source Parameter assignment area allows you to assign the data points to calculate and view the
energy leakage at template level in the generated report. If you do not assign any data point, energy

leakage information is not displayed in the report. Click  to delete the data point.

² Right-click the template name and select Create group.
The Create group dialog is displayed.

[sc_pm_creategroup, 1, en_US]

² Enter the Group name.
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ii
NOTE
You can create multiple groups or elements with the same name.

²
Click .

The Text for every language dialog opens.
² In the Text column, enter the desired name for the group in the required languages.
The group name entered for each language will be displayed according to the language selected in the UI.
² Click Create.
The group is created and the Source Parameter assignment area is displayed in the UI. You can create
elements or groups under a group using the context menu options. You can also copy and paste a group via
the context menu options.

[sc_pm_group_context, 2, en_US]

ii
NOTE
The Source Parameter assignment area allows you to assign the data points to calculate and view the
energy leakage at the group level in the generated report. If you do not assign any data point, energy

leakage information is not displayed in the report. Click  to delete the data point.

² Select Create element.
The Create new element dialog is displayed.
² Enter the new element name.

² Click Create.
The element is created and the Consumption Parameter assignment area is displayed in the UI.

[sc_pm_element, 2, en_US]
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²
Click  to add a data point.

The Selection tree for energy values dialog is displayed.
² Select a data point from the tree.

² Click OK.
The data point is added and displayed in the Data point text field.

[sc_pm_selection_tree, 2, en_US]

You can deselect the Use engineering settings option in the Consumption Parameter assignment area.
This enables you to change the Divisor and Converted Unit values for each data point.
² Click Save to save the template.
A confirmation prompt appears to confirm the selection of new settings.

ii
NOTE
You can add and save only the energy data points. The units of all the data points created in a Sankey tree
must be the same.

² Click Yes.
The template is created with the selected energy data point.

Creating a Sankey Report

² In the Report view, select the required Sankey template displayed under the Sankey node.
The Create report tab is displayed in the Sankey section.
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[sc_pm_createreport_sankey, 1, en_US]

² Select a value for Duration.
The report values will be displayed based on the duration selected.

² Click  to select a period.

² Select an interval accordingly.
The report values will be generated at the selected interval.
For example, if you select the interval as 15 min, then report values are generated for every 15 mins.

² Select the File type, either Excel or PDF.

²
Select a Path by clicking .
The Choose a File dialog is displayed.

ii
NOTE
If you change the default path, the created report will not be listed in the View reports tab list.

² Enter a File name.

² Click Save to save the file name.

² Click Create report to create the report in the selected path.
To schedule the creation of the report at regular intervals, proceed as follows:
² Select the Schedule tab.
The Schedule tab details are displayed in the UI:
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[sc_pm_schedule_sankey, 1, en_US]

² In the Schedule parameters section, select the Schedule interval
² Click  and select the Next trigger.

The next report will be generated on the displayed time.

² If you want to generate the report, select the Status as Active.

² In the Data parameters section, select the value for Duration.
The data parameters report is generated according to the schedule parameters configuration.
² In the Report parameters section, select a File type, either Excel or PDF.

²
Select a path by clicking .
The Choose a Folder dialog is displayed.

² Click Select Folder.
The selected folder path will be displayed.
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² You can select the Email option to e-mail the report.
Click Save to schedule the creation of the report.
For more information on how to configure an Email ID, refer to 8.3 Configuring E-Mail Server Settings.

Standard
This report can be used for any measuring values that is archived. This report displays all the values of the
selected data points for a selected time period in a table.

ii
NOTE
A standard template can be exported and used in advanced reports.

Creating an Standard Report Template

²

Click  to add a data point.
The Data point selector dialog is displayed.
You can select the required data points via the Measured value tab or the KPI tab.
To select data points via the Measured value tab:

6.5.2.10
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[sc_pm_selectdp, 1, en_US]

² In the Filter settings section, select the required Device type from the drop-down list.

² Enter the Device name.

² Enter which Group it belongs to.

² Enter the required Measured value.

² Select the required data point from the selection tree.

² Click OK, to add the data point to the data point list.

You can add multiple data points above or below the selected data point in the list by using  or .
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[sc_pm_datapoint, 1, en_US]

You can add, delete, or edit data points by using the respective buttons.
You can deselect the Use engg settings option in the Use engg settings column. This enables you to change
the Divisor and Converted Unit values for each data point in the corresponding column. To generate a sum of
the values for the selected data point in the report, you can select the Sum option in the Sum column.
² To delete a data point from the list, select a data point.

²
Click  to delete the data point from the list.
You can select Create Min/Max/Avg values option to view the minimum, maximum, and average values
in the report. These values will be displayed in the form of a graph.
You can also select Highlight Min/Max value option to highlight the minimum and maximum values in
the report.

² Click Save, to save the template.

Creating an Standard Report

² In the Report view, select the Create report tab.

² Select the required Standard template from the template tree.
The Create report tab is displayed in the Standard section.
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[sc_pm_std_createrep, 2, en_US]

² Select the value for Duration.
The report values will be based on the duration selected.

² Click  to select a period.

² Select an interval accordingly.
The report values will be generated at the selected interval.
For example, if you select the interval as 15 mins then report values are generated for every 15 mins.
On selecting the check box Additional interval (+1), the report values are generated with an additional
interval along with the existing intervals.

² Select a File type, either Excel, PDF, or CSV.

ii
NOTE
When you update the project from an older version to the latest version, the CSV export templates and the
corresponding schedules will be displayed under the standard reports.

²
Select a Path by clicking .
The Choose a File dialog is displayed.

ii
NOTE
If the default path is changed, the created report will not be listed in the View reports tab list.

² Enter a File name.

² Click Save, to save the file name.

² Click Create report, to create the report in the selected path.
To schedule the creation of the report at regular intervals:
² Select the Schedule tab.
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[sc_pm_std_createsch, 2, en_US]

² In the Schedule parameters section, select a Schedule interval.
² Click  and select the Next trigger.

The next report will be generated for the displayed time.

² Select the Status as Active, if you want the report to be generated.

² In the Data parameters section, select the value for Duration.

² Select an Interval accordingly.
On selecting the check box Additional interval (+1), the report values are generated with an additional
interval along with the existing intervals.
The data parameters report is generated according to the schedule parameters configuration.

² In the Report parameters section, select a File type, either Excel or PDF.
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²
Select a Path by clicking .
The Choose a Folder dialog is displayed.

² Click Select Folder.
The selected folder path will be displayed.

² You can select the Email option to e-mail the report.
Click Save to schedule the creation of the report.
For more information on how to configure an Email ID, refer to 8.3 Configuring E-Mail Server Settings.

Top 10 Energy
The Top 10 energy report displays the details of the top 10 consumers of the active energy and reactive
energy across the powermanager system.

ii
NOTE
By default, all the devices with the respective data points are considered for calculation of energy values.
Separate configuration of data points is not required.

Creating a Top 10 Active Energy Report

² In the Report view, click Top 10 energy > Top 10 active energy.
The Top 10 active energy report view is displayed.
² Select the Create report tab.

[sc_pm_top10_ae, 2, en_US]

6.5.2.11
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² Select the value for Duration.
The report values will be based on the duration selected.

² Click  to select a period.

² Select a File type, either Excel or PDF.

² Select the checkbox option in the Exclude column for the respective device under the Exclude devices
from Top 10 area to exclude the device from the Top 10 active energy report.

²
Select a Path by clicking .
The Choose a File dialog is displayed.

ii
NOTE
If you change the default path, the created report will not be listed in the View reports tab list.

² Enter a File name.

² Click Save to save the file name.

² Click Create report to create the report in the selected path.
To schedule the creation of the report at regular intervals, proceed as follows:
² Select the Schedule tab.

[sc_pm_top10_ae_schedule, 2, en_US]

² In the Schedule parameters section, select a Schedule interval.
² Click  and select the Next trigger.

The next report will be generated for the displayed time.

² If you want the report to be generated, select the Status as Active.
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² In the Data parameters section, select the value for Duration.
The data parameters report is generated according to the schedule parameters configuration.
² In the Report parameters section, select a File type, either Excel or PDF.

²
Select a Path by clicking click .
The Choose a Folder dialog is displayed.

² Click Select Folder.
The selected folder path will be displayed.

² You can select the Email option to e-mail the report.

² Select the checkbox option in the Exclude column for the respective device under the Exclude devices
from Top 10 area to exclude the device from the Top 10 active energy report.

² Click Save to schedule the creation of the report.
For more information on how to configure an Email ID, refer to 8.3 Configuring E-Mail Server Settings.

Creating a Top 10 Reactive Energy Report

² In the Report view, click Top 10 energy > Top 10 reactive energy.
The Top 10 reactive energy report view is displayed.
² Select the Create report tab.

[sc_pm_top10_re, 2, en_US]

² Select the value for Duration.
The report values will be based on the duration selected.
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² Click  to select a period.

² Select a File type, either Excel or PDF.

² Select the checkbox option in the Exclude column for the respective device under the Exclude devices
from Top 10 area to exclude the device from the Top 10 reactive energy report.

²
Select a Path by clicking .
The Choose a File dialog is displayed.

ii
NOTE
If you change the default path, the created report will not be listed in the View reports tab list.

² Enter a File name.

² Click Save, to save the file name.

² Click Create report, to create the report in the selected path.
To schedule the creation of the report at regular intervals:
² Select the Schedule tab.
In the Schedule parameters section, select a Schedule interval.

[sc_pm_top10_re_schedule, 2, en_US]

² Click  and select the Next trigger.
The next report will be generated for the displayed time.

² If you want to generate the report, select the Status as Active.

² In the Data parameters section, select the value for Duration.
The data parameters report is generated according to the schedule parameters configuration.
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² In the Report parameters section, select a File type, either Excel or PDF.

²
Select a Path by clicking .
The Choose a Folder dialog is displayed.

² Click Select Folder.
The selected folder path will be displayed.

² You can select the Email option to e-mail the report.

² Select the checkbox option in the Exclude column for the respective device under the Exclude devices
from Top 10 area to exclude the device from the Top 10 reactive energy report.

² Click Save to schedule the creation of the report.
For more information on how to configure an Email ID, refer to 8.3 Configuring E-Mail Server Settings.

Total Energy
This report displays the total energy consumption of a selected data point for the selected time period. The
report can be created with a bar chart or a pie chart.

Creating an Total Energy Report Template

²

Click  to add a data point.
The Selection tree for energy values dialog is displayed.

² Select a data point from the tree.

² Click OK.
The data point is added to the list.

[sc_pm_totalenergy, 1, en_US]

You can add, delete, or edit data points using the respective buttons.
You can deselect the User engg settings option in the Use engg settings column. This enables you to change
the Divisor and Converted Unit values for each data point in the corresponding column.
² To delete a data point from the list, select a data point.

²
Click  to delete the data point from the list.

6.5.2.12
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² Click Save, to save the template.

Creating an Total Energy Report

² In the Report view, select the Create report tab.

² Select the required Total Energy template from the template tree.
The Create report tab is displayed in the Total Energy section.

[sc_pm_te_cr, 1, en_US]

² Select the value for Duration.
The report values will be based on the duration selected.

² Click  select a period.

² Select Compare.

² Click  select a period.
The data point values between two selected periods will be compared and a report will be generated.

² Select a Chart type.
The report values will be represented in the form of the chart type selected.

² Select File type, either Excel or Pdf.
²

Select a Path by clicking .
The Choose a File dialog is displayed.

ii
NOTE
If the default path is changed, the created report will not be listed in the View reports tab list.
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² Enter a File name.

² Click Save, to save the file name.

² Click Create report, to create the report in the selected path.
To schedule the creation of the report at regular intervals:
² Select the Schedule tab.

[sc_pm_te_cs, 1, en_US]

² In the Schedule parameters section, select a Schedule interval.
² Click  and select the Next trigger.

The next report will be generated on the displayed time.

² Select the Status as Active, if you want the report to be generated.

² In the Data parameters section, select the value for Duration.
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² Select a Chart type.
The data parameters report is generated according to the schedule parameters configuration.

² In the Report parameters section, select a File type, either Excel or PDF.

²
Select a Path by clicking  .
The Choose a Folder dialog is displayed.

² Click Select Folder.
The selected folder path will be displayed.

² You can select the Email option to e-mail the report.
Click Save to schedule the creation of the report.
For more information on how to configure an Email ID, refer to 8.3 Configuring E-Mail Server Settings.

Settings Tab

The Settings tab consists of Medium configuration, Cost center configuration, and Schedule tabs.

Medium Configuration Tab
The Medium configuration tab allows you to set tariffs for the different mediums that are used.
A sub tariff set is a charged price that refers to one media unit (kWh, m³) and which applies to one specific
period of time.
To set the currency to calculate the cost of the mediums used:
² In the Settings tab, click Medium configuration tab.

[sc_pm_mediumconfig, 1, en_US]

² Enter the Currency.

² Click Save, to confirm the currency to be used.
To add a new medium:
² Right-click Medium.

² Select Create medium.
The Create medium dialog is displayed.

² Enter a Name for the medium.

² Click Create.
The medium is added to the medium tree and the settings section is displayed.

To rename a medium:
² Right-click a medium.

6.5.3
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² Select Rename medium.
The Rename medium dialog is displayed.

² Enter a new Name for the medium.

² Click Apply.
The medium is renamed.

To delete a medium:
² Right-click a medium.

² Select Delete medium.
The Information dialog is displayed.

² Click Yes, to delete the medium.
The 5 default mediums which can be configured are Air, Electricity, Gas, Steam, and Water.
The tariff settings for each medium is similar.

To set the tariffs:
² Select the required medium to be configured from the medium tree.
The General settings section displays the Medium unit and Currency used.

[sc_pm_generalsettings, 1, en_US]

² In the Tariff settings section, select a Sub Tariff from the drop-down list.

[sc_pm_tariffsettings, 1, en_US]
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² Set the From time, To time, currency/unit (example: Euro/m3), and the days of the weeks for which the
tariff is applicable.

ii
NOTE
The From time and To time is not applicable for the default sub tariff.

² Select the Holiday option if you want to apply the tariff for the holidays too.
The system ensures that there is no time overlap or errors. You receive an error message if the total daily
period deviates from the 24-hour day, or the defined weekdays do not result in a 7-day week.

² Click  to copy the sub tariff.
The Duplicate sub tariff dialog is displayed.

² Enter a New name for the sub tariff and click Apply.
A duplicate of the selected sub tariff is created.
The system shows an error if the validity range of 2 sub tariff sets overlap.

² Click  to set a period.
The Calendar is displayed.

² Set the Valid from date and click OK.

² Set the Valid to date and click OK.
The duplicated sub tariff will be valid only in between the selected period.

² Select Apply every year, to set the sub tariff for every year.

² Click to  rename the selected sub tariff.
The Rename sub tariff dialog is displayed.

² Enter the value for New name for the sub tariff and click Apply.
The sub tariff is renamed.

² Click  to add a new sub tariff.
The Add sub tariff dialog is displayed.

² Enter a New name for sub traiff.
² Click Apply, to rename the sub tariff.

The new sub tariff is added to the Sub tariff drop-down list and its settings are displayed.

² Click  to delete the selected sub tariff.

[sc_pm_holidaylist, 1, en_US]
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² In the Holiday list section, click .
The Calendar is displayed.

² Select a day and click OK.
The date will be added to the date list.

² Select the option in the Apply every year column, to apply the selected date as holiday every year.

² Click Save, to save the created sub tariffs.

Cost center configuration tab
The Cost center configuration tab consists of the Cost centers list.

[sc_Cost_Cent_Config, 1, en_US]

² Click .
The Add cost center dialog is displayed.

² Enter a Name for the cost center and click Apply.
The cost center will added to the Cost centers list. This cost center can be used to create reports.

² Click  to delete the selected cost center.

² Click  to rename the selected cost center.
The Rename cost center dialog is displayed.

² Enter a new Name for the cost center and click Apply.
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Schedule tab
The Schedule tab consists of the Scheduled Report list.
This list displays the reports which are scheduled for creation.

[sc_Schedule_Set_Tab, 1, en_US]

² It displays the type of report that is to be created (Template type), the name of the report (Template
name), the period of the report (Duration), and whether it is Active or not.
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Trends

Overview

Trends allow you to represent the variations in the values of a device over a specific time range. A trend can
contain any number of hierarchically arranged areas for representing curves, with scales and legends. Value-
over-time and value-over-value representations are both possible here.

Creating a Trend View

To create a trend view:
²

Click  in tool bar.
An empty Trend window and the Select Trend View dialog open.

[sc_SelectTrendView_Dialog, 1, en_US]

Figure 7-1 Select Trend View Dialog

ii
NOTE
If the Select Trend View dialog does not open, click Properties... in the Trend window to open the dialog.

² On the Select Trend View dialog, click New.

² Assign a name to the new trend and click OK.
The new trend view is created and is visible in the Select trend configuration and time range list on the
Select Trend View dialog.

7.1

7.1.1

7.1.2

Tools
7.1 Trends

176 powermanager,  , Help
E50417-H1076-C550-A7, Edition 06.2019



² Close the Select Trend View dialog and start the configuration of the new trend view.

Configuring Trend View

To configure a trend view:
²

Click  in the tool bar.
An empty Trend window and the Select Trend View dialog open.

[sc_SelectTrendView_Dialog, 1, en_US]

Figure 7-2 Select Trend View Dialog

² From the Select trend configuration and time range list on the Select Trend View dialog, select the
trend view that you want to edit.

² Click Edit.
The Trend Configuration Editor window opens.
In the Trend Configuration Editor window, select the datapoint and define the time range.
For more information, see 7.1.4 Selecting a Datapoint.

² Click OK to close the Trend Configuration Editor window.

² In the Select Trend View window, select the time limitation from the Time Range list box.
There are two types of time ranges available to complement the time ranges selected from the Trend
Configuration Editor:
Open: The values for these time ranges come from the database. Additionally, new values are added to
these time ranges online.
Closed: The values for these time ranges come exclusively from the database.

² Click View if the time range is closed.

7.1.3
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- or -

² Click Forward if time range is open.
In this scenario, define the Start time and End time for the time range.
Click View.

The trend window shows the configured trend view.
The trend retains all its configurations if it is used again.

ii
NOTE
The trend view allows visual comparison of individual trends. You can add or remove datapoints from the
trend view to modify the results. For more information, see 7.1.4 Selecting a Datapoint.

Selecting a Datapoint

Selecting a Datapoint Using Trend Configuration Editor Window
Select the datapoints for the trend view from the Trend Configuration Editor window.
You can accommodate one or more datapoints in the view. Visual comparison of individual trends is thus
possible. A maximum of 16 datapoints can be represented in one trend.

7.1.4
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[sc_TrendConfigEditor_Window, 2, en_US]

Figure 7-3 Trend Configuration Editor Window

To select datapoints for a trend view:
² From the Selected Curve list box, select Undefined Curve.

- or -

² If Undefined Curve entry is not available in the list box, click New to create an entry.

²
Click  to assign a datapoint to the curve.
The dpSelector window opens.
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² Select the datapoint in the dpSelector window, and click OK.
The new datapoint name is displayed in the Select datapoint with datapoint selector and Selected
Curve field.
You can further customize the trend view on the Scale and Style tabs on the Trend Configuration Editor
window.

² Click OK.
The datapoint is added to the trend view. The trend is displayed for the defined time range.

Displaying the Trend View

Opening a Trend View

Click  from the tool bar to open the Trends window.

• If the Trends window was last closed using the  button or the ALT + F4 command, it opens the
last closed trend view.

• If the Trends window was last closed using the Close button on the window, it opens an empty trend
view along with the Select Trend View dialog.
You can open a trend view from this dialog.

You can open an existing trend view.

Viewing the Trend Window

[sc_TrendView_Window, 1, en_US]

Figure 7-4 Trend View

7.1.5
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• Click the graphic to open the Trend Ruler Values window.

• Use the scroll wheel to zoom in and out of the trend view.

• Click Legend to open the header area. The header area lists the datapoints, which enables displaying and
hiding of the curves.
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Alert Classes
In device engineering, you can configure an alert class for each alert.

[sc_AlertClasses, 1, en_US]

Figure 7-5 Alert Classes

High and low limits of measured values always belong to the same alert class.
You can select the alert class from a list box.
The following types of alert classes are available:
List box in device engi-
neering

Alert class (DPE) Color Type of acknowledgement

Warning not acknowl-
edgeable

Warning does not
require acknowledge-
ment

Yellow Cannot be acknowledged

Warning Warning requires
acknowledgement

Yellow CAME or WENT requires acknowledge-
ment

Alert not acknowledge-
able

Alert does not require
acknowledgement

Red Cannot be acknowledged

Alert Warning requires
acknowledgement

Red CAME or WENT requires acknowledge-
ment

[sc_Alarms, 2, en_US]

Figure 7-6 Base Panel's Alert Area

• The abbreviations are displayed in the first column of the alert area.

• The priority of the alert is displayed in the second column of the alert area.

• Cannot be acknowledged: The alert area can only be in the CAME or no alert state. The normal state is
only achieved by a value change. Acknowledgement is not possible.

• CAME or WENT required acknowledgement: Each alert range can be in one of the following states.
– came/unacknowledged
– came/acknowledged
– went/unacknowledged
– No alert

The normal state is only achieved by a value change and acknowledging the alert. However, for
acknowledging the alert, acknowledge either the came alert in the came/unacknowledged state or
the went alert in the went/unacknowledged state.

7.2
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Alert Coding

Color Cycle Meaning
Yellow Flashing rapidly Pending, unacknowledged warning
Yellow Flashing slowly No longer pending, unacknowledged warning
Yellow Uninterrupted Pending, acknowledged warning
Red Flashing rapidly Pending, unacknowledged alert
Red Flashing slowly No longer pending, unacknowledged alert
Red Uninterrupted Pending, acknowledged alert
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Data Evaluation - Advanced Report

Overview of Data Evaluation

powermanager Excel Report is an Excel application that provides access to process data, and support for
simple generation of reports based on this data.
You can define further compression levels over and above those present in the powermanager database in
Excel for special cases. Once report templates are created, you can share them for use with different time
ranges (daily report, monthly report).

powermanager Report

Overview powermanager Excel Report
Use powermanager Excel Report as a report generator.
To create a report for a defined period, the system accesses the template and fills it with data from the power-
manager process database.
Automatic report creation is time-driven and does not require user intervention.
The following report types are available for selection:

• Energy report

• Cost center report

• Comparison report (measuring point/measured value)

• Duration curve report
You can generate a report in the following three ways:

• Manual

• Semiautomatic

• Fully automatic

Opening the powermanager Report
To open the powermanager report window:
² In the menu bar, click Tools > Report in the Icon Line.
Microsoft Excel opens in the powermanager Report window.
The default file name of the Microsoft Excel file in powermanager report window is Report.xls.

powermanager Report
The powermanager report window consists of the following components:
Component Description
Template
New Click New to create a report template.
Open Click Open to open an existing template for editing.
Reports
New Click New to create a report based on an existing template.
Open Click Open to open an existing report.
Quick Selection The Quick Selection area enables semiautomatic report creation based on a template

and saved information about the report type and the report period.
Click Create report to create and open a report with the previously selected entry in
the Quick Selection area.

7.3

7.3.1

7.3.2

7.3.2.1

7.3.2.2

7.3.2.3
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Additional Menu Titles
The menu bar of the powermanager report window contains three additional menu titles:

• Report

• Template

• Reports
The menu titles contain the additional Excel commands that you need for working with the powermanager
report generator.
The menu titles are available in all Excel windows that you open from the start window.
The menus are only available if you open an Excel template from the powermanager report window.

Returning to the powermanager Report Window
To return to the Report.xls window when multiple windows are open:

• Click the View tab, and click Switch Windows > Report.xls.

Closing powermanager Report
To close the powermanager report window:
² Save and close all the open report windows except Report.xls.

² Close Report.xls.

ii
NOTE
If you try to close Report.xls without closing all the other report windows, you get the following message:
The project cannot be terminated as project files are still open!

Menus in powermanager Excel Report

The Report Menu

Menu Command Description
Update Templates Update the templates to the latest Excel Report versions.
Quick Selection Configure display of the Quick selection area on the powermanager report homepage

(Report.xls).
Schedule Set the times for automatic creation of reports and the subsequent report printing and

saving actions.
Mailing List Create a list of recipients for sending the reports by e-mail. The finished report can be

sent either automatically with a schedule or manually.
Password Enter a password to configure the Excel Report.
Info An information window containing the current version information, links to the

powermanager homepage and the Siemens AG contact addresses.

The Configuration Submenu
Enter a password to configure the Excel Report.
Menu Command Description
Change Password Assign a new password.
Options Configure operating options. For example, communication, password assignment, and

so on.
Archive Structure Read the archive structure file.
Basic Values Select the time values and the interval on which one report type is based.

7.3.2.4

7.3.2.5

7.3.2.6
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Menu Command Description
Report Types Define the connection between the datapoint types or names (represented by the

basic values) and their archive values for each type of report.
Status Bits Assign display formats depending on powermanager status bits (for example, identi-

fying invalid values as crossed through).
Tariff Sets Create new tariff sets and edit or delete existing ones.
Cost Centers Create new cost centers based on a tariff set and edit or delete existing ones.
Media Create new media and edit or delete existing ones.

The Template Menu

Menu Command Description
New Create a template based on a master template. The Report format dialog opens. By

default, the master template is selected in the Format box.
Open The Select a file dialog opens.

To edit a template, select a template file in the dialog.
Configure The Report types dialog opens.
Add spreadsheet Add a spreadsheet or another template.
Delete spreadsheet Delete a marked sheet.
Insert Measured
Value

Select a data source or a datapoint to insert at the marked location (column or row
assignment for datapoints).

Modify DP Update the datapoint assignment for a column (or row).
SQL Wizard Dialog-based compilation of an SQL query (only active when using the SQL template).

The Reports Menu

Menu Command Description
New Create a report using a template along with details of the time range (period).
Open The Select a file dialog opens. To edit a report file, select it in the dialog.
Send mail powermanager e-mails an existing report which is open. The information is taken from

the mailing list and is made available for selection.
Save as HTML Save an open report as an HTML page.

Data Evaluation

Report Types

Energy Report
The energy report is available for exporting power demand values.

Cost Center Report
The cost center report calculates the demand and the costs of several media in one report.
It also supports manual unit conversion. This unit conversion allows you to enter a denominator.

Calculating the Costs
Costs are calculated for every medium within one cost center as soon as a measuring point is assigned to the
medium within the cost center. Depending on the report type, the report queries all demand values of the
measuring point within the query period (for example, all hourly values of one day).
For calculation, the respective tariff is determined for each demand value and the costs for each demand value
are calculated based on the demand value, the weighting, and the tariff. To determine the associated tariff,

7.3.3

7.3.3.1

Tools
7.3 Data Evaluation - Advanced Report

186 powermanager,  , Help
E50417-H1076-C550-A7, Edition 06.2019



the associated tariff rate is first determined using the cost center assigned to the demand value and the
assigned medium.
Determine the associated subtariff rate using the validity of the subtariff rate and the time stamp of the
demand value. The tariff within the subtariff rate then also results from the time stamp of the demand value.
The following values are calculated based on these single costs and single demand values:

• Total costs of one medium in one cost center

• Total demand of one medium in one cost center

• Total costs of one medium across all cost centers

• Total demand of one medium across all cost centers

• Total costs of one cost center

Tabular Display of the Cost Center Report
You can use the tabular display of the cost center report on several media. If a medium is not used in a cost
center, the costs and demand are displayed as a blank line.
The total costs of a cost center result from the sum of the costs for each medium. The values of the costs are
added up without checking the unit or the currency of the single costs. The currency of the costs of the first
medium in the table appear in the heading of the total costs.

Chart Display of the Cost Center Report
You can use the chart display of the cost center report with several media. All media with demand and costs
are displayed for each cost center.
To improve clarity, the chart is split into two single charts if there are 10 or more media per cost center. One
chart shows the demand, while the other shows the correlating costs. If the cost center for demand and costs
is the same, the bars on the charts show the same color. As different media are displayed for the Demand
chart, the unit is also displayed in the graphic next to the value. In the Costs chart, however, only the costs
without the unit are displayed on the left-hand axis.

Report Template for Comparing Demand Measurements (Measuring Point Comparison)
Use the measuring point comparison to add up the energy demand values of different measuring points over a
time and compare them in a bar chart.
The report template consists of two table sheets. The first table sheet contains a report belonging to the
standard report type. Insert any counted values into the template. The unit pertaining to the first measuring
point is displayed in the chart display. The unit is not checked. A denominator and a unit can be specified for
unit conversion. All values are divided with the denominator before they are displayed in the chart. The
manually assigned unit then substitutes the unit of the measuring points in the chart display.
There is a bar chart on the second table sheet. This chart is preconfigured so that it shows the sum of the
single values of each measured value as a bar. The values queried in the event of a query from the database
are determined via the report types. When defining the report type, it is possible to select between 15-
minutes, hourly, and daily values. The Data entry in the report type definition is evaluated in this case.

Comparing Measured Values Over Different Time Periods (Measuring Point Comparison)
Use the Comparison Report template to compare several measured values over different periods of time.
You can cancel and select the count values for the comparison. Only the first 10 counted values are consid-
ered when creating a chart. The values queried in the event of a query from the database are determined via
the report types. You can select between 15-minutes, hourly, and daily values. The Data entry in the report
type definition is evaluated in this case.

Duration Curve Report
A sorted duration curve is a chart in which the power demand of a load is displayed as a function of the usage
time of this power. In powermanager V3.4, use the ContinuousLine.xltm report template to create such a
sorted duration curve. The power demand value is taken as the basic value for calculating a duration curve.
Therefore, enter the measured value in a defined cell in the template. It is entered manually or via a data entry
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dialog in which, after selecting a device, you are offered its power demand values. The dialog offers only
power demand values whose time stamp is at the start of the calculation interval. The query period selected
when making the query defines the time range of the query. You can save the template any number of times
under a different name.

Evaluating Data
Ensure that the following prerequisites are met before you start evaluating data:

• The powermanager Excel report is open.

• A medium is created.

• A tariff set is created.

• A cost center report is created.
To evaluate data:
² Create a template.

² Insert datapoints in the template.

² Save the template in the following location:
\proj_path\data\xls_report\Template\

ii
NOTE
Save the template in XLTM format.

² Use the new template to create a report.

² Save the report in the following location:
\proj_path\data\xls_report\Report\

ii
NOTE
Save the report in XLSM format.

The data is evaluated.
Additional Options

• Set up a quick selection.

• Create a schedule.

• After generating the report, you can also create a chart with values selected from the retrieved values
with the aid of the Chart Wizard under MS Excel.

Media

Overview of Media
The label and unit define a medium.
Use a medium to define the tariff set.

Creating a Medium
To create a medium:
² Open the powermanager report window.

² Click the Add-Ins tab, and click Report > Configuration > Media.

7.3.3.2

7.3.4

7.3.4.1

7.3.4.2
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² In the Password dialog, enter the password as erAdmin and click OK.
The Medium window opens.

²
In the Medium window, click .
The Media dialog opens.

² In the Media dialog, enter the name and unit of the medium in the respective fields.

² Click OK.
A medium is created. The medium is available for selection when defining a tariff set.

Deleting a Medium
Before deleting a medium, ensure that it is not in use in a tariff set.
² Click the Add-Ins tab, and click Report > Configuration > Media.

The Password dialog opens.

² Enter the valid password and click OK.
The Media dialog opens.

² In the Media dialog, click the medium you want to delete.

²
Click .
If a tariff set is using the medium, the following message is displayed: Medium is still in use in
tariff set: <tariff set name>.

² Click OK to confirm.

² Click OK to close the Media dialog.

² Assign a new medium to the tariff set.

² Repeat the operation until the medium is deleted.
The medium is deleted.

Tariff Sets

Overview of Tariff Sets
A (sub)tariff set is a charged price that refers to one media unit (kWh, m³) and which applies to one specific
period of time.
In order to define a valid tariff for a specific day of the week at a specific time, parameterize the tariff sets in
Excel Report.
You can assign only one medium for each tariff set.
You can define up to 12 tariffs for each tariff set. The tariffs are numbered from Tariff 1 to Tariff 12. The time
of the day and the price charged for each unit are defined in each tariff.
You cannot delete or change the time range of the Default subtariff set. This subtariff rate is valid whenever
no other subtariff rate is defined. The validity periods of the individual subtariff sets must not overlap.
A tariff set is not bound to a specific template, but is available for general use.

Creating a Tariff Set
Before creating a tariff set, ensure that you create at least one medium.
To create a tariff set:
² Open the powermanager report window.

² Click the Add-Ins tab, and click Report > Configuration > Tariff Sets.

7.3.4.3

7.3.5

7.3.5.1

7.3.5.2
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² In the Password dialog, enter the password as erAdmin and click OK.
The Tariff sets window opens.

[sc_TariffSets_Window, 1, en_US]

Figure 7-7 Tariff Sets Window

²
In the Tariff sets window, click .
The Tariff set Details window opens.

² Enter the tariff data in the Tariff set Details window.
For the description of all the fields in the Tariff set Details window, see Tariff set Details Window.

² Click OK.

Tariff set Details Window
You can define 12 tariffs per subtariff set. The tariffs are numbered from Tariff 1 through Tariff 12.
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[sc_TariffSetsDetails_Window, 1, en_US]

Figure 7-8 Tariff Set Details

The Tariff sets Details window contains the following fields:

• Name
Name of the tariff set.

• Medium
Material or energy type with an assigned unit that is priced in the tariff.

• Currency
Currency of cost recording.
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• Sub-tariff Set
All data within the Sub-tariff set area refers to the currently selected subtariff set.
You can see the existing subtariff sets in the list box in this area.
The Sub-tariff set area has the following components:
– Copy

Click Copy to create a copy of the currently open subtariff set.
– Edit

Click Edit to change the name of the subtariff set.
– Delete

Click Delete to delete the subtariff set.
powermanager does not prompt you for confirmation after you click Delete.

– Valid from, Valid to
The time range for which the subtariff set is valid.
The system shows an error if the validity range of two subtariff sets overlap.
The set the validity of the subtariff set to one day, set the validity from 00:00:00 h to 23:59:59 h.

• Times/Costs
Under the Times/Costs area, select a tariff to activate it.
Specify the following information for each tariff that you select:
– Specify the validity period for the tariff.

The validity period must be exact to the hour. If you specify the period in minutes or seconds, then
powermanager rejects the validity period.
By default, the validity period is set from 00:00:00 to 00:00:00, indicating a validity of a full day.

– Price for the consumption time.
– The days of the weeks for which the tariff is applicable.

Select the Ho option if you want to apply the tariff to the holidays too.
The system ensures that there are no time overlaps or errors. You receive an error message if the
total daily period deviates from the 24-hour day or the defined weekdays do not result in a 7-day
week.

• Holidays (Ho)
You can list the public holidays in the Holidays box.
For more information, see Defining Holidays in the following section.

Defining Holidays
To define the holidays for the period that is recorded in the cost center report:
² In the Holidays (Ho) area, click Add.

The Insert Date dialog opens.

² In the Insert Date dialog, enter the date of the holiday.

² Click OK.
The specified date is added to the list of holidays.

Creating a Sub-tariff Set
To create a subtariff set:
² Click Add to create a subtariff set.

The Sub-tariff entry dialog opens.

² In the Name field, enter a valid name for the subtariff.

² Click OK.
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² In the Sub-tariff entry area, enter the start and end date of the subtariff validity period.
The subtariff set is created.

Deleting a Tariff Set
Delete a tariff set only if it is not assigned to a cost center.
If you delete a tariff set that is assigned to some cost center, then the cost center configuration becomes
invalid.
To delete a tariff set:
² Open the powermanager report window.

² Click the Add-Ins tab, and click Report > Configuration > Tariff Sets.

² In the Password dialog, enter the password as erAdmin and click OK.
The Tariff sets window opens.

²
In the Tariff sets window, select the tariff set that you want to delete and click .

² Click OK on the confirmation message.

Cost Centers

Overview of Cost Centers
A cost center is not bound to a specific template, but is available for general use.
You can assign one tariff set to any number of cost centers.
You can assign one cost center to a maximum of 10 tariff sets.

Creating a Cost Center
To create a cost center:
² Open the powermanager report window.

² Click the Add-Ins tab, and click Report > Configuration > Cost Centers.

² In the Password dialog, enter the password as erAdmin and click OK.
The Cost Center window opens.

[sc_CostCenters_Window, 1, en_US]

Figure 7-9 Cost Center Window
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²
In the Cost Center window, click .
The Cost Center dialog opens.
If there are no tariff sets defined, powermanager does not open the Cost Center dialog and shows an
error message.

[sc_CostCenterDialog, 1, en_US]

Figure 7-10 Cost Center Dialog

² Enter the following information in the Cost Center dialog:
Name: The cost center name.
Ensure that the cost center has a unique name.
Tariff set: You can assign up to 10 tariff sets to one cost center.
Select the tariff sets from the list box.

² Click OK.

Deleting a Cost Center

ii
NOTE
Only delete a cost center if it is not used in a template.
The delete command deletes the cost center immediately without prompting for confirmation. Templates
that access the deleted cost center will no longer function.

To delete a cost center:
² Open the powermanager report window.

7.3.6.3
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² Click the Add-Ins tab, and click Report > Configuration > Cost Centers.

² In the Password dialog, enter the password as erAdmin and click OK.
The Cost Center window opens.

² In the Cost Center window, select the cost center that you want to delete.

²
Click  to delete the selected cost center.

Templates

Overview of Templates
The predefined powermanager standard report templates are Excel templates. Enter the operating data in
these Excel templates to customize them according to your specifications.
The templates serve as samples for the reports.
The created templates are stored in Excel. Template files have the XLTM extension and are stored in the
default templates directory of the reports. The templates dialog automatically displays the correct path.

Report Format
The report generator uses the term format to describe the type of report, for example, Cost center report.
From the technical perspective, the format encompasses the underlying standard template and all the auto-
matic mechanisms set up for data selection and representation.

Creating a Template

Prerequisites
Before creating a template, ensure that the following prerequisites are met:

• The master template of the selected report type is available.

• At least one tariff set is defined on creation of the default cost center report.

• At least one cost center is defined on creation of the default cost center report.
To create a template:
² Click New under Template area.

- or -

² Click the Add-Ins tab, and click Template > New.

² In the Report format window, select the report format.

² Click OK.
The Report types window opens.

² Select one or more report types.
For more information, see Report Types in the following section.

² Click OK.
Excel opens the standard template of the selected report format.

² Add the required datapoints to the template.

² Click  to save the template.

- or -

7.3.7
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²

For Microsoft Excel 2007, click , and click File > Save.
For Microsoft Excel 2010/2013, click the File tab and then click Save.
Ensure that you do not use the Save As option to save the template as this procedure saves the template
as an Excel table.

ii
NOTE
Ensure that the name of the template does not end with a number.

Report Types Dialog

[sc_ReportTypes, 1, en_US]

Figure 7-11 Report Types Dialog

• Existing report types
The Existing report types box lists all the existing report types.

• Report types for this template
The Report types for this template box list all the report types that are used when creating a report.

• Use the < and > buttons to move individual report types from one box to another.

• Use the << and >> buttons to move all the available report types from one box to another.

• The Min color and Max color boxes define the color coding of the extreme values in the report. Click the
buttons to change the color.

Opening a Template
To open an existing template:

7.3.7.3
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² In the start window of the report generator, click Open in the Template area.
- or -

² Click the Add-Ins tab, and click Template > Open.
The Template option in the menu bar is available in all windows that you open from the report generator
window.

² Open the required template.

Editing a Template
To edit an existing template:
² Click Open under Template area.

- or -

² Click the Add-Ins tab, and click Template > Open.
The Select a file window opens.

² Select and open the template that you want to edit.

² In the Report format window, select the report format.

² Click OK.
The Report types window opens.

² Select one or more report types.
For more information on report types, see 7.3.8.8 Configuring the Report Type.

² Click OK.
Excel opens the standard template of the selected report format.

² Add the required datapoints to the template. For more information on adding datapoints, see
7.3.9.1 Overview of Datapoints.

² Click  to save the template.

- or -

²

For Microsoft Excel 2007, click , and click File > Save.
For Microsoft Excel 2010/2013, click the File tab and then click Save.
Ensure that you do not use the Save As option to save the template as this procedure saves the template
as an Excel table.

ii
NOTE
Ensure that the name of the template does not end with a number.

Updating Templates
In order to use templates created in an older version of Excel Report in the latest version, adapt these
templates suitably.

ii
NOTE
You can only update the templates located in the Template directory.

To update a template, select the template and click Report > Update templates.

7.3.7.4

7.3.7.5
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ii
NOTE
Update templates by making changes to the configuration. This concerns changes to the basic values, the
report types, and the format templates of the status bits.

Conducting SQL Queries
For powermanager Report 3.2 and above, you can execute SQL queries with the Excel Report and display the
result as a report.
An SQL master template SQL query exists for this purpose.

ii
NOTE
You cannot use aliases for SQL queries with Excel Report. You can, however, use aliases for direct queries
via the History Database (HDB).

ii
NOTE
Do not use the SQL Wizard to query datapoints of a distributed system. Only values of the local system are
adopted. You cannot add the datapoints of a distributed system to the list of the selected datapoints.

² Open the SQL query template.

² Click the Add-Ins tab, and click Template > SQL Wizard.
The Values/alerts dialog opens.

² In the Values/alerts dialog, select the Values option and click Forward.
The SELECT dialog opens.

² Select an entry from the source list.

² Click > to transfer the selected value to the target list.
The selected value is displayed in the target list.

² Click Forward.
The FROM dialog opens.

² In the Datapoint type list box, select the datapoint type.

² In the Datapoint list box, select the datapoint.

² In the Datapoint type list box, select the datapoint type.

² Click > to transfer the selected values to the elements list.
The string composed of the selected entries is displayed in the list.

² Click Forward.
The WHERE dialog opens.

² Select an operator from the Operators list box.

² Select an option from the Options list box.

² Select a keyword from the Keyword list box.

² Select a value from the Value list box.

² Click > to transfer the selected values to the elements list.
The string composed of the selected entries is displayed in the list.

² Click Forward.
The TIMERANGE dialog opens.

² Click Forward.
The SORT dialog opens.

7.3.7.6
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² Select DP element option in the SORT dialog.

² Select the value to sort in the list box.

² Click Finished.
SQL query is carried out. The SQL query is filled with the queried values.
Save the SQL query in the Report directory.

[sc_SQL_Queries, 1, en_US]

Figure 7-12 SQL Query Report Template with Measured Value Inserted Via SQL Wizard

Overview of Template Structure
A template is structured into four different areas demarcated by orange rows or columns.
The template consists of the following areas:

• Default Settings (containing the report type, for example, standard report)

• Header

• Data

• Page End or Footer

ii
NOTE
Do not delete or modify the keywords (in the standard report in column A, in the ATV report and operating
report: row '1'), and the orange-colored rows assigned for the area demarcations.

7.3.7.7
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[sc_StandardTemplate_Example, 1, en_US]

Figure 7-13 Example: Standard Template

The Template Areas

Default Settings
The information on each of the datapoints is saved in the Default Settings area.
This section is not visible in completed report.

ii
NOTE
Do not add or delete rows in this area. Only experienced users should edit these rows if necessary when
creating a template.

Header and Footer
The header and footer areas are designed using the functions of MS Excel.
To repeat the header and footer on every sheet of an excel report:
² On the menu bar, click Page Setup.

The Page setup dialog opens.

² Select the Table tab.

² In the Rows to repeat at top field, enter the repetition rows.

7.3.7.8
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² Click OK.

Keywords
To display the statistics functions, enter keywords in the header and footer areas.
In a default report, the associated values of each datapoint are entered in the column A.
Use the following keywords:

Min, Max, MinTime, MaxTime, Number, Sum, Integral0, Integral1, SumNumber, Average, Average1,
Time0, Time1, Changes, Changes01, Changes10, StartValue, EndValue, and Difference

powermanager Functions in Excel
You can use several keywords for labeling the finished report in the header and footer areas or in other areas
outside the actual data area. You can choose to access the report information in all templates by German or
English names (erProtokollTyp = erReportType).
The keywords are used like functions in Excel.
The following keywords are available for the data area:
powermanager Func-
tion in Excel

English Description

erProtokollTyp erReportType Name of the report type.
erVon erFrom Start time of the query.
erBis erTo End time of the query.
erIntervall erInterval Time interval between the individual values.
erIntervallEinheit erIntervalUnit Units for the time interval between the individual values.
erPeriode erPeriod Time period covered by the report query.
erPeriodeEinheit erPeriodUnit Units for the time period covered by the report query

Requirements
The applicable cells are formatted in the matching display format.

Example

For this formula: Cell formatting required: Format_Cell_Numbers
Formula erFrom Date _ '4.7.97 13:30'

Data
The Data area is defined using one or more rows, which contain the individual values for the datapoints over
time. These rows are used cyclically in the report layout. For example, if the set parameter creates a template
in which one white row, one green row, and one yellow row are displayed in its three-row data area, in the
final report, this color sequence are repeated cyclically as many times as is necessary to display all the rows of
values.

ii
NOTE
In the template for a daily report containing hourly values, you do not need to allocate 24 rows in the data
area. powermanager Report 3.x automatically fits in the necessary number of rows when the report is
created.

You can customize the formatting. Insert formulas in columns where no datapoint is defined. You can also
compile mixed queries across several systems in one joint report.
Reports are protected with sheet protection by default. Therefore, subsequent changes to individual cells
cannot be made.
To exclude individual cells from sheet protection:
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² On the menu bar, click Format > Cells.
The Format Cells window opens.

² On the Protection tab, deselect the Locked option.

² Click OK.

Using Keywords for Headers and Footers
Special placeholders are reserved for the headers and footers of the page layout. You can replace these place-
holders with the parameters of the query when a report is generated.
Control Variable Description
[Reporttype] Name of the time range covered by the query (for example, Daily report).
[From] Start date/time of the query in internal time format.
[From Date] Start date of query.
[From Time] Start time of query.
[To] End date/time of the query in internal time format.
[To Date] End date of query.
[To Time] End time of query.
[Interval] Time interval between the individual values.
[Period] Period of time covered by the report query.

To insert a placeholder in a header or footer:
² Click the View tab and click Page Layout.
² Click on the header area.

The Design tab opens.

² Insert a placeholder in the header area.

² To insert a placeholder in the footer area, on the Design tab, click Go to Footer.

Reports

Overview of Reports
A report contains the data exported from a database for a specific time period.

Report Types
Predefined report types are available for selection in the templates.

Creating a Report

Prerequisites
Ensure that the following prerequisites are met before you start creating a report:

• There is at least one template in the system.

• The template is closed.
To create a report:
² Click New under Report area.

- or -

² Click the Add-Ins tab, and click Reports > New.
The Reports option in the menu bar is available in all windows that you open from the report generator
window.

² In the dialog that opens, select the template for the report.

7.3.7.9
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² In the Time period for the report window, specify the report type and time range for the report.
Depending on the selected report type, the system assigns a default time range to the report.
You can modify this time range to suit your requirements.

² Click OK.
The report generator creates the report. The report opens in a new window in Excel.

²

For Microsoft Excel 2007, click , and click File > Save.
For Microsoft Excel 2010/2013, click the File tab and then click Save.
For more information on saving reports, see Saving a Report.

Saving a Report

Standard Storage System
The powermanager standard storage system is uniform for all users.
The default storage location for all the generated reports is:
<Project_name>\data\xls_report\Report\
When you save a report for the first time, the system creates a subdirectory under the preceding path. The
name of the subdirectory is the same as that of the report type.
For example, if you select the daily report type for a report, then the report is saved in the following path:
<Project_name>\data\xls_report\Report\Daily report
Subsequent save commands open the designated folder for the report.

Any Storage Locations
Additionally, you can save reports in any folders independent of the default storage path.

File Name
The powermanager report generator names the reports based on the following format:

• <template_name>\YYYYMMDD.xlsm
Here, YYYY, MM, and DD stand for year, month, and day respectively. The date displayed is the generation
date of the report.

Opening a Report
To open an existing report:
² Click Open under Report area.

- or -

² Click the Add-Ins tab, and click Reports > Open.
The Reports option in the menu bar is available in all windows that you open from the report generator
window.
The Select a file dialog opens.

² In the Select a file dialog, navigate to the relevant subdirectory and select the report that you want to
open.

² Click Open.

Quick Selection – Semiautomatic Report Creation
Use the quick selection feature to automate the report creation partially.
Initiate the report generation.
The system defines the template, report type, and report period.

7.3.8.3
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Creating a Quick Selection
A quick selection saves the information on the template, report type, and report period for reuse.
To create a quick selection:
² Click the Add-Ins tab, and click Report > Quick Selection.

The Quick Selection window opens.

²
In the Quick Selection window, click .
The Quick Selection dialog opens.

[sc_QuickSelection_Dialog, 1, en_US]

Figure 7-14 Quick Selection

² Enter the following information in the Quick Selection dialog:
Label: Quick selection name
Template: Default template that is applied to the reports generated using this quick selection
Report Type: Default report type that is applied to the reports generated using this quick selection
If the template does not contain the selected report type, the report generator sends the following error
message: No report types defined in the template.
In this case, include the report type in the template before creating the quick selection or select another
report type.
Print: Select this option to send the report to the default printer selected assigned to the system. If you
select this option, the system does not prompt for confirmation.
Save: Select this option to save the report without being prompted for confirmation.
For more information on saving reports, see Saving a Report.
Close: Select this option if you do not want to view the report after creation. The report is saved in the
selected location.
Time period: Under Time period, select Last period if you want to generate report for the previous
month or previous day.
Select Current period if you want to generate the report for the current month or current day.

² Click OK.
The quick selection template is available for selection in the Quick Selection field of the powermanager report
window.
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Creating a Report Using Quick Selection
The Quick Selection field in the home window of the report generator lists all available templates for quick
selection.
For more information on creating a new quick selection template, see Creating a Quick Selection in the
preceding section.
To create a report using quick selection:
² In the Quick Selection field, double-click the template you want to use.

- or -

² Select a quick selection template and click Create report.
The report generator creates the report without prompting for confirmation. Depending on the quick selection
settings, the report is saved, printed, or displayed in the Excel window.

Schedule – Automatic Report Creation
You can automate report generation using the Schedule feature. An active schedule creates reports periodi-
cally. For example, every morning, the daily report for the previous day, and so on.

Viewing the List of Active Schedules
Click the Add-Ins tab, and click Report > Schedule to view the list of active schedules in the Schedule
window.

[sc_ScheduleWindow, 1, en_US]

Figure 7-15 Schedule Window

The lamp icon that precedes the schedule name indicates the status of the schedule:

• Green lamp: Schedule is active
Reports are created based on the time range given in the schedule.

• White lamp: Schedule is switched off

• Yellow lamp: Schedule is skipped because the report was still running

• Red lamp: An error occurred during report creation

7.3.8.6

7.3.8.7
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Creating a Schedule
Ensure that the following prerequisites are met before you create a schedule:

• Setup a permanently running computer for cyclic and automatic report generation. This computer must
be a server computer and not a workstation computer.

To create a schedule:
² Click the Add-Ins tab, and click Report > Schedule.

The Schedule window opens.

²
In the Quick Selection window, click .
The Schedule dialog opens.

[sc_ScheduleDialog, 2, en_US]

Figure 7-16 Schedule Dialog
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² Enter the following information in the Schedule dialog:
Label: Schedule name
Template: Default template that is applied to the reports generated using the schedule
Report Type: Default report type that is applied to the reports generated using the schedule
If the template does not contain the selected report type, the report generator sends the following error
message:
No report types defined in the template.
In this case, include the report type in the template before creating the schedule or select another report
type.
Interval: Interval between each report generation
For example, select 1 month(s) to generate the report monthly.
Next call: Date and time when the report generation starts at the end of each interval
Active: Select Active if you want start the schedule immediately after creation.
Print: Select this option to send the report to the default printer selected assigned to the system. If you
select this option, the system does not prompt for confirmation.
Save: Select this option to save the report without being prompted for confirmation.
For more information on saving reports, see Saving a Report.
HTML export: Select this option if you want to save the report in the HTML format.
The HTML report is saved in the folder:
Mailing list: Select this option if you want to e-mail the report to a particular mailing list immediately
after the report creation.
After you select this option, select the mailing list from the list box below.
In the powermanager report window, click Report > Mailing list to create a mailing list.
<project_name>\data\xls_report\html\
Time period: Under Time period, select Last period if you want to generate report for the previous
month or previous day.
Select Current period if you want to generate the report for the current month or current day.
Specify the path to save the report.

² Click OK to close the Schedule dialog.
The new schedule is listed in the Schedule window.

² Click OK to close the Schedule window.

ii
NOTE
You can also create reports for historical data.
If you want to generate reports for historical data, set the next run option for the date from which you
want the data. For instance, you can generate all the daily reports for the past week.
If powermanager Report is not running at the time of the next report generation, the reports that are still
outstanding are automatically generated, when you confirm the same, the next time you start powerman-
ager report.

Configuring the Report Type
The report type defines the interval and the period of the data export. For example, cumulation of the data in
15-minute intervals throughout the day.
You can configure which of the existing report types are used for the current template.
Once a template is created you can use it for a daily report of hourly values as well as for a monthly report of
daily values.

ii
NOTE
If the archive structure is changed, then the update these changes in the template. Thus, new datapoints
for DP types that exist can be adopted immediately in the template without updating.

7.3.8.8
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² Click the Add-Ins tab, and click Template > Configure.
The Report Type dialog opens.

² Select the report types from the Existing report types list.

² To transfer the selected report types to the Report types for this template list, click > button.
The selected templates are displayed in the right-hand list box.

² Click OK.

Report Types Window

[sc_ReportTypes, 1, en_US]

Figure 7-17 Report Types Window

• Existing report types
The Existing report types box lists all the existing report types.

• Report types for this template
The Report types for this template box lists all the report types that are used when creating a report.

• Use the < and > buttons to move individual report types from one box to another.

• Use the << and >> buttons to move all the available report types from one box to another.

• Min color
Min color defines the color for display of the minimum value for each column in the report.
The default color is green.

• Max color
Max color defines the color for display of the maximum value for each column in the report.
The default color is red.

• Print preview after creation of report
Select this option to open the print preview automatically after report creation.

Tools
7.3 Data Evaluation - Advanced Report

208 powermanager,  , Help
E50417-H1076-C550-A7, Edition 06.2019



• Track changes
Select this option to archive and insert the report changes in an automatically created report sheet.

To change the color for Min/Max color buttons:
² Click the Min color or Max color button.

The Change color dialog opens.

² Enter the RGB value in the respective text box.
You can also move the sliders pertaining to each color.
The color selection preview is shown in the top area.

[sc_ChangeColor, 1, en_US]

Figure 7-18 Change Color Dialog

² Click OK.
To parameterize the highlighting settings of the changes:
² Click the Review tab and click Track Changes > Highlight Changes.

The Highlight Changes dialog opens.

² Select the List changes on a new sheet option.

ii
NOTE
The individual sheets are no longer be protected against changes (the sheet protection is activated when
the changes are not tracked).

Canceling Report Protection
By default, sheet protection for reports is always activated, meaning that the values are read-only. Sheet
protection is protected with your report password. To deactivate sheet protection for individual columns, click
Format > Cell > Protection tab > Locked.

Datapoints

Overview of Datapoints
A datapoint encompasses the value that a measuring point of the system supplies.

7.3.8.9

7.3.9
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Use the Insert datapoint operation to define the values assigned to powermanager process variable in a
column.
The procedure is similar for all templates:

• You define the control data of a datapoint in a dialog.

• The dialog makes the possible data available for selection in list boxes.

• The report generator applies the data from the dialog to the Excel template.

Inserting a Measured Value into a Template

ii
NOTE
In powermanager, the datapoint types supported by the following device types are made available to you:
PAC1200, PAC1500, PAC1600, PAC2200, PAC3100, PAC3200, PAC3200T, PAC4200, PAC5100, PAC5200,
P850, P855, generic Modbus device, virtual counter, 3WL, 3WL10, 3VL, 3VA, and 3VA27.
Additionally, you can manually insert datapoints for devices that cannot be directly integrated with power-
manager.

Prerequisites
Ensure that the following prerequisites are met:

• There is at least one template in the system.

• The device type is supported.
To insert datapoints in a template:
² Create the first datapoint in column C of the Excel template.

Mark any cell or any cell area in column C.

² Click the Add-Ins tab, and click Template > Insert DP.
The Measured Value window opens.

² In the Measured Value window, enter the necessary information.

² Click OK.
Excel applies the data from the Measure Value window to column C of the template.

² Enter datapoints description under the header row to improve readability.
If you use Change DP, the boxes are automatically filled with the measuring point designation from the
datapoint name.

² Insert further datapoints in column D, E, and so on.

ii
NOTE
The datapoints available for selection are filtered.
Click Report > Configuration > Options to reach the filter settings.
Click the Add-Ins tab, and click Report > Configuration > Options to reach the filter settings.
On the Datapoint selection tab, define the datapoints which appear in the selection.

Deleting a Datapoint from a Template
To delete a datapoint from a template:
² Select the datapoint you want to delete.

² Press DELETE on the keyboard.

Editing Data of a Datapoint
To edit a datapoint:

7.3.9.2
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² Select the datapoint you want to edit.

² Click the Add-Ins tab, and click Template > Modify DP.
The Measure Value window opens.

² In the Measure Value window, edit the required information.

² Click OK.
Excel applies the updated data from the Measure Value window to the template.

Datapoints in the Cost Center Report

[sc_InsertMeasureValue_Window, 1, en_US]

7.3.9.5
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The Insert Measured Value window for Cost Center report contains the following fields:

• Archive type
The Counter value is selected by default in the Archive Type list box. It limits the list of measured values
to the consumption values.

• System
In a single system installation of powermanager, System1 is selected by default. You cannot change this
value.
In a distributed system installation of powermanager, select any one of the distributed systems.

• Device Type
From the Device Type list box, select the device type of the device that supplies the data. This device is
also called the datapoint type (DPT).
The Device list box at the bottom of the table lists the devices associated with the selected device type.

• Measured Value
From the Measured Value list box, select the measured value that the selected device supplies. This
measured value is also called the datapoint element (DPE).
Its availability depends on the selected device type. The table in the following section lists the counters.

• Device name representation
In the Device name representation list box, select the name and additional information for the device
which appears in the Device list box.
The Device name representation list box has the following options:
– DP/Technical name

The device is listed under its internal device name. The name of the root precedes the device name.
For example, System1:PAC4200_Anlage.

– Alias
The device is listed under its alias.
Devices without assigned aliases do not appear in the list.

– Custom name
The device is listed under its internal name.
The name of the selected datapoint element and the suffix value are appended to the device name.
For example, PAC4200_Anlage.counter.W_t1.value.

• Filter
Use the filter feature to limit the number of devices in the Device list box to a subset.

• Cost Center
From the Cost Center list box, select the cost center to which the counter demand values are assigned.

• Medium
From the Medium list box, select the medium that is assigned to the cost center via the tariff set.
If several media are assigned to the selected cost center, the list box offers the media for selection.

• Change unit in the report
The Change unit in the report box shows the unit of the selected medium.

• Unit of the datapoint
The Unit of the datapoint box shows the unit of the datapoint.

• Denominator
The Denominator box determines the conversion ratio for both the units. By default, the value in the
denominator box is 1.
Example
To convert from watt hours to kilowatt hours, enter the denominator value as 1000.
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• Weighting (0-1)
Proportional assignment of the counted consumption values for the selected cost center, expressed as a
decimal factor.
For example, the value 0.2 corresponds to a proportional share of 20 %.

• Device list
The Device list box lists all devices created in the system that correspond to the selected device type and
the filter criterion. Select the desired device.

Energy Counters and Universal Counters

Table 7-1 Energy Counters and Universal Counters

Counter/
device type

counter.W_t1
Active
energy on-
peak tariff

counter.W_t2
Active
energy off-
peak tariff

counter.Q_t1
Reactive
energy on-
peak tariff

counter.Q_t2
Reactive
energy off-
peak tariff

counter.coun
ter
Universal
counter

counter.coun
ter_2
Second
universal
counter of
the PAC4200

counter.user
_counter_1
counter.user
_counter_2
…
counter.user
_counter_10
10 pulse
counters of
the PAC4200

Generic
Modbus
Device

X1

PAC 1200 X X
PAC 1500 X X X X
PAC 1600 X X
PAC 2200 X X X X X
PAC 3100 X X
PAC 3200 X X X
PAC 3200 T X X X
PAC 4200 X X X X X X X
PAC 5100 X
PAC 5200 X
Virtual
Counter

X

P850 X
P855 X
3VA ETU5 X X
3VA ETU8 X X
3WL X X
3WL 10 X X

Datapoints in the EnergyReport
The EnergyReport is a cost center report without assignment of costs.
You can select further data types in addition to the consumption meters.

7.3.9.6

1 5 universal counters
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[sc_InsertMeasuredValueWindow, 1, en_US]

Figure 7-19 Insert Measured Value Window

The Insert Measured Values window has the following fields:

• Archive type
Select one of the following options from the Archive type list box:
– Counter

Select this option to limit the list of measured values to the consumption values.
– HDB directly

Select this option to limit the list of measured values to the general measured values.
Select the HDB directly option for the energy report to select power demand values.
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• DP function
The DP function field has a predefined value.

• Offset
Adjust the value in the Offset box for the Measured value comparison report.
For other reports, do not change the predefined value 0.

• Automatic formatting
Select any one of the following options from the Automatic formatting list box to format the raw data in
the report output:
– No formatting: Select this option if you do not want to format the exported data.
– Only format: Select this option to assign values up to a fixed number of decimal places.
– Format and unit: Select this option to assign values to a fixed number of decimal places. The unit of

the measured variable is also displayed.

[sc_DailyReport, 1, en_US]

• Min / max marker
Select this option to highlight the minimum and maximum values in the report.

• Statistical functions
You can print the minimum value, maximum value, average of all values, or sum of all values in the
footers of the reports.
The default report templates are prepared only for these four functions.

Mailing List

Overview of Mailing List
For powermanager Report version 2.0 and above, you can send reports by e-mail.
The finished report can either be sent automatically using a fixed schedule or manually.

Creating a Mailing List
The subject and the recipient are specified in the mailing list.
To create a mailing list:
² Click the Add-Ins tab, and click Report > Mailing List.

- or -

²
In the Cost centers window, click .
The Mailing list dialog opens.

² Enter the message in the Mailing list window.

7.3.10

7.3.10.1

7.3.10.2
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² In the Label field, enter the name of the recipient or a recipient group.
- or -

² Click  to open the Find address dialog.
Select one or more recipients and click OK.

² Enter the subject for the mail in the Subject field.

² Click OK.

Sending an E-mail Manually
Ensure that the following prerequisites are met before you send an e-mail:

• A mailing list is created.

• A report is open.

² Click the Add-Ins tab, and click Reports > Send Mail.
The Send mail dialog opens.

² In the Send mail dialog, select a recipient from the To list box.

² Click OK.

Sending an E-mail Using a Schedule
Ensure that you have at least one mailing list created before you set a schedule for sending an e-mail.
² Click the Add-Ins tab, and click Report > Schedule.

The Schedule window opens.

² In the Schedule window, select a schedule.

² Click Edit entry.
The Schedule dialog opens.

² Select the Mailing list option.
When saved according to the schedule, the report is also sent as a mail to a defined mailing list.

HTML Pages

Overview of HTML Pages
In powermanager Report version 2.0 and above, you can generate finished reports as HTML pages using the
Schedule option.
You can also manually generate an HTML page from an opened report. You can publish the HTML pages on a
Web server or for similar purposes.

ii
NOTE
You can only generate HTML pages with Report if you are using MS Excel 2013/2016.

Creating a Base Directory
To create a base directory:
² Click the Add-Ins tab, and click Report > Configuration > Options.

The Password dialog opens.

² In the Password dialog, specify the password.

7.3.10.3

7.3.10.4

7.3.11

7.3.11.1

7.3.11.2
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² Click OK.
The Settings dialog opens.

² In the Settings dialog, click the HTML tab.

² In the HTML field, specify the directory path to store the HTML pages.
The default path is C:\Siemens\SENTRON\powermanagerV3.4\data\xls_report.
The report is placed in a subdirectory depending on the report type.

[sc_Create_BaseDir, 3, en_US]

Figure 7-20 Creating File Path for HTML Pages

² Click OK.

Creating an HTML Page

Prerequisites
Ensure that the following prerequisites are met before you create an HTML page for the report:

• Open the report which you want to convert to an HTML page.

• Select the base directory.

Procedure
Click the Add-Ins tab, and click Report > Save as HTML to save the report in HTML format.

Creating an HTML Page Using Schedule
Ensure that you create a base directory before you create the HTML page.
To create an HTML page using schedule:

7.3.11.3

7.3.11.4
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² Click the Add-Ins tab, and click Report > Schedule.
The Schedule window opens.

² In the Schedule window, select a schedule.

² Click the edit icon.
The Schedule dialog opens.

² In the Schedule dialog, select the HTML export option.
The report is saved in the default path as an HTML page.

Publishing Reports on the Internet
powermanager Excel Report 3.x lets you publish reports through Web servers. Either the Siemens AG power-
manager HTTP server can be used for this, or any other Web server can handle publication.

Layout of an Internet Report
In HTML, a report is displayed in a logical sequence with tabs: first the table, then the diagram, and, if appli-
cable, further analysis tables.
To publish a report on the Internet:
² Click the Add-Ins tab, and click Report > Save as HTML to save the report in HTML format.

² Publish the result file with the .htm extension on your Web server.

Use Cases

Creating a Cost Center Report

Prerequisites
Ensure that the following prerequisites are met before you create a cost center report:

• powermanager Excel Report is open.

• Medium is created

• Tariff set is created

• Cost center report is created

Creating a Template
To create a template:
² In the powermanager report window, under the Template area, click New.

The Report format dialog opens.

² In the Report format dialog, select the Cost center report template from the Format list box.
The Report types dialog opens.

² In the Report types dialog, select the required report type. Excel opens the cost center report template of
the selected report format.

Using a Template

² Create the first datapoint in column C of the Excel template.
Mark any cell or any cell area in column C.

² Click the Add-Ins tab, and click Template > Insert DP.
The Measured Value window opens.

² In the Measured Value window, select the datapoint type.

² In the Measured value list box, select the datapoint element for the counter of the device type.

7.3.11.5

7.3.12

7.3.12.1
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² In the Device list area, select the device that provides the demand values.

² In the Cost center list box, select the cost center to which the counted demand values are assigned.

² Enter a conversion factor if the values in Unit in report and Unit of DP differ.

² Enter a weighting (0-1) as a decimal factor that specifies the proportionate assignment of the counted
demand values for the selected cost center. A share of 0.2 corresponds to a share of 20 %.

² Click OK.

² Click OK.
Excel applies the data from the Measure Value window to column C of the template.

² Insert further datapoints in column D, E, and so on.

² Save the template under proj_path/data/xls_report/Template with the .xltm extension.

Creating a Report

² Create a report using the previously created template and by entering the time range.

² In the Time range for report types dialog, select Costcenter_daily.

² Enter the time range for the new report.

² Save the report under proj_path/data/xls_report/Report with the .xlsm extension.

System Requirements

System Requirements

Operating system, Excel, and
ADO

Windows 7, Windows Server 2008/2012 R2, Windows Server 2016, and
Windows 10
Excel 2013, Excel 2016 (activate macros and ActiveX manually)

Network TCP/IP capable LAN, for templates with file access

You must be a member of the Main user group (this is also valid for powermanager, not only for the Excel
Report).

Technical Requirements Prior to Installing powermanager Excel Report
Ensure that the following conditions are met before you install powermanager Excel report:
² Microsoft Excel 2007/2010/2013 is installed.

² MDAC 2.7 (ADO) is installed.
The ADO 2.6 option is not available as an extra option. The Microsoft Sub installation MDAC 2.7 is run if
you want to use a feature and it is not installed.

² Use of the History database (WCCOAvalarch).

² A report licence is required to use Excel Report.

² Run the regsvr32 command for the following files:
C:\WinNT\system32> regsvr32 SubTimer.dll
C:\WinNT\system32> regsvr32 MSCOMCTL.OCX
C:\WinNT\system32> regsvr32 MSCOMCT2.OCX
The files with the .dep extension contain information on the files needed by the respective ActiveX
control.
Files or documents with such an extension can be opened or processed using the Visual Basic Setup
Wizard program. Registration is not possible.
Alternatively, you can also run the batch file under \\reportRegEdit\reportReg.bat on the instal-
lation disk.

7.3.13
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ii
NOTE
Under Windows 2008/2012, it is not possible to register the subtimer.dll file. In this case, the file
MSVBVM50.DLL is missing. Download the file from the Microsoft site http://support.microsoft.com/kb/
180071/.

ii
NOTE
Activate macros in Excel. Share the whole project (project directory) with both write and read permissions.

ii
NOTE
If you use statistical functions and have specified the Always start calculation at time on the Synchroniza-
tion tab of the datapoint function, the start time for the report has to be the same as the Always start
calculation at time of the DP function.

Adding a New Language to the Excel Report
To add a new language to the excel report:
² Start the powermanager project.

² Start the Excel report.

² Click the Home tab, and click Format > Hide & Unhide > Unhide Sheet.
The Unhide dialog opens.

² In the Unhide dialog, select the Texts sheet.

² Click OK.

² Add a new column.

² Translate the texts.

² Hide the Texts sheet.

² Save the report.

[sc_AddNewLanguage, 1, en_US]

Figure 7-21 Report.xls

Settings for Continuous Operation
To avoid excessive memory utilization by Excel Report:
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7.3.13.4
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² Configure the macro settings so that you do not have to confirm the use of macros when starting the
Excel Report.

² Configure Scheduled tasks on the Windows Control Panel:
1. Task for starting the Excel Report.
2. Task for stopping the Excel Report via the following scripts:
Name: kill_excel.sh:

#************************** kill_pvss2 ***********************

#* kills the running Excel-Report

#*

#*************************************************************

GetExcelID()

{

set -- $( tlist | grep -i " EXCEL.EXE" | cut -d " " -f1 )

echo $1

}

#*************************************************************

#* MAIN

#*************************************************************

set -x

pid=$( GetExcelID )

echo MAIN $ pid

kill $ pid

and

Name: kill_excel.cmd:
@ bash kill_excel.sh

ii
NOTE
When you configure the tasks, the directory where the tasks are executed must the same directory where
the data (Excel Report, scripts) is located.

Configure the tasks so that they are executed cyclically, for example, once a week. Select the times so that
they do not overlap with the times of automatic report calls.
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Installing powermanager Excel Report

Automatic Installation
powermanager Excel Report is installed automatically.

Starting powermanager Excel Report
To start the powermanager Excel Report:
² On the System Management panel, click the Reports tab.

² Click Excel Report.
- or -

² In the menu bar click Tools > Advanced report.

[sc_ReportTab_SyMgmt, 2, en_US]

Figure 7-22 Launching Excel Report from the System Management Panel

Installing a powermanager Excel Report Client Computer

Setting up the Computer Link Between Client and Server
The following example demonstrates, with specific reference to the Excel Report, how to establish a connec-
tion from a client to a server to create reports. This section is relevant only if you do not want to run power-
manager Report on the powermanager server.

Example
The network contains two computers, a server and a client.
Use the server to:

• Install powermanager (along with Data Manager and Event Manager)

• Set up the powermanager project.

• Install the powermanager Excel Report (optional).
You can start the Excel Report by default on the server because everything runs locally on the server.
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Use the client to:

• Install the powermanager Excel Report as the UI client.

• Set up all the necessary powermanager components, except the project. The components are installed
automatically for the UI client installation option.

Setting up COM Manager on the Server for the Server
To set up COM Manager on the server for the server:
² Open Report.xls on the server.

² Click the Add-Ins tab, and click Report > Configuration > Options.
The Settings dialog opens.

² Select Default in the Options for host list box.
The ComManager tab displays the default config file address.

[sc_ComManagerTab_Default, 3, en_US]

Figure 7-23 Configuring COM Manager for Server Computer

Configuring a Network Drive Connection

² Configure a network drive connection on the client to the server computer.
For example, assign the drive letter F: for the computer name eiwnt066.

Configuring the Client Host
To configure the client host:
² Create a config file in the config directory.

² Adapt the project path in the config file.
proj_path = "F:/<proj_path>/<Project_name>"
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² Select Options in the Report - Configuration menu.
The Settings dialog opens.

² Click Create.
The Host name dialog opens.

² Enter the host name.

² Enter the data and event manager in the config file.
data = "server computer name"
event = "server computer name"

Client host is configured.
Create new reports on the client computer using powermanager Excel Report (Report.xls).

[sc_ComManager_ClientHost, 3, en_US]

Figure 7-24 Setting Up the COM Manager for the Client Using Example Entries

Configuring powermanager Excel Report

To access all the settings that must be specified once at the time when a project is set up:

• Click the Add-Ins tab, and click Report > Configuration.

The settings are protected by a password.

Operator Controls
The buttons used in the parameterization dialogs are described below:

7.3.15
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Button Description of Functions
Create an entry.

Edit an existing entry.

Delete an existing entry.

Display the name of the computer you are working on.

Open or import an existing file.

Select a data record.

Retrieve values from powermanager.

Arrange the elements of a list.

Password

ii
NOTE
To ensure protection of data, replace the default password (erAdmin) with your own password after you
start the application for the first time.

ii
NOTE
The settings for Report can only be made once you have entered a password.

ii
NOTE
If, after enabling Save password you forget to turn off this access to Report, these Report settings are not
protected, although you must enter the password again after restarting powermanager Report.

All configuration settings are password protected.
Use password protection to protect reporting settings from access by inexperienced users. Obtain further
information directly from your powermanager supplier.
If you have entered the correct password, click OK to confirm the password. Else, the OK button is deacti-
vated. After you successfully enter the password, you do not need to specify it again until the next time you
start the report.

Saving the Password
After you enter the valid password, click Report > Password and select the Save password option.
If the  icon is visible along side the Save Password option, then the password is enabled. Click the entry

to block the configuration. The icon changes to  and you log off.

Applicability of the Password
The password applies to the following areas:

• Configuration of report. The default password is erAdmin. You can modify the password.

• Sheet protection for normal reports. The default password is erAdmin. This password is different from
the report configuration password. You can modify the password.
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• Protection of the release for reports with the Track changes option. The default password is erAdmin.
This password is different from the report configuration password and the sheet protection password.
You cannot modify the password for existing reports.

• Protection of the whole report file using a fixed password for released reports (contact the Siemens AG
product center regarding the password). Use this password to open a report when the Excel Report is not
running and does not play any other role.

• The source code.

Change Password
To change the password:

• Click the Add-Ins tab, and click Report > Configuration > Change password.
The Change password dialog opens.

• Enter the current password in the Old password field.

• Enter the new password in the New password field.

• Enter the modified password again.

• Click OK.

ii
NOTE
The password is not specific to any user and is also used for sheet protection of all reports created.

Options
Use the Options menu to define general settings and specifications regarding communication between the
COM manager and powermanager (TCP/IP).
Click the Add-Ins tab, and click Report > Configuration > Options to open the Settings dialog.
The Options menu is present in the Settings dialog.
The settings are defined for each computer. The Default setting applies to all computers for which no specific
setting is defined. Excel Report defines the correct computer name.
In the Options for the host list box, select the computer that serves as the host for timing control. The
settings then apply to the current host.

Click  to add a new computer.

Click  to display the name of the computer in use.

Click  to delete an existing computer name with the associated settings. You cannot delete the default
settings.
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Tab Settings Notes
General Host for schedule Select a host for timing control.

Use only one computer for timing control for the whole
powermanager project.

Language Select the language in which powermanager Report (menu
items and dialogs of the Report AddIn) is displayed.
All other menus and dialogs in MS Excel are displayed in the
installation language of Excel. Comments and descriptions
for powermanager are shown in the language in which the
datapoint list is written in powermanager.
You can switch the language for powermanager Report
online. By default, powermanager Report uses the language
set in Excel.

Password for reports Enter a password to protect the sheets of all new reports in
the text box.
The password can differ from the configuration password.

Automatic logout When you select the option box, a minute(s) field is addi-
tionally displayed in the dialog.
In the minute(s) field, enter the automatic logout time in
minutes.

Day changeover point Enter the day changeover point.
When you generate a new report, synchronize the time
periods to the day changeover point set here.
Use the value query icon to read the day changeover point
set in powermanager (type: _config, datapoint
element: _config.StartHour). The value read is
displayed in the associated field.

Reset Excel Report Click Reset Excel Report to reset the current settings to the
default initial settings.
You lose all your customized settings for tariffs, cost
centers, and so on.

ComManager Config file Enter the path to the config file.
The selected Config file determines what powermanager
project the COM manager connects to.
Select the file from within the entire network using the File
Browser (file selection window).

Command line Enter further parameters in the Command line field.
Example of a command line entry:

• data datahostname
• event eventhostname

HTML HTML Specify a path where new reports are saved as HTML files by
default.
In Report Versions 2.0 and above (with Excel version 2000
and above), you can generate finished reports automatically
as HTML pages using the Schedule option.
You can also generate an HTML page manually from an
opened report.
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Tab Settings Notes
Datapoint selec-
tion

Extended functions Use the Extended functions option to define whether the
extended functions are available for selection in the Insert
measured value dialog.

Old datapoint types Use the Old datapoint types dialog to parameterize which
datapoint types (device types) are offered for selection
when selecting measured values.
All datapoint types not yet selected are displayed in area 1.

New datapoint types Datapoint types selected for display are moved to area 2.

ii
NOTE
It is recommended that you stick to one language for all parameter settings (especially, for importing the
archive structure and the datapoint list).
As data and event are not entered in the powermanager config file by default, specify the paths to Data
Manager and Event Manager in the command line during client installations.
If powermanager data is accessed simultaneously by separate Report installations, the ID of each computer
involved must be unique. The number of different IDs depends on the powermanager license.

Importing the Archive Structure
The archive structure file (AC datapoint types) is created from the main AC parameterization panel in power-
manager.
The archive structure contains the datapoint types used in powermanager together with their elements (if
present), the associated compression levels, the intervals, and the associated datapoint functions (compres-
sion rules).
Click Report > Configuration > Archive Structure to import the archive structure.
Click the Add-Ins tab, and click Report > Configuration > Archive structure to import the archive structure.
A File Browser opens. Select the required file from all the files in the network. The default directory in which
powermanager saves the file is <proj_path>/data/xls_report.
New or modified archive structures (datapoint types) are adopted in Excel Report and confirmed with a
message.
If new datapoint types are adopted in the database, basic values and report types are created automatically for
the default intervals 5 minutes, hour, day, and month. The names are based on the language currently set in
powermanager Report.

[sc_CreateBasicValue_Message, 1, en_US]

Figure 7-25 Creating a Basic Value

Basic Values
From the various compression structures of different datapoint types, those elements that contain similarly
compressed data, for example, hourly values or daily values, are collected together into a group of basic
values. You can select any name for these basic values.
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All the compression levels for the standard intervals of interest are derived automatically from the archive
structure. powermanager creates the automatically generated basic values when the structure file is imported.
The basic values simply require confirmation by the parameter setter.
Do not change the basic values. The following screenshot is an example of all basic values defined for a
project.

[sc_BasicValues_Window, 1, en_US]

Figure 7-26 Basic Values

The following basic value parameterization window is used for editing or creating an entry.
In case of distributed systems, you can select between several systems.
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[sc_BasicValue_Parameterization, 1, en_US]

Figure 7-27 Basic Value Parameterization

Use the magnifying glass to select other data records to assign to the basic value that is open for editing.
Use the Interval as a filter criterion for selecting the archives and as a default value for the period (result) or
the interval (data) for the report types.
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[sc_Template_Window, 1, en_US]

Figure 7-28 Selecting Data Records

Define the filter settings in the top window section. These settings affect the lower part of the display.
The datapoint element within a datapoint type is defined in the DPE column beside the datapoint type. In the
adjacent columns, the selected compression level and associated interval are displayed.

Special Case: Groups with Different Archiving Intervals
You can group archives of different datapoint types into a basic value with different memory intervals. For
example, it is possible to display a laboratory value entered once a day in the same daily report as hourly
recorded measured values by using the same laboratory value for each hourly value (for example, a sum of a
day divides to a 1/24th).
On the other hand, you can display measured values and count values in a weekly report as a four-hourly
mean value (or sum value), even though the values are archived half-hourly.
The only requirement is that the ratio of the converted values to the archived values is an integer, and that a
common synchronization time is found for them. Since the required calculation of the values is performed in
Excel, only the functions Min, Max, Sum, and SumNumber (arithmetic mean) return valid results.

Report Types
The report type establishes the connection between the datapoint names (represented by the basic values)
and their archive values.
Similar to basic values, you can also derive the report types automatically from the archive structure for the
standard intervals of interest. Therefore, it is not necessary to make any changes to the report types.
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The following image shows a list of parameterized report types.

[sc_ReportTypes_Window, 1, en_US]

Figure 7-29 Report Types

The settings of the basic values are subdivided into a data and a result area.
The period that is set represents the time period displayed in this report. Each data record is displayed at a
time interval derived using the interval for a time period.
Use the synchronization settings to offset the start time for the report. For example, if a day changeover point
is set to 06:00 hours and you open a daily report with a period of one day and an interval of one hour, the first
value is entered at 06:00 hours and the last for 05:00 hours of the following day.
Settings Notes
Name Enter a name for the report format.
Data Select the interval period.
Result Select the periodic querying of the report.
Period Select the report creation period.
Interval Select the interval.

The Interval is used as a filter criterion for selecting the archives and as a default
value for the period (result) or the interval (durations) for the report types.

Report begins at Specify the time of triggering the report creation repetition interval.
On the day of the week Select a day of the week.
On the day of the month Select a day of the month.
In a month Select a month.
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[sc_ReportTypes_Parameterization, 1, en_US]

Figure 7-30 Parameterization of the Report Type

Special Case: Report Covering Several Periods
You can create reports that extend over several periods. The results are always expected for a datapoint at the
start of the time period, and are not retrieved over the full period. Therefore, at the template creation stage,
ensure that the results (values from the footer or result area in column-oriented reports) are not retrieved
from powermanager, but are calculated from the retrieved data held in powermanager Report.

Special Case: Report with Parameterized Interval
The basic values need not necessarily be based on the time ranges from the powermanager archive but you
can parameterize the display. For example, an hourly values basic value is specified for the data area that,
while it contains real values, does not contain hourly values but 30-minute values instead. However, the
report would then be defined here to display a value only for every other hour. This value is set in the Interval
field.

Status Bits
For every value entered in the powermanager database, a 64-bit data word is saved containing the status bits
that represent the saved value. The information contained in the status bits ranges from flagging up invalid
values, through identification of range violations, right up to labeling of correction values.
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Use the status bits to format the values in a report. Simplify the status bits to avoid having to handle all theo-
retically possible status bit combinations (2^64). Excel recognizes the 64 status bits mapped onto 5 different
status designations (valid, substitutional, invalid, corrected, default) by a bit-wise comparison of the status bits
with a bit pattern. If a match is found, the relevant cell is formatted according to the identified status. The
actual formatting corresponds to the Excel standard. For example, invalid values or correction values are high-
lighted in a suitable way in the Excel reports.
The status bits in the standard version are predefined. Do not change the status bits. You can rearrange these
status settings or add new ones to them.
The following figure lists the defined status bits with their meaning. When evaluating the data, the bit pattern
list is worked through from top to bottom until the first match is found. This formatting is then applied to the
row. Place those bit patterns expected to occur most frequently (for example, valid) as close to the top of the
list as possible.
A 0 in the bit pattern indicates that the bit is not set. A 1 indicates that the bit is set. A question mark labels
irrelevant status bits. This indicates that the bits are irrelevant to the comparison whether these bits are 0 or 1.
The Ignore values column indicates whether a value identified for this status is included in the statistical func-
tion, or whether it is ignored (applies to calculations in MS Excel).

[sc_StatusBits_Window, 1, en_US]

Figure 7-31 Display of Defined Status Bits
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New entries or changes in the list are handled as follows:

•
Click  to assign formatting to the selected status designation.

[sc_StatusBits_Parameterization, 1, en_US]

Figure 7-32 Parameterizing a Status Bit

• Click an individual element in the comparison bit-pattern to change the value in the sequence ?-1-0.

[sc_StatusBits_Format, 1, en_US]

Figure 7-33 Defining a Format

• Select the Ignore values option to include the value whose status matches this bit pattern in the statis-
tical calculations in Excel. The format template is saved in the Report (Report.xls).
After changing this format template, update each template.
To update the template, click the Add-Ins tab, and click Report > Update templates.

ii
NOTE
Only the templates located in the Template directory are updated.
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Tariff Sets
For information on tariff sets, see 7.3.5.1 Overview of Tariff Sets.

Cost Centers
For information on cost centers, see 7.3.6.1 Overview of Cost Centers.

Media
For information on media, see 7.3.4.1 Overview of Media.

Configuring the Microsoft Excel Macro Security Level

The security concept of Microsoft Excel enables you to decide whether to run the macros or not. For interrup-
tion-free operation of the powermanager report generator, set the security level to low.
To configure the Microsoft Excel macro security level:
²

For Excel 2007, click  > Excel Options.
For Excel 2013/2016, click the File tab, and then click Options.
The Excel Options window opens.

² In the Excel Options window, click Trust Center.
The Trust Center page opens.

² On the Trust Center page, click Trust Center Settings....
The Trust Center window opens.

² In the Trust Center window, click Macro Settings.

² On the Macro Settings page, select Enable all macros.

² Click OK to close the Trust Center window.

² Click OK to close the Excel Options window.

7.3.16
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Export

Overview of Topology Export

² To open the Topology export, click Tools > Topology export.
The Topology export dialog opens.

²
Click .
The Choose a File dialog opens.

² Enter a File name.

² Click Save, to save the CSV file.
To enable importing of the device data using the mass parameterization feature, ensure that you name
the CSV file with the prefix PM_.
For example, PM_Example.csv.
For more information on mass parameterization, see 7.6 Mass Parameterization.

7.4

7.4.1

Tools
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Power Peak Analysis

Overview of Power Peak Analysis

powermanager contains a report generator for determination of power peaks within a specified time range.
You can evaluate the following values using the report generator:

• Power demand values of the PAC device types. The time stamp of the power demand values is at the start
of the period.

• Parameterized power demand values of generic Modbus devices.

Report
You receive the result of analysis in the form of a tabular report in the csv file format. You can open, print, and
edit the report file with Microsoft Excel.
powermanager issues the report in the language that you set.

[sc_Powerpeak_Report, 1, en_US]

Figure 7-34 Power Peak Analysis Report

Opening the Power Peaks Window

To open the Power Peaks window:
² In the menu bar click Tools > Power peak analysis.
The Power Peaks window opens and displays the last saved configuration.

7.5

7.5.1

7.5.2

Tools
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[sc_Powerpeaks_Window, 2, en_US]

Figure 7-35 Power Peaks Window

Creating a Report

To create a report:
² Open the Power Peaks window.

² Modify the configuration data to suit your requirements.

² In the Target Path field, specify the directory where you want to save the report.

² Click Create Report to start the report creation.
Wait until the progress bar goes up to 100 % and then goes back to 0 %.
Save the modified configuration if you wish to keep it.

Configuring Power Peaks

Scope
Configuring power peak analysis comprises:

• Selecting datapoints

• Defining the limit of the datapoint

• Narrowing down the query period

7.5.3

7.5.4
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• Displaying power peaks in the report

• Report file name and path

Selecting Datapoints
The Measured values table lists the datapoints that are included in the analysis and are printed in the report.
The Meas. Value Selection area under the Measured value table provides the following functions for editing
the table entries:

• Including datapoints in the Measured value table.

• Deleting a datapoint from the Measured value table.

• Changing the limit of a datapoint or limits of all datapoints.

Including a Datapoint in the Measured Value Table
To include a datapoint in the Measured values table:
²

Click  to open the Value Selection dialog.

² In the Value Selection dialog, select the required datapoint from the selection tree.

²
Click .

² Specify the threshold of the datapoint in the Limit field.
Violation of the threshold is considered to be a power peak.

² Select Single Limit option.

²
Click .

The datapoint with its assigned threshold is now visible in the Measured Value table.

Deleting a Datapoint from the Measured Value Table

ii
NOTE
The system deletes the selected datapoint without prompting for confirmation.

To delete a datapoint from the Measured value table:
² Select the datapoint that you want to delete.

²
Click  to delete the selected datapoint.

Deleting All Datapoints from the Measured Value Table

ii
NOTE
The system deletes the selected datapoint without prompting for confirmation.

To delete all datapoints from the Measured value table:
²

Click  to delete all datapoints from the Measured value table.

Editing a Datapoint from the Measured Value Table
To edit a datapoint from the Measured value table:
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² Select the datapoint that you want to edit.
The data for the selected datapoint becomes visible in the Meas. Value Selection area.

² Make the required changes to the datapoint details.

² Select Single Limit option.

²
Click  to save the changes.

Editing Single/General Limit

Selecting the Single Limit or General Limit option changes the behavior of the  button.
² Select the Single Limit option to transfer the current values of the Measured value and Limit fields to the

Measured value table while retaining the existing entries in the table.
- or -

² Select the General Limit option to transfer the current values of the Measured value and Limit fields to
the Measured value table and overwriting the thresholds of the existing entries with the new threshold
value.

ii
NOTE
To cancel this step, reedit all limits already parameterized.

Query Period
The Start time and End time fields in the Query parameters area narrow down the query period.
A number of previously defined calendar periods are available for selection.
Open intervals:

• Today

• This week

• This month

• This year
Closed intervals:

• Yesterday

• Last week

• Last month

• Last year

• Last 24 hours

• Last 3 days
Any periods:

• Any day

• Any period
A selected previously defined period can be modified to suit requirements.
To define a query period:
² Click Set query time.

² Select one of the previously defined periods in the dialog.
- or -
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² Define an individual period in the Start time and End time fields.

²
Click  to save the changes.

Displaying Power Peaks in the Report
To display the power peaks in the report:
² Select Show percentage deviation.

The system calculates and prints the percentage deviation of the power peak from the parameterized
limit value.

² In the Number area, the All option is selected by default. Keep this option selected if you want to display
all the power peaks per measuring point in the report.
- or -

² Select Input if you want to display a set number of power peaks per measuring point in the report.
Specify the limit in the field beside the Input option.
If the number of power peaks exceed the set value, then an annotation is inserted in the report.

Report Filename and Path

Filename
powermanager generates the power peak analysis report in the csv file format.
The format of the file name is:
Peak_Data_<YYYY>_<MM>_<DD>_<HH>_<MM>_<SS>.csv
Here, <YYYY>, <MM>, and <DD> denote year, month, and date respectively. They indicate the date when the
report generation started.
<HH>, <MM>, and <SS> denote the hour, minute, and second respectively. They indicate the time when the
report generation started.

Directory
To select the directory where the report is saved:
² Specify the directory in the Target path field.

By default, the Target path field contains the address of the last set directory.
If you want to save the report to other directory, overwrite the path to suit your requirements.
The lowermost directory must end with a directory delimiter. For example, ../data/ instead of ../data.

Default Directory
If the specified directory does not exist, powermanager saves the report in the default directory.
The \data directory underneath the project directory is the default directory.
The default directory is set by default when the application is installed.
Any directory deviating from the default directory is stored on the client system and not throughout the
system.

Saving the Power Peaks Configuration

ii
NOTE
Unsaved configuration changes are lost when you close the Power Peaks window.

² Click  to save the power peaks configuration.

7.5.5
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Calculating Power Peaks

Scope
powermanager calculates power peaks based on archived data.
A power peak consists of one or more periods. It begins with the end period of the first measured value that
exceeds the defined threshold and ends with the end period of the last measured value that exceeds the
defined threshold.
To determine the end of the period, the period length at the time of the period start is determined and is
added to it. If several measured values exceed the limit in succession, the highest violation within the time
range is specified as the power peak. The end period of the value is always specified in the report as the time
for a measured value.

Percentage Deviation
The percentage deviation from the limit is calculated based on:
((Value of the highest violation) – (Limit)) / (Limit) * 100
The percentage deviation is rounded to integral percentages without decimal places.

Example of Percentage Deviation
Consider a scenario where the defined limit is 2 kW and the query period is from:
01.01.2010 10:00 to 01.01.2010 11:00

Table 7-2 Measured Values

Time stamp (period start) Time range [min] Value [W]
01.01.2010 10:00 h 15 1957
01.01.2010 10:15 h 15 2110
01.01.2010 10:30 h 15 2215
01.01.2010 10:45 h 15 2013
01.01.2010 11:00 h 15 957

Based on the values in the preceding table, the following violations have occurred:
01.01.2010 10:30 h to 01.01.2010 11:00 h
Value: 2215 W
Therefore, the percentage of deviation is:
( 2215 W – 2000 W ) / ( 2000 W ) * 100 % = 11 %

Closing the Power Peak Window

To close the Power Peaks window:
² Click  to save the configuration changes.

²
Click  to close the Power Peaks window.

ii
NOTE
Unsaved configuration changes are lost when you close the Power Peaks window.

7.5.6

7.5.7
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Mass Parameterization
Overview

You can automate creation of new devices in the project tree. To do this, create a csv file in the project data
directory.

Example
Consider that you want to create the following devices in an automated fashion:

• Two PAC4200 devices with the names MyPAC4200_1 and MyPAC4200_2

• One PAC3100 device with the name MyPAC3100_1 via Slot1 of the gateway MyPAC4200_2

• One PAC3100 device with the name MyPAC3100_2 via the standard gateway

7.6
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To create the csv file:

• The format of the command to create the above devices in automated fashion is:
DP name;DP type;area;sector;IP address;gateway;unit_address;frame;port
Here,
– DP name is the internal device name.
– DP type is the device type.

Following device types are available in powermanager:
– pmDev3VAETU5
– pmDev3VAETU8
– pmDev3VA27
– pmDev3VLCOM21
– pmDev3WL (3WL)
– pmDev3WL10 (3WL)
– pmDevPAC1200, pmDevPAC1500, pmDevPAC1600, pmDevPAC2200, pmDevPAC3100,

pmDevPAC3200, pmDevPAC3200T, pmDevPAC4200, pmDevPAC5100, pmDevPAC5200
– pmDevMB (generic Modbus device)
– pmDevP850, pmDevP855 (SICAM P85x devices)
– pmDevManualMeasuringDevice

– Area is the area name in the project tree.
– Sector is the sector name in the project tree.

Only 1 sector level is supported.
– IP address is the IP address of the system.
– Gateway has a value range of TRUE or FALSE.

Following gateways can be defined:
– Modbus-TCP: FALSE
– Modbus-RTU: TRUE

– Unit_Address is the address of the unit in the subnetworked Modbus network.
– Modbus-TCP: 0 (no relevance)
– Modbus-RTU: 1 - 247

– Frame is defined as [tcp; rtu]

– Following ports are available:
– Modbus-TCP: 502
– Modbus-RTU – Slot1 : 17002 (7KM PAC4200, RS 485 bus is connected to slot "MOD1")
– Modbus-RTU – Slot2 : 17003 (7KM PAC4200, RS 485 bus is connected to slot "MOD2")
– Modbus-RTU – standard gateway: 502

• Therefore, for the above example, the following entries must be made in the csv file:
MyPAC4200_1;pmDevPAC4200;area_4;sector_2;192.168.219.214;FALSE;0;tcp;502
MyPAC4200_2;pmDevPAC4200;area_4;sector_2;192.168.219.215;FALSE;0;tcp;502
MyPAC3100_1;pmDevPAC3100;area_4;sector_2;192.168.219.215;TRUE;1;rtu;17002
MyPAC3100_2;pmDevPAC3100;area_4;sector_2;192.168.219.214;TRUE;1;rtu;502
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ii
NOTE

• Select tcp as a frame for a device you want to operate over the standard gateway.

• A predefined sample file PM_MassDataTmplte.csv is present in the data directory of the demo
project.

User Interface
In the menu bar, click Tools > Mass parameterization to access the mass parameterization display.

[sc_MassParameterization, 3, en_US]

Figure 7-36 Mass Parameterization View

The mass parameterization view contains the following components:

• File
The File table in the left panel lists all the csv files that are created in the data directory of the current
project.

• Read file
Select a file from the file table and click read file to see the data of the file in the right panel.
– If a device with an identical name and device type exists in the project tree, the device is highlighted

in Yellow.
– If a device with an identical name and a different device type exists in the project tree, the device is

highlighted in Red.
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• Import data
Click Import data to import the data of the selected file.

You can also overwrite existing devices or create areas that do not exist.
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Project Settings

Configuring Project Settings

The System settings page enables you to change the project settings. It enables you to change the project
configuration and change device configuration.
To open the System settings page, right-click the project tree root and click System settings.
System settings page has the following tabs:

• Configuration
The Configuration tab displays the version number of the project. Additionally, it contains the following
options:
– In the General section,

No archive smoothing
Select this option to disable smoothing of the measured values, but it will increase the memory
utilization in the database.
UL standard
Select this option to represent the measured values in accordance with UL standard. The default
standard used is IEC standard.

– In the Default value in case communication stops section,
Default device value
Select this option to assign a default value to any device in the project if the communication
between the device and powermanager stops.
If you select this option, define the default value in the Default value box.
The default values will not be assigned for energy and power period values.
Set as invalid value for report
Select this option if you want to highlight the devices that use the default values in the report.

– Report settings
Password
erAdmin is the default password for basic reports. Use this field to customize the password for all
basic reports. It is recommended that you change the password.

• Device
The Device tab contains the following options:
– Create Device

Use this option to create a new device type.
For more information, see 8.1.3 Creating New Device Type.

– Delete device
Use this option to delete any of the manually created device types.
To delete a device type, select the device type from the Device type drop-down list, and click
Delete.

– Update database for
Use this option to set the database size for the current project.
To set the database size for the current database, select the maximum number of devices from the
drop-down list and click Update.

8.1

8.1.1
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Optimizing Performance

Overview
powermanager offers the following options to improve the performance of the system:

• Smoothing supplied data

• Extending polling times

• Reducing active addresses

Smoothing Supplied Data
Smoothing is used to reduce the amount of communication and the volume of data stored in the system.
powermanager can smooth the data supplied by the devices in the driver before it is processed further in the
control system.

Value-dependent Smoothing with Relative Threshold Value
powermanager performs value-dependent smoothing with a relative threshold (specified in [%]).
A value is only smoothed if the difference between value arriving in the driver and the last value transferred to
the Event Manager is less than the relative threshold.
No smoothing takes place if the difference between the consecutive values exceeds the relative threshold
value.

Value Range
Meaningful threshold values lie in the range from 0 % to 5 %.

8.1.2
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Smoothing Supplied Data
To smooth the supplied data:

• Right-click the project tree root.

• In the context menu, click System settings and select the Driver tab to view the driver settings.

[sc_DriverSettings, 3, en_US]

• In the Driver settings view, enter the relative threshold percentage in the % field next to the change
smoothing button.
The recommended relative threshold range is from 0 through 5 %.

• Click change smoothing to start the smoothing process.

Extending Polling Times
Depending on the measured value type, measured values are read (polled) by powermanager at different
times. The communication load is reduced when the polling times are increased.
To change the polling times:

• In the Polling times table, under the New value column define the updated polling time.

• Under the Unit column, select the unit for each polling group from the drop-down list.

• Click Save to confirm the changes.
Click Reset to reset all the changes.

ii
NOTE
Ensure that the polling time assigned to each group is between 100 ms to 900 s.
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Reducing Addresses
You can reduce the number of active addresses to optimize the performance of powermanager. You can
reduce the addresses for the PAC1200, PAC3200, PAC3200T, PAC4200, PAC5200, P855, and P850 devices
using a semi-automated process. For PAC1500 and PAC3100, the scope of addresses is already reduced by
default.
To reduce the addresses:

• Right-click the project tree root.

• From the context menu, click device engineering > PAC3200/PAC3200T/PAC4200.

• Go to the Configuration tab.

[sc_Reducing_Addresses, 2, en_US]

• On the Configuration tab, deselect the Use default settings option.

• To reduce address of a device, under the Address column, deselect the checkbox corresponding to the
device.

• Save the above configuration.

Result
The reduced scope of addresses affects:

• Newly created devices

• Devices with the Use area settings option activated

Restoring the Original Address Configuration
To restore the original address configuration, activate the Use default settings option and save the change.

Creating New Device Type

The XML import feature enables you to add new device types to powermanager.

Prerequisites
Before importing the XML file to powermanager, create the XML file with valid device information.

8.1.3
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You can create a new XML file using the following method:

• A sample XML file, ImportSample.xml, is present in the following location:
<drive_letter>:\Siemens\SENTRON\powermanager\powermanagerLib\data\Xml_Import\
where, <drive_letter> is the drive letter of the directory where powermanager is installed.
This location also contains the XML schema PM_Import.xsd.
Open the XML file and enter the valid device information. Save the file in the same location.

To import the XML file:
² In the project tree view, right-click the project tree root.

² On the context menu, click System settings.
The System settings page opens.

² Click the Device tab.

² On the Device tab, under Create device, click Import.
The XML_Import window opens.

²
Click  next to the Select an XML import file field.
The Choose a file window opens.

² Browse to the XML file path.

² Select the XML file you want to import and click Open.
The details of the select XML file are displayed on the XML_Import window.

² Click Start Import.
powermanager starts importing the XML file.

² After the import is complete, the Import Results field shows the following message:
All steps passed.

Additionally, a green circle is displayed next to the Import Results field.

Settings and Configurations
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[sc_ImportXML, 3, en_US]

² Close the XML_Import window.
After successful import of the XML, the newly created device is visible in the Create device context
menu.

Measuring Period and Tariff Synchronization

Overview
powermanager enables you to synchronize the power demand values and the tariffs of multiple devices using
the digital input of a single device. You can only synchronize the PAC devices (PAC2200, PAC3100, PAC3200,
PAC3200T, and PAC4200).

ii
NOTE
It is recommended that you enable synchronization when configuring the devices.

powermanager enables you to add offline device for synchronization. These devices are taken into considera-
tion when they come online.

Prerequisites
Ensure that you meet the following prerequisites before enabling synchronization:

• Ensure that all the devices that you want to synchronize have the Synchronization via Bus setting
enabled.

• Ensure that the synchronization interval for all the devices is 15 minutes.

8.1.4

8.1.4.1
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Measuring Period Synchronization
To synchronize measuring period:
² Right-click the system node from the tree.

² Select System settings.

² Select the Synchronization tab.
The Measuring period dialog opens.

The Measuring period tab displays the following columns:
Sync.: Select the checkbox in this column against the device for which you want to enable synchronization.
Device: Devices added for synchronization
Bus/DI/Clock/None: Synchronization type set for the device
Interval Length: Synchronization interval. This must always be set at 15 minutes.
² Select Synchronize measuring period with this digital input.

²
Click  to add devices for synchronization.
The selection tree for digital inputs window opens.

² Select the digital inputs for devices that you want to synchronize.

² Click OK.
The device is added to the synchronization table.

² To enable synchronization for a particular device, select the device using the checkbox under the Sync.
column.

ii
NOTE

To enable synchronization for all devices, click .

² Click  to save the changes.

Tariff Synchronization
To synchronize tariff:
² Right-click the project tree root.

² In the context menu, click System settings > Synchronization > Tariff.
The Tariff tab opens.

The tariff tab displays the following columns:
Set tariff: Select the checkbox in this column against the device for which you want to enable synchroniza-
tion.
Device: The devices that you added for synchronization.
² Select Set high/low tariff with this digital input.
²

Click  to add devices for synchronization.
The selection tree for digital inputs window opens.

² Select the digital inputs for devices that you want to synchronize.

² Click OK.
The device is added to the synchronization table.

8.1.4.2

8.1.4.3
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² Under Tariff signal meaning, select the appropriate option.
1-signal at digital input means high tariff: Select this option if you want to set the tariff to high.
1-signal at digital input means low tariff: Select this option if you want to set the tariff to low.

² To enable synchronization for a particular device, select the device using the checkbox under the Sync.
column.

ii
NOTE

To enable synchronization for all devices, click .

² Click  to save the changes.
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Engineering of the Power Management System

Device Engineering for Power Monitoring Devices, E-counters, and Circuit
Breakers

Overview of Device Engineering

Device Support

• Power monitoring devices and circuit breakers: powermanager supports the power monitoring devices
belonging to the PAC series and the 3VL, 3VA, and 3WL circuit breakers.

• Generic Modbus device: Use the generic Modbus device, to connect any Modbus-enabled data acquisi-
tion devices directly to the powermanager via Ethernet (Modbus TCP) or via a gateway (for example,
PAC4200) using RS485 interface.

Opening Device Engineering
To open device engineering for a device, right-click the device in the project tree and click Device engi-
neering.

Communication and Units Tab

[sc_pm_comm_units, 1, en_US]

Set the following parameters on the Communication and Units tab:

• IP address of the device: When communicating via a gateway, use the IP address of the higher level.
When communicating via Modbus TCP, use the IP address of the device.

8.2

8.2.1

8.2.1.1

8.2.1.2
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• Gateway communication: Activate gateway communication if the device is connected using Modbus
RTU via gateway.
– Select the Access point:

– PAC4200 - 1st slot
– PAC4200 - 2nd slot
– Gateway

– Port number:
This option with the default port number 502 in the text box is displayed only on selecting the check
box Gateway communication. You can modify the port number.

– Unit address:
Unit address (Modbus address in the Modbus RTU subnet)

• Device password:
Using this option, you can enter the device password for the following devices:
– PAC2200
– PAC3100
– PAC3200
– PAC3200T
– PAC4200
For the password-protected devices, the synchronization of the device is possible only when you enter
the correct password.

powermanager uses units and factors for setting the displayed unit. The conversion factor between the unit in
the device and the displayed unit is specified.

ii
NOTE
A unit change and a denominator refer to the display and do not change the datapoint.
When using a PAC4200 as the gateway, configure the unit address on the device.
The 3VL circuit breaker cannot be operated via COM11 over the gateway of the PAC4200.

Configuration Tab
Define the following on the Configuration tab:

• Elements polled by the device by software (address)

• Measured variables that are displayed under Selected values (display)
You can configure the settings for individual devices.
However, you can also inherit the settings from the entire area. For this purpose, select the Inherit area
settings option.

• Measured variables to be archived for each device (archiving)
If you archive large number of measured variables, it affects the system speed (performance).
For more information, see 8.1.2 Optimizing Performance.

• Measured variables for which an alert is triggered (alarm)

• Setting of the upper and lower limit values
The unit in which the limit value must be entered is displayed under Unit.

8.2.1.3
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Configuration Tab for PAC1200
The Configuration tab for the PAC1200 device is different from the standard Configuration tab available for
other PAC devices. It has the following subtabs:

• Data manager:
The Data manager tab displays the configuration options for all data points of the data-manager compo-
nent of the PAC1200 device. The inheritance option is available only in the data manager Configuration
tab.

• Sensor:
The Sensor tab displays the configuration options for all data points of all the sensors that can be
connected to the data manager (96 in total). The units for data-manager data points and sensor data
points are the same.

ii
NOTE
Communication setup is required only for data manager configuration. By default, the energy data points
from data-manager configuration and the sensor configuration are archived.

Alert Configuration Tab
On the Alert configuration tab, define the texts to be displayed in the alert window.
For this purpose, see the message names and the standard messages saved in the software. You can modify
these and assign individual texts for all the languages supported by powermanager. If you do not assign your
own texts, the standard messages are used.

Extended Configuration Tab
On the Extended configuration tab, define the properties of the measured values of a generic Modbus
device.
You can change the names of the measured variables for all the languages supported by powermanager. The
element column shows the modified names.
Click reset to default values to reset all changes to the delivery status.

Trend Configuration Tab
The Trend configuration tab enables you to configure trend curves for generating trend graphs. This func-
tionality is available for all devices.
You can add a maximum of nine trend curves for each device type.
The Trend Configuration tab is only visible if you access the Device Engineering view at the System level.
The trend curves configured for a device type are applicable to all the devices of that device type. For example,
if you add trend curves to PAC4200 device type, then those trend curves are visible for all the PAC4200
devices added to the project.
To add a trend curve:
² Right-click the tree root.

² On the context menu, click Device engineering > <device type>.
The Device engineering view for the selected device opens.

² Open the Trend configuration tab.
The trend configuration table displays the default trend curves for the selected device.

² To add new trend curves, deselect Use default settings.

² Select a row in the Curve name list.

² Click .
The dpSelector window opens.

² In the dpSelector window, select the parameters for which you want to create the trend curve.

8.2.1.4

8.2.1.5

8.2.1.6
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² Click OK.
The selected parameter is added to the Curve name list.

² Click , to delete the selected data point.

²
Click , to delete all the data points.

² Click Save.
The new curve is visible under the Trend tab in the standard view of the device type.

Dashboard Configuration Tab
The Dashboard configuration tab enables you to configure gauge, trend, and bar chart configurations. This
functionality is available for all devices.
The Dashboard Configuration tab is only visible if you access the Device Engineering view at the System
level.
² Right-click the tree root.

² On the context menu, click Device engineering > <device type>.
The Device engineering view for the selected device opens.

[sc_Dashboard_Config, 1, en_US]

² Open the Dashboard configuration tab.
The default Gauge configuration, Trend configuration, and Barchart configuration is displayed.

² You can deselect the Use default settings, to change the configurations.
In the Gauge configuration section,

² Click , next to any of the Data point fields.
The Data point selector dialog opens.

² Select a data point and click OK.
The name of the selected data point will be displayed in the data point field.

² Click , next to the corresponding Range field.
The Select range dialog opens.

8.2.1.7
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² Configure the range values and colors and click OK.
The configured Range will be displayed.
Configure the required data points and ranges accordingly.
In the Trend configuration section,

² Click , next to any of the Data point fields.
The Data point selector dialog opens.

² Select a data point and click OK.
The name of the selected data point will be displayed in the data point field.
In the Barchart configuration section,

² Click , next to the Data point field.
The Data point selector dialog opens.

² Select a data point and click OK.
The name of the selected data point will be displayed in the data point field.

² Select an Interval.
² Click Save, to save the configuration.

PAC4200

Event Memory Messages
The messages of the PAC4200 event memory are displayed if they were configured in the device as the
Warning or Alert type. The message type can be configured in the device.

ii
NOTE
Set the messages in the system settings to back-to-normal if you have authorization for switching (3). For
example, use this setting when messages of the PAC4200 event memory are displayed but the associated
messages in the device are deleted.

Load Profile Memory
The Power period group shows values of the load profile memory. In this connection, apparent energy, active
energy, or reactive energy can be recorded, depending on the device configuration. The type of reactive
power (VAR1, VARn, or VARtot) in the load profile memory depends on the settings in the device.

Inputs and Outputs

PAC3100 Digital Inputs
Use the 2 digital inputs of the PAC3100 as status inputs in powermanager. The settings on the device are
made via the powermanager device configuration software.

PAC3200/PAC3200T Digital Inputs
The digital input of the PAC3200/PAC3200T can be freely assigned:

• Universal counter

• Status
The software detects the selected mode automatically.

8.2.2

8.2.3
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PAC4200 Digital Inputs
Use the 2 digital inputs of the PAC4200 in the software in accordance with the configuration in the device.
If the inputs are configured as pulse inputs in the device, record the value via the two universal counters in the
software. For this purpose, activate the address and, if necessary, archiving of the universal counter in the
device engineering.
The device automatically detects the unit and cannot be changed in the software.
If the inputs have been configured as status inputs in the device, you can monitor them in the software. If
necessary, trigger an alert. Configure the alert texts in the device software in the project tree.
In addition to the internal inputs, you can use the inputs and outputs of the DI/DO modules in accordance with
the configuring in the device.
You can switch the outputs of the modules via the software. Use the Switch digital outputs tab for this
purpose.

PAC4200 - External DI/DO Modules
powermanager detects and external modules plugged into the device. Each module offers 4 digital inputs that
can be used in the software in accordance with their configuration in the device.
If you want to read the inputs via the user counters in accordance with the configuration of the device, acti-
vate their addresses in powermanager. Use device engineering for this purpose.
You can also use device engineering to activate data archiving. The units are read out directly from the device
and cannot be changed in the software.
If you want to assign alerts to the inputs, select the measured variable for status monitoring in the device
engineering. Define the alert texts on the Alert configuration tab in device engineering.

Outputs

General
For information on digital outputs, see 6.4.1 Overview of Reaction Plans.

PAC3100
If you switch an output of the PAC3100, it takes up to 10 s before the switching operation is visible for the
powermanager user. The switching operation takes effect immediately on the device.

N-conductor Module
N-conductor modules can be connected to PAC3200 and PAC4200 devices. Only one N-conductor module can
be connected to one PAC3200/PAC4200 device. The system checks if any N-conductor module is connected to
the device and displays the N-conductor details accordingly. The N-conductor details are available in the
Status and Commands tab in the respective section. The functionality is similar to that of any DI/DO module
getting plugged into the device. Also, if the N-conductor module is plugged in, in the Overview tab of the
PAC3200/PAC4200 device, the neutral current measured is also displayed below the neutral current. The
details about I5 and I6 are displayed in powermanager as they are configured in the device.

Generic Modbus Device

Any Modbus-Enabled Data Acquisition Devices
With the generic Modbus device, you can link any Modbus-enabled measuring devices to powermanager.
The generic Modbus device supports:

• Up to 50 measured variables

• 10 status messages

• 5 power demand values

• 5 counter values

8.2.4

Settings and Configurations
8.2 Engineering of the Power Management System

powermanager,  , Help 263
E50417-H1076-C550-A7, Edition 06.2019



• 10 commands (write values)

• 10 digital outputs
Power and energy values are displayed in groups.
The following specifications are mandatory for device configuration:

• Name of the measure value

• Transformation type

• Index

• Specification of the Modbus Function Code

• Specification of a factor with which the supplied measured value is multiplied

• Unit of the measure value

• Specification of a message for the status messages

Overflow Limits
You can parameterize the overflow limits of the counters on the Counter Configuration tab.

Support of Free Interval Lengths
The values that are parameterized as power demand values in the generic Modbus device are restamped in
the system.

Setting the Endian Byte Order
You can set the endian byte order for polling the data on the Communication & Units tab.
Depending on whether the device transmits data in big endian order or little endian order, select the appro-
priate option for data polling under Endian Byte Order on the Communication & Units tab.

Configuring Digital Outputs
Each generic modbus device that you create contains provision to configure 10 command data points and 10
digital outputs.You can configure these command datapoints and digital outputs from the Extended configu-
ration tab in the Device engineering view.
You can assign values to each command data points (write values) on the Write values tab in the standard
view of Generic modbus device.
Additionally, you can view and change the state of the digital outputs on the Switch digital outputs tab in the
standard view of Generic modbus device.

Virtual Counters

Overview
Use a virtual counter to calculate consumption values such as active energy, reactive energy, or counted units
of the universal counter.

Linking Count Values
Virtual counters are used to link counter values. They are available as objects in the tree.
The following operations are possible:

• Summation/differentiation of counter values
A unit can be specified for the result.
In the display, you see the formula including the measured variables involved. You can create the virtual coun-
ters from the shortcut menu.

8.2.5

8.2.5.1
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Device Engineering for Virtual Counter
On the Counter configuration tab, assign an energy counter or a universal counter to the virtual counter.
Define the unit and the corresponding conversion factor.
Following components are visible on the Counter configuration tab of the device engineering view:

• Unit
– Unit recorded by the universal counter of the connected device. For example, m3 for cubic meters.
– Unit of the energy counter.

• Factor
Define a factor to convert units. For example, conversion from watt-hours to kilowatt hours with a factor
of 0.001.

• Variable
Universal counter or energy counter

• Operator
Operators for adding or subtracting counters

To add a universal or energy counter to the Counter configuration tab:
² Define the unit of the counter in the Unit field.

²

Click .
The VC input panel window opens.

² In the VC input panel window, define the factor in the Factor field.
Select the universal or energy counter from the Variable drop-down list.

² Click OK.

² Click Save, to save the changes.

ii
NOTE
You can add up to 10 counters per virtual counter.
You can also add one virtual counter as an universal/energy counter for another virtual counter.

Calculation Value Device

Overview
You can create the calculation value device unit in the project tree.
The Calculation value object enables you to group and convert a maximum of 10 freely selected measured
values using a customized formula.

Effect of Using Calculation Units
A device can be deleted only if it is not used in any calculation unit.
For more information about the device engineering of the Calculation values, see 8.2.6.2 Calculation Value
Configuration Tab.

Calculation Value Configuration Tab

Variable
Select the measured values using the selection tree. Every selected measured value is assigned a variable iden-
tifier p1, p2, and so on. Use the variables in the calculation formula.

8.2.5.2
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Operators
They are also used for the following Boolean functions:
Notation 1 Notation 2 Function
OR || OR
AND && AND
XOR ^ EXCLUSIVE OR
NOT | NOT

Formula in the Function Box
Create the formula in the Function box.
The Function box is case-sensitive.
If a variable identifier used in the Function box does not correspond to any measured value, the value of that
identifier is zero.
Ensure that the formula is syntactically correct. The function is checked for validity before it is saved.

Examples
Following are some examples of syntactically correct formulas:

• p1 + p2 + p3

• (p1 + p2) / 1000

• (p1 || p2) && p3

Average Value Device

Overview
The average value device is a virtual device, which enables you to calculate the average value of any data
point from a physical device or another average value device over a specific time period.
After configuring an average value device, you can monitor, represent, and archive the average value calcu-
lated by the device.
The Device Engineering view enables you to define average value parameters for each device on the
Average value configuration tab. You can define up to 10 average value parameters for each device.
For more information, see 8.2.7.2  Average Value Configuration Tab.

Average Value Configuration Tab
The Average value configuration tab enables you to configure the Average value device.
By default, there are 10 placeholders available to add the parameters for which you want to calculate the
average value. The placeholders for average value parameters are named Average Value 1, Average Value 2,
Average Value 3...Average Value 10.

8.2.7
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[sc_AverageValue_Tab, 2, en_US]

Average Value Configuration Tab
To add an average value parameter for an average value device:
² Select a placeholder from the Average value configuration table.

² Click .
The dpSelector window opens.

ii
NOTE

To delete a parameter, select the parameter and click . The parameter is deleted and is replaced by the
respective placeholder.
For example, if you delete the third parameter, then it is replaced by the placeholder Average Value 3.

² In the dpSelector window, select the device for which you want to create the average value parameters.

² Click OK.

² The average value parameter is added to the table.

² By default, the average value for a device is calculated for an interval of 15 minutes. However, you can
set the interval between 1 min to 1440 minutes (24 hours).

² Under the Factor column, define a factor to calculate the average value for the defined unit.

² Under the Unit column, define the unit of the average value data point.

² Click Save, to save the configuration.
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ii
NOTE
Ensure that the average value parameter fulfills the following conditions:

• The selected data point must be available for the device.

• The selected data point must belong to a local system and not a distributed system.

• The selected data point type must be an integer, unsigned integer, or float value.

• The selected data point must not be an average value data point itself.

• Each combination of the data point and the calculation interval should be unique.
Additionally, the selected data point must also be archived for powermanager to calculate the correct
average value. If the data point is not archived, powermanager will still calculate the average value for that
data point. However, if you restart the project, powermanager does not calculate the correct value for the
data point.

ii
NOTE
For information on the Configuration and Extended Configuration tabs, see 8.2.1.3 Configuration Tab
and 8.2.1.5 Extended Configuration Tab.

Converter Device

Overview
The converter device is a virtual device, which enables you to convert the power values to corresponding
energy values and vice versa.
After configuring a converter device, you can monitor, represent, and archive the power or energy values
calculated by the device.
The Device Engineering view enables you to select data points to convert for each device on the Converter
configuration tab. You can define up to 10 converter data points for each device.
For more information, see 8.2.8.2 Device Engineering for Converter Device.

Device Engineering for Converter Device
The device engineering view enables you to define power/energy parameters for each device on the
Converter configuration tab. You can define up to 10 parameters for each device.
By default, there are 10 placeholders available in each tab to add the power or energy parameters. The place-
holders for energy parameters are named Energy Value 1, Energy Value 2, Energy Value 3...Energy Value
10. The placeholders for power parameters are named Power Value 1, Power Value 2, Power Value
3...Power Value 10.

Converting Energy to Power
To add energy parameters to the Energy to Power tab:
² Select a placeholder from the Energy to Power table.

8.2.8
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[sc_Energy2Power_Converter, 2, en_US]

Figure 8-1 Energy to Power Converter Tab

² Click .
The Selection tree for energy values window opens. The Selection tree for energy values window
displays only the energy data points of all the devices.

Settings and Configurations
8.2 Engineering of the Power Management System

powermanager,  , Help 269
E50417-H1076-C550-A7, Edition 06.2019



[sc_EnergyDP_Input, 1, en_US]

Figure 8-2 Selection tree for energy values

ii
NOTE

To delete a parameter, select the parameter and click . The parameter is deleted and is replaced by the
respective placeholder.
For example, if you delete the third parameter, then it is replaced by the placeholder Energy Value 3.

² In the Selection tree for energy values window, select the data points for which you want to create the
average value parameters.

² Click OK.
The converter parameter is added to the table.

² Under the Period (mins) column, select the time interval for which the energy data is collected. This data
is then converted to power data.
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² Under the Factor column, define a factor to convert units. For example, converting kW to kWh.

² Under the Unit column, define the unit of the converter data point.

² Select the show trend option from the Show trend column.
This enables you to view the trend graph of the selected data points in the trends view.

² Click Save.

Converting Power to Energy
To add power data points to the Power to Energy tab:
² Select a placeholder from the Power to Energy table.

[sc_Power2Energy_Converter, 2, en_US]

Figure 8-3 Power to Energy Converter Tab

² Click .
The Selection tree for power values window opens. The Selection tree for power values window
displays only the power data points of all the devices.
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[sc_PowerDP_Input, 1, en_US]

Figure 8-4 Selection tree for power values

ii
NOTE

To delete a parameter, select the parameter and click . The parameter is deleted and is replaced by the
respective placeholder.
For example, if you delete the third parameter, then it is replaced by the placeholder Power Value 3.

² In the Selection tree for power values window, select the data point for which you want to create the
average value parameters.

² Click OK.
The converter parameter is added to the table.

² Under the Factor column, define a factor to convert units. For example, converting kWh to kW.

² Under the Unit column, define the unit of the converter data point.
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² Select the show trend option from the Show trend column.
This enables you to view the trend graph of the selected data points in the trends view.

² Click Save.

ii
NOTE
Ensure that the converter parameter fulfills the following conditions:

• The selected data point must be available for the device.

• The selected data point must not be a converter data point itself.

• Each data point selected for conversion must be unique.
Additionally, the selected data point must also be archived for powermanager to correctly convert the data
point. If the data point is not archived, powermanager will still convert that data point. However, if you
restart the project, powermanager does not calculate the correct conversion value for the device.

ii
NOTE
For information on the Configuration and Extended Configuration tabs, see: 8.2.1.3 Configuration Tab
and 8.2.1.5 Extended Configuration Tab.

Filter Administration

Overview of Filter Administration
You can use filters to restrict the scope of the measured quantities, displayed in the base panel, to individual
views.
Some examples of filtering are:

• Filtering current values of all devices belonging to a specific sector

• Filtering voltage values supplied by all devices of the PAC4200 type

• Filtering total active power of all devices in the system with heating as part of their names

Using Filters
User-defined filters are available at the area, sector, and project tree root level. The required filter can be
selected from the filter list box in the base panel.

Filter Administration and Configuration
Use filter administration to define new filters or to modify existing ones. Right-click the project tree root to
view the filter configuration options.

Using Filters
To apply a user-defined filter:
²

In the tool bar, click  to open the Standard view of the base panel.

² In the project tree, select the level (root, area, or sector) to which you want to apply the filter.

² Select the required filter from the filter list box.
The base panel shows the filtered datapoints of the selected project tree branch.
The system remembers the assignment of the project tree branch and filter. Use No filter from the filter list
box to return to the unfiltered overall view.

8.2.9
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ii
NOTE
If the filter list box shows only the default and No filter filters, then it implies that no user-defined filters
are created.
In this case, create a filter list.

Managing Filters

Opening Filter Administration
Right-click the project tree root and then click Filter administration to open the filter administration view.

[sc_pm_filteradmin, 1, en_US]

Figure 8-5 Selecting Filter Administration

8.2.9.3
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Filter Administration View

[sc_FilterAdmin_View, 2, en_US]

Figure 8-6 Filter Administration View

Filter administration is split into the following three areas:

• Basic Functions
The area at the top provides four basic functions:
–

 – Create a filter

–
 – Delete a filter

–
 – Save filter settings

–
 – Rename a filter

• Previous Settings
The previous settings area shows the settings of the currently selected filter.

• Configuration Elements
The Filter mode and Filter definition areas enable you to configure the filters.
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Creating a New Filter
To create a filter:
²

Click .

² Name the filter and click Accept.
The filter name appears in the list box at the top of the filter administration view.

² Configure the filter in the configuration elements area.

²
Click  to save the filter.
You can change the filter name later to adapt it to a different language.

Modifying an Existing Filter
To modify an existing filter:
² Select the filter you want to edit from the list box at the top of the filter administration view.

² Change the filter configuration in the configuration elements area.

²
Click  to save the filter.

Deleting a Filter

² Select the filter you want to delete from the list box at the top of the filter administration view.

²
Click  to delete the selected filter.

The selected filter is deleted.

ii
NOTE
You cannot delete the default filter.

Renaming a Filter
To rename a filter:
² Select the filter you want to rename from the list box at the top of the filter administration view.

²
Click  to rename the selected filter.

² Enter the new name in the dialog.
The dialog shows several languages for selection. Change the name in the required target language.

Configuring Filters

Types of Definitions
Filter administration offers two methods of configuring filter settings:

• Select selection criteria from predefined lists.
To do this, select the list option.

• Definition of text sequences that conduct a full text search.
To do this, select the wildcard option.

8.2.9.4
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Areas
The filter conditions can be applied to:

• Area
Areas that are created in the project tree.

• Device type
Device types.

• Device name
Devices that are created in the project tree.

• Sectors
Sectors that are created in the project tree.

• Measured value
All retrievable measured values.

Five tabs denote the objects to which filter conditions are applied. Each tab represents one object.
If you select the list option, the tabs provide area-specific lists for selection.
A text sequence of the wildcard filter definition type is effective in the area in which it has been created.

Language Dependence
If you use the list option, the filter results are identical for all languages in the project. The system saves the
compiled filter based on the internal designation.
Wildcards refer to the designations in the current language. When you use wildcards, the same filter in
different languages return different results.

List Filter Mode

Assigning Selection Criteria
To adopt selection criteria for a filter, move the values from the available groups and available measure points
boxes to the selected box.

• Selecting a measured variable for the filter

Select a measured variable from the available measure points box and click  to move it to the
selected box.

• Selecting all the measured variables for the filter

Click  to move all the measured variables to the selected box.

• Removing a measured variable from the filter

Select a measured variable from the selected box and click  to move it to the available measure
points box.

• Removing all measured variables from the filter

Click  to remove all measured variables from the selected box.

Wildcards Filter Mode
The wildcards mode allows you to define text sequences that filter the display as full text search criteria.
The text sequences can contain wildcards.
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[sc_Filter_WildcardsMode, 1, en_US]

Figure 8-7 Power Peak: Wild Card Filter Mode

Table 8-1 Wildcards

? Any character
* One or several of any characters

Example:
The text sequence PAC* entered in the advance selection of the Device tab limits displays only the devices
from the PAC series.

Empty Filter
No filter is active when the Pattern box is blank or contains the test sequence *.
The configured filters are displayed immediately in the Previous settings area.

User Rights

User Rights

ii
NOTE
Assign a password to each user with administration rights. Else, access to powermanager is unprotected.
When powermanager is delivered, the standard user root has no password. Assign a password to the
standard user root.

8.2.10

8.2.10.1
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Predefined Authorization Levels and User Groups
The powermanager standard has the following predefined groups and levels:

• 5 user groups

• 5 authorization levels

• Assignment of user groups

• Authorization levels

Table 8-2 Authorization Levels

Level Name in the dialog Scope of rights
1 Visualize Allows only visualization
2 Normal operator authorization Allows the opening of panels
3 Extended operator authorization Allows the execution of commands, the setting of

substitute values, the setting of correction values, and
the modification of value range types

4 Administration Allows the use of GEDI and PARA
5 Acknowledgement Allows the acknowledging of alerts

Table 8-3 Rights of the User Groups in the powermanager Standard

Group/Level Visualization Operator Authorization Administration Acknowledge-
mentNormal Advanced

Root X X X X X
Para X X X X X
Operatorall X X X X
Operator X X X
Guest X

The group assignment confers the group rights on the user.
For more information, see User Administration, Basics.

Creating Users

ii
NOTE
Do not delete the standard user "root".

To create a user:
² In the menu bar click Settings > System management.

The System Management window opens.

² Open the Permission tab in the System Management window.

² Click .
The User Administration window opens.

² On the User Administration window, click Add User.
The User Characteristics window opens.

² Enter the required information in the User Characteristics window.
Assign a password.

8.2.10.2
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² Click OK to confirm creation of the new schedule.
The user account is created in powermanager. The account is listed in the User administration window.
You can log on with the assigned user name and password.

² Click Close to exit the User administration window.

User Administration Window

[sc_UserAdmin_Window, 1, en_US]

Figure 8-8 User Administration Window

• User name
powermanager logon name

• Groups
User groups to which a user is assigned
Each user receives specific user rights through the group. Assign each user to at least one group.

• ID
Internal identification number of the user account

• User language
Language of the powermanager user interface
powermanager suggests the language when you log on.

User Characteristics Window
On the User Administration window, click Add User. The User Characteristics window opens.

8.2.10.3
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[sc_UserCharacteristics_Window, 1, en_US]

Figure 8-9 User Characteristics Window

• User name
Name of the user account
The user uses this name to log on.

• Full Name
Full name of the user

• Description
Short description of the user account

• Language
Language of the powermanager user interface
The language is suggested to the user at logon.
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• Group membership
Assign the user to at least one user group. You can also assign the user to multiple groups.
The group assignment confers the group rights on the user. For more information on the rights assigned
to the users in different groups, see Predefined Authorization Levels and User Groups.

• Password
Click Password to open the field for assigning password.
Ensure that you assign a password for each user having administration rights. Else, the access to power-
manager is unprotected.

Archive Settings

Archive Settings

Alert Classes
With the default database configuration, archive records are not deleted from the hard disk until they are
saved using Backup. Therefore, the hard disk capacity becomes full unless appropriate backups are made.
To prevent this, warning limits are set as default for hard disk capacity monitoring.
The default settings are:

• Hard disk full (warning): powermanager displays this warning when 3 GB or less hard hard disk is free.

• Hard disk full (alert): powermanager displays this alert when 1 GB or less hard hard disk is free.

• Emergency mode: powermanager displays this alert when 100 MB or less hard hard disk is free.
You can change these settings. For more information, see Monitoring the hard disk.
If disk capacity falls below the set emergency limit of 100 MB, powermanager switches to a safe mode to
protect its own database integrity. In the safe mode, you can still operate the project, but values are no longer
archived.
To exit emergency mode, correct the storage bottleneck and restart the project.

Archiving of Measured Values

General
The following measured values are archived as standard:

• Total power demand
– Active power
– Reactive power
– Apparent power

• Energy values
– Active energy (total of tariff 1 and tariff 2, tariff 1 by default)
– Reactive energy (total of tariff 1 and tariff 2, tariff 1 by default)
– Apparent energy

The power demand values are used to display load curves. You can optimally save the associated min/max
values. The energy values are used for consumption analysis.

Online Measured Values
You can configure measured values to be archived.
Measured values are time-stamped in the software. When archiving measured values, adapt the archive size to
the database since archiving of these measured variables uses up considerable space in the database.

8.2.11
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ii
NOTE
Adapt the archive size due to the multiple measured variables. To optimize storage capacity, the data is
only written to the database when modified.

For more information, see 8.1.2 Optimizing Performance.

Archiving Power Demand Values (PAC4200)
Power demand values from the PAC4200 device are read out of the device memory. Therefore, if the connec-
tion to the device fails, the data is read later from the device and entered in the database. This process avoids
gaps in the database.

Further Engineering Options

Support of Free Interval Lengths for PAC Devices
powermanager supports 15 min interval lengths.
The interval length supplied with the power values is compared with the interval length available in the DPE.
An error message is issued in the alert line if the values deviate from one another by more than 30 s. The alert
is reset if the interval length again drops between the tolerance limits.
It is not necessary to adapt the polling cycles of measured values as they are always below 1 min (minimum
interval length).
An additional DPE converts the interval length supplied by the PAC to minutes. You can select this variable for
the selected values.
If an energy export is triggered and then a tariff interval is modified, this change is not detected in the export.

Period and Time Synchronization
Activate the addresses for a device in device engineering to enable period/time synchronization for the device.
The Set Date/Time Automatically element is available for time synchronization, and the Automatic Load
Profile Synchronization element is available for period synchronization.

Inheritance
Inheritance means that the configuration of a device type is transferred to all devices within the area.
To activate inheritance, select the Inherit area settings option in Device engineering.
To set the valid area settings:

• Right-click the area.

• In the shortcut menu, under device engineering, select the device type for which you want to create the
area settings.

• Configure the device type.

• Click Save.
Inheritance is applied to all devices in the area for which the Inherit area settings option is selected.
Deselect the Inherit area settings option if you want to remove inheritance from the device.

General Configuration
Perform general configuration of powermanager in the System Management.
For more information, see System Management.
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Configuring E-Mail Server Settings
The E-mail configuration dialog is used to configure the E-mail server settings.
² In the menu bar, select Settings.

² Click E-mail configuration.
The E-mail configuration dialog is displayed.

[sc_pm_email_configuration, 1, en_US]

² Enter a SMTP server address.

² Enter the corresponding Port number.

² Enter a User name, for the SMTP server.

² Enter a Password, for the SMTP server.

² Select TLS, to use encryption and authentication.

² Click OK.
The E-mail server settings are configured.

8.3
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E-mailing List
The E-mailing list dialog is used to configure the e-mailing list details.
To configure the e-mailing list, proceed as follows:
² In the menu bar, select Settings.

² Click E-mailing list.
The E-mailing list dialog is displayed.

[sc_pm_emailing_list, 1, en_US]

² Click  to add the mailing list details.

The Add E-mailing list dialog appears.

[sc_pm_addemaillist, 1, en_US]

² Enter the required details.

² Click Ok.
The mailing list details are configured and displayed in the E-mailing list dialog.

8.4
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OPC Server Configuration
The OPC server configuration dialog enables you to add a data point or a group of data points to configure
the OPC server.
OPC UA Server and OPC UA Client are supported from powermanager V3.5 onwards.
To configure the OPC server, proceed as follows:
² In the menu bar, select Settings.

² Click OPC server configuration.
The OPC server configuration dialog is displayed.

[sc_pm_opc, 1, en_US]

² Using the list-box option, select the desired OPC group value as OPCRead, OPCWrite, OPCUARead, or
OPCUAWrite.

² Click Add group.
The Add group dialog is displayed.

8.5
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[sc_pm_addgroup, 1, en_US]

² Using the list-box option, select the desired Group.

² Click OK.
The group is added.
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[sc_pm_groupadded, 1, en_US]

² Click Add data point.
The Select data point dialog is displayed.
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[sc_pm_selectdpexample, 1, en_US]

² Select the desired data point.

² Click OK.
The data point is added.

² Click Configuration summary.
The Configuration summary dialog displays the list of all the configured details.
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[sc_configuration_summary, 1, en_US]

OPC UA services
You must start the OPC UA Server manually to use OPC UA services. A separate license is required to enable
OPC UA services. For more information on OPC UA, refer to the Drivers section in the extended help.
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dpSelector Window
The dpSelector (Select data point) window enables you to select the appropriate datapoints or measured
values.
You can toggle between two views on the dpSelector window:

• The Device data point tab under Custom view displays the project tree with project-specific designa-
tions for the area, sector, and device.

• The KPI data point tab under Custom view displays the KPI tree with project-specific designations for the
group and KPI.

• The DPE tab under the Technical view displays the three-stage tree of the datapoint types, datapoints,
and datapoint elements.

[sc_pm_dpselectorviews, 1, en_US]

Figure 8-10 Data Point Selector Windows

ii
NOTE
The Technical view is only available with powermanager expert license.

Selecting Datapoint Elements
To select datapoint element for the trend display:
² For Device data point tab, apply the filter criteria in the Filter settings box.

The Filter settings box contains the following fields:
Device type: Select the device type from this drop-down list.
Device name: Enter the device name.
Group: Enter the group name to which the device belongs.
Data point: The name of the data point.

² Double-click the relevant entries in the tree view to reach the datapoint element that you want to include
in the trend view.

² Select the datapoint element and click OK.
- or -

8.6
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² For DPE tab, apply the filter criteria in the Filter options box.
The Filter options box contains the following fields:
DPT filter: The Datapoint Type (DPT) filter field has a default filter value of pmDev*. The * in the string
indicates any character string.
DP Filter: Define the Datapoint (DP) filter in this field.
The final results are filtered based on the filters defined in both the fields.
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Load Monitoring

Overview of Load Monitoring

Purpose of Load Monitoring
Electricity supply contracts contain provisions to calculate the kilowatthour rate and the demand charge.
The demand charge is calculated according to the maximum imported power.
Therefore, avoid power peaks and distribute the power demand uniformly throughout the day.
Load monitoring enables you to:

• Monitor energy use

• Respond to deviations from the planned target

Orientation Variables
Load monitoring supplies two orientation variables for estimation of consumption behavior:

• Correction power

• Forecast energy consumption

Correction Power
The correction power is the power that has to be connected or disconnected to use the energy volume avail-
able for the current tariff interval optimally. It informs you whether the energy imported in the tariff interval is
within the limits of available energy and is used optimally.

Forecast Energy Consumption
Load monitoring forecasts the expected energy consumption at the end of the tariff interval. The forecast is
recalculated for each calculation interval and becomes more precise after each calculation interval.

Tariff Interval / Calculation Interval
The tariff interval is subdivided into a number of calculation intervals that can be selected. The correction
power and the consumption forecast are determined for each calculation interval.

Response
Load monitoring supports reactive measures with:

• Switching bits

• Alerts

Switching Bits
Load monitoring sets the following switching bits:

• Element switchNo: The bit is set if the correction power is within the limit curve or the first or last calcu-
lation interval is calculated.

• Element switchOff: powermanager sets this bit if the load needs to be deactivated.

• Element switchOn: powermanager sets this bit if the load needs to be activated.
The bits are triggered based on the defined limit curve.
The switching state is queried in reaction plans.
For more information on reaction plans, see 6.4.1 Overview of Reaction Plans.

8.7
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Alerts and Warnings
An alert or a warning can be optionally configured for each switching bit. Configure it when defining the limit
curve.

Load Monitoring

To call load monitoring:
² Ensure that the Standard view is activated.

If Standard view is not activated, click  to activate the Standard view.

² In the project tree, click the load monitoring data source.
The Overview tab opens.

Configuring Load Monitoring

powermanager manages load monitoring as a device. It is attached to an area or sector in the project tree. The
command to create a load monitor is in the shortcut menu of the project tree.
To create a load monitoring device:
² Right-click the system node.

² Click Create device > Monitoring functions > Load monitoring.

² Assign a name to the load monitoring device. The name must not contain any spaces, special characters,
or diacritical marks.

² Click Create.

² Creation of the new device can take some time depending on the device and the project size.
The load monitor is visible in the project tree, but it is not configured. The Configuration view is launched
automatically.
For more information, see 8.7.5.1 Overview of Configuration.

View

Overview Tab
The Overview tab shows the consumption development of the monitored datapoint in the current tariff
interval:

• Actual energy consumption

• Forecast energy consumption

• Timing

• Correction value
The values are shown as:

• Percentage values in a graphical bar chart

• Absolute numerical values.

8.7.2
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[sc_pm_overview, 1, en_US]

Figure 8-11 Overview Tab

Bar Chart
The bar chart contains the following components:

• Consumption: The blue Consumption bar shows the actual percentage energy consumption in the
current tariff interval. The reference value is 100 % of the setpoint.
The percentage value of the consumption with respect to the setpoint is displayed in the text box and
indicated in the bar chart.

• Forecast: The Forecast bar shows the forecast of the consumption in the current tariff interval.
The forecast is updated for each calculation interval.
The percentage value of the forecast is displayed in the text box and indicated in the bar chart.

• Interval: The Interval field displays the calculation intervals.
The first value specifies the last completed calculation interval. The second value shows the number of
calculation intervals into which the tariff interval is subdivided.
The yellow time bar shows the timing in the current tariff interval. The bar ends at the 100 % when the
last calculation interval is reached.

Correction value: The Correction value field shows the positive or negative power correction value. Use this
value to adjust the actual power to its optimal value so that it corresponds to the setpoint.

Energy Profile Tab
The Energy profile tab displays the deviation between actual energy consumption and rated energy
consumption during the current tariff interval.

8.7.4.2
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[sc_pm_energyprofile, 1, en_US]

Figure 8-12 Energy Profile Tab

Graphic
The Energy profile tab contains the following information:

• The X-axis denotes the time curve of the tariff interval.

• The Y-axis denotes the imported energy.

• The black trend line denotes the consumption setpoint. It is always linear.

• The colored trend line shows the actual consumption.
The trend line is either blue, red, or magenta.
– If the actual consumption is below the setpoint, then the trend line is blue. This indicates a positive

correction power in the current calculation interval. You can activate extra power without exceeding
the setpoint.

– If the actual consumption is above the setpoint, then the trend line is red. This indicates a negative
correction power in the current calculation interval. Switch off some power to bring the consump-
tion to the setpoint.

– If powermanager encounters an invalid value during the calculation interval, then the trend line is
magenta.

Trend
The Trend tab displays the power demand of the monitored load during the current day and the previous day.
The trend of the previous day is not displayed if no data is available for the previous day or if the calculation
interval length has changed with respect to the previous day.
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[sc_pm_dailytrend, 1, en_US]

Figure 8-13 Trend Tab Display

The Trend tab displays the following information:

• The X-axis shows the tariff intervals for a 24 hour time range.

• The Y-axis shows the power in kW.

• The orange horizontal axis shows the power setpoint.

• The blue column shows the actual output of one tariff interval.

• The red column shows the tariff interval with the highest power demand during the day.

• The magenta column shows the tariff intervals with invalid values.

Correction Value
The Correction value tab shows:

• Correction power values of the calculation intervals during the current tariff interval

• Parameterized limit curve
The limit curve defines the threshold of the correction power. Switching is only recommended if the
actual power exceeds the limit curve. The purpose of limit definition is to smooth brief power spikes, thus
reducing the number of switching recommendations.

• Alert notifications for Switch on, Switch off, No switch and Soon are displayed with LED controls.
Superpositioning of the 2 curves results in the calculation intervals with the switching recommendation that
takes effect.

8.7.4.4
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[sc_pm_correctionvalue, 1, en_US]

Figure 8-14 Correction Value Tab

Limit Curve
The limit curve shows the defined positive and negative limits within which no switching recommendation is
given.
The limit curve can be configured in device engineering view, on the Limit curve tab.
The Limit curve tab displays the following information:

• The X-axis shows the time curve of the tariff interval.

• The Y-axis shows the correction power in kW.

• The colored bars show the correction power of the calculation interval.
– The green bars above the X-axis indicate positive correlation power in the calculation interval.
– The red bars below the X-axis indicate negative correlation power in the calculation interval.

Configuration

Overview of Configuration
A load monitoring unit created in the project tree monitors one data point.
Following configurations are necessary for the load monitoring unit to start monitoring:

• Selection of the data point

• Definition of the tariff interval and of the calculation interval

• Definition of the setpoint, either constant or variable, during the day

8.7.5
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• Definition of the limit curve

• Definition of the response
To access the Configuration view (Parameterization tab and Limit curve tab) for a load monitoring device,
right-click the device and click device engineering. Device engineering opens automatically when you create
a configuration.
After making the configuration changes, click the Save button to confirm the changes.
Any tariff interval running at this time is stopped and marked as invalid.

ii
NOTE
Ensure that you use only positive values for load monitoring. Using negative values results into display
problems.

Parameterization Tab

[sc_pm_parameterization, 1, en_US]

Figure 8-15 Parameterization Tab
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Monitored Datapoint
The Datapoint selection area enables you to select the data source for Power or Energy that you want to
monitor via the radio button options.
Ensure that you provide the appropriate information in the following list boxes to select the data source that
you want.

Click  to select the respective data point for Power or Energy directly from the project tree structure.

Interval Settings
Use the Interval settings area to define the length of the tariff and calculation intervals.

• Tariff interval: Define the tariff interval in minutes and seconds.

• Calculation interval: Define the calculation interval in minutes and seconds.
While defining the tariff and calculation intervals, ensure that:

• The tariff interval is integrally divisible by the calculation interval.

• 60 minutes are integrally divisible by the tariff interval.

• The tariff interval lasts a maximum of 60 minutes.

Limit Settings
Assign a constant or variable setpoint to the monitored data source.
Set a schedule for a variable setpoint.

• Guideline: Select Guideline to assign a constant setpoint to the monitored data source.
Selecting this option activates the Setpoint field.

• Setpoint: Define the momentary power in kW in the Setpoint field. The smallest calculated setpoint is 1
kW.

• Timetable: Select Timetable to assign a variable setpoint to the monitored data source.
The Edit button is activated after you select this option.
Click Edit to prepare a schedule for a variable setpoint.
For more information on creating schedules, see 8.7.5.3 Schedule.

Schedule

Objective
For each tariff interval during a day, a schedule defines the rated power of the monitored datapoint. Thus, the
planned rated power varies in intervals and can increase or decrease at various times in a day.
The system calculates the number of tariff intervals. The interval length in the schedule is prepared accord-
ingly. For example, if a 15-minute tariff interval is configured, the schedule contains 96 intervals.
A schedule applies to any selected calendar period. For all days without an assigned individual schedule, the
system accesses a default schedule.
The time difference between summer and winter time is not considered in the schedule. Configure the
changeover days separately.
To create or edit schedules, explicitly activate an edit mode. This prevents inadvertent parameterization errors.

Path and File Name
The system subdivides consecutive calendar periods into days and creates a file in the following directory:
<project_name>\data\EC_TimeTable
The format of the name assigned to the file is:
<load_monitor_name>_YYYYMMDD.csv
The file containing the default schedule is named:

8.7.5.3
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<load_monitor_name>_default.csv

Opening the Edit Schedule Window
To open the Edit Schedule window:

• In the Setpoint area, select the Timetable option in device engineering.

• Click Edit.
If a schedule exists, it is used automatically and the table is filled with it. Else, a message appears.

Edit Schedule Window
The Edit schedule window enables you to create and edit timetables. You can define the schedules for a
prolonged period and store them for each day.

[sc_pm_edit_schedule, 1, en_US]

Figure 8-16 Edit Schedule Window

The schedule table has the following columns:

• No.: The nth tariff interval in the course of the day. The system calculates and specifies the number of
tariff intervals.

• Time: Start time of the tariff interval.

• setpoint: Power setpoint on the monitored datapoint in the tariff interval.
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The Action area has the following boxes:

• View file: This option is selected by default when you open the Edit Schedule window. It enables you to
view the current schedule in the table.
Also, only the starting point of the schedule is activated in the Period area when you select this option.

• Save/edit file: Select this option to edit the schedule.
Selecting this option activates both the starting point and ending point of the schedule in the Period
area.
Additionally, you can edit the setpoint in the Setpoint column of the schedule table.

Period Area
In the display mode, only the top date boxes Year, Month, and Day are open. The visible schedule is assigned
to the selected calendar date.
In the edit mode, the bottom date fields are additionally open. The top and bottom calendar dates specify the
calendar period to which a schedule is assigned. The top calendar date specifies the start day and the bottom
calendar date specifies the end day.

Creating a Schedule
To create a schedule:

• Check whether an individual schedule exists for the target period.
The schedule table has the heading Default schedule when the default schedule is visible. The table
does not have a heading when an individual schedule is assigned to the currently selected day.

• Select Save/edit file.

• In the Period area, define the time range for which the schedule is valid.

• Set up the schedule in the table. Define the power setpoint of the monitored datapoint for each tariff
interval.
Empty Setpoint cells in the table assume the value from the Setpoint cell above. If you want to apply a
constant setpoint through the entire day, define the setpoint only for the first interval at the start of the
day.
If the Setpoint cell of the first tariff interval at the start of the day is not filled, the value entered on the
Parameterization tab applies.

• Click Apply to confirm the changes.

Creating a Default Schedule
If no default schedule exists, powermanager shows an error message when you open the Edit Schedule
window.
To create a default schedule:

• Create a schedule in the Edit Schedule window.

• After you create a schedule, go to <project_name>\data\EC_TimeTable.

• Select the new schedule file.
The file name format for the new file is: <load_monitor_name>_YYYYMMDD.csv.
The date YYYYMMDD in the file name corresponds to the date value in the dialog.

• Replace the date YYYYMMDD with default.
Therefore, the new file name has the format: <load_monitor_name>_default.csv.

Click the New button in the Edit table area to empty all setpoint fields of the currently selected schedule.
This action is only possible in the display mode. To fill the blank table, switch to the edit mode.
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Limit Curve Tab

Objective
The limit curve defines the threshold of the correction power. Switching is only recommended if the actual
power exceeds the limit curve. The purpose of limit definition is to smooth brief power spikes, thus reducing
the number of switching recommendations.

[sc_pm_limitcurve, 1, en_US]

Figure 8-17 Limit Curve Tab

Positive and Negative Limit Correction Power
Define the upper and lower envelopes for the positive and the negative thresholds of the correction power on
the Limit curve tab.
Define the following fields:

• Alarming
Select whether you want the limit curve to be defined according to power (in kW) or the percentage of
the setpoint.

• Maximum correction value
The maximum correction value determines the range of value of the correction power displayed in the
diagram.
Ensure that the limits of the interpolation points P1 to P4 do not exceed the maximum correction value.

• Envelope 1
Define the threshold for the positive correction power in the Envelope 1 area.

8.7.5.4
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• Envelope 2
Define the threshold for the negative correction power in the Envelope 2 area.

• P1, t1 to P4, t4
Define the interpolation points of the limit curve in these boxes under the Envelope 1 and Envelope 2
areas.
You can see the preview of the limit curve at the bottom of the Limit curve tab.

Alerting
Activate the alerts in the Alerting area of the Limit curve tab.
The internal switching bits of the system trigger the alerts sending. In turn, which switching bits the system
sets depends on the defined limit curve.
There are four options available in the Alerting area:

• No switch
Select this option to receive an alert/warning whenever the switchNo switching bit is set.
You do not need to connect or disconnect the load.

• Switch off
Select this option to receive an alert/warning whenever the switchOff switching bit is set.
Disconnect the load.

• Switch on
Select this option to receive an alert/warning whenever the switchOn switching bit is set.
Load can be connected.

• Soon
Switch off the load because the percentage threshold in the Limit % field is reached.
The value in the Limit % field refers to the energy consumption setpoint in the tariff interval. 100 %
corresponds to the setpoint.
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Manual Measuring Devices

Overview of Manual Measuring Devices

Several electrical subsystems within non-residential buildings or small and medium industrial plants consist of
measuring devices, which are either not capable of or restricted from communicating with any external
systems such as powermanager. The manual measuring device feature enables you to manually add data from
an external device that cannot be integrated with powermanager.

Runtime View

The runtime view for manual measuring devices shows the following tabs.

Overview Tab

[sc_pm_overviewtab, 1, en_US]

Figure 8-18 Overview Tab

The Overview tab displays the measured values entered for the selected devices. This tab shows a maximum
of 50 previous values. In order to add new measured values for the device, switch to Input view. For more
information, see 6.3.1 Overview.

Energy Tab

[sc_pm_energy_runtime, 1, en_US]

The Energy tab displays the energy consumption details. This tab enables you to compare the energy
consumption between 2 different time periods.

8.8

8.8.1

8.8.2
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For more information, see 6.1.7 Energy.

Device Engineering

After adding the device to powermanager, on the Unit+Overflow tab, define the following parameters:
Unit: The measurement unit for the data entered for the device. You cannot change the unit after you save
the configuration.
Overflow: The maximum acceptable measured value.

ii
NOTE
Ensure that the overflow value is greater than or equal to 0.
The overflow value cannot be negative.

[sc_pm_devengg, 1, en_US]

Figure 8-19 Unit+Overflow Tab for Manual Measuring Device

Archiving
By default, powermanager creates an archive of the measured values entered for a device. Each archive stores
measured values upto 13 months. After the archive is full, it is closed and you cannot edit the archive.

Reporting
You can generate the Cost Center report and the Energy report for manual measuring devices.

8.8.3
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Expert Option

Range of Functions

The Expert option offers a Graphics Editor (GEDI). Use GEDI to create and display new panels.
Expert mode also offers a script language to customize your adaptations to the product.
For more information, see Graphics Editor (GEDI).
You can display the measuring devices and their measured variables, created in the project tree, in the
graphics pictures.

ii
NOTE
A separate license is required to enable use of the Expert option. For more information, see 2.3.2 License
Packages.

To open the graphics editor, right-click the project tree root in the device tree and then click Tools > Graphics
Editor. This option is disabled without a valid license.

Device Support

In GEDI, the pm tab under All Objects contains the device types of powermanager.

Device Information

PAC 1200

[sc_PAC1200_DeviceInfo, 1, en_US]

Display:

• Device name

• Three measured values

• Communication status

• Alert status/sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)

PAC 1500

[sc_PAC1500_DeviceInfo.tif, 1, en_US]

8.9

8.9.1

8.9.2
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Display:

• Device name

• Three measured values

• Communication status

• Alert status/sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)

PAC1651

[sc_PAC1651_DeviceInfo, 1, en_US]

Display:

• Device name

• Three measured values

• Communication status

• Alert status/sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)

PAC1661

[sc_PAC1661_DeviceInfo, 1, en_US]

Display:

• Device name

• Three measured values

• Communication status

• Alert status/sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)
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PAC1665

[sc_PAC1665_DeviceInfo, 1, en_US]

Display:

• Device name

• Three measured values

• Communication status

• Alert status/sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)

PAC1682

[sc_PAC1682_DeviceInfo, 1, en_US]

Display:

• Device name

• Three measured values

• Communication status

• Alert status/sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)

PAC2200

[sc_PAC2200_DeviceInfo, 1, en_US]

Display:

• Device name

• Three measured values
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• Communication status

• Alert status/sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)

PAC 3200

[sc_PAC3200_DeviceInfo.tif, 1, en_US]

Display:

• Device name

• Three measured values

• Communication status

• Alert status/sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)
After you insert the object, the Properties panel opens. You can assign a device (DPE) to the graphics object.
Right-click the graphics object to select the displayed measuring points at runtime.

PAC 3200T

[sc_pm_3200, 1, en_US]

Display:

• Device name

• Three measured values

• Communication status

• Alert status/sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)
After you insert the object, the Properties panel opens. You can assign a device (DPE) to the graphics object.
Right-click the graphics object to select the displayed measuring points at runtime.
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PAC 4200

[sc_PAC4200_DeviceInfo.tif, 1, en_US]

Display:

• Device name

• Three measured values

• Communication status

• Alert status/sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)
After you insert the object, the Properties panel opens.
You can assign a device (DPE) to the graphics object. Right-click the graphics object to select the displayed
measuring points at runtime.

PAC5100

[sc_P850_DeviceInfo, 1, en_US]

Display:

• Device name

• Three measured values

• Communication status

• Alert status/sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)
After you insert the object, the Properties panel opens.
You can assign a device (DPE) to the graphics object. Right-click the graphics object to select the displayed
measuring points at runtime.
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PAC5200

[sc_P855_DeviceInfo, 1, en_US]

Display:

• Device name

• Three measured values

• Communication status

• Alert status/sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)
After you insert the object, the Properties panel opens.
You can assign a device (DPE) to the graphics object. Right-click the graphics object to select the displayed
measuring points at runtime.

P850

[sc_P850_DeviceInfo, 1, en_US]

Display:

• Device name

• Three measured values

• Communication status

• Alert status/sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)
After you insert the object, the Properties panel opens. You can assign a device (DPE) to the graphics object.
Right-click the graphics object to select the displayed measuring points at runtime.

P855

[sc_P855_DeviceInfo, 1, en_US]
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Display:

• Device name

• Three measured values

• Communication status

• Alert status/sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)
After you insert the object, the Properties panel opens.
You can assign a device (DPE) to the graphics object. Right-click the graphics object to select the displayed
measuring points at runtime.

3WL

[sc_3WL_DeviceInfo.tif, 1, en_US]

Indicator:

• Device name

• Switch status (not ready/ON/OFF/TRIPPED)

• Communication status

• Sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)
After you insert the object, the Properties panel opens.
You can assign a device (DPE) to the graphics object. Right-click the graphics object to select the displayed
measuring points at runtime.

3WL10

[sc_3WL10_DeviceInfo, 1, en_US]

Indicator:

• Device name

• Switch status (not ready/ON/OFF/TRIPPED)

• Communication status

• Sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)
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3VA

[sc_3VA_DeviceInfo, 1, en_US]

Indicator:

• Device name

• Switch status (not ready/ON/OFF/TRIPPED)

• Communication status

• Sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)
After you insert the object, the Properties panel opens.
You can assign a device (DPE) to the graphics object. Right-click the graphics object to select the displayed
measuring points at runtime.

3VL

[sc_3VL_DeviceInfo.tif, 1, en_US]

Indicator:

• Device name

• Switch status (not ready/ON/OFF/TRIPPED)

• Communication status

• Sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)
After you insert the object, the Properties panel opens.
You can assign a device (DPE) to the graphics object. Right-click the graphics object to select the displayed
measuring points at runtime.

3VL COM21

[sc_3VLC21_DeviceInfo.tif, 1, en_US]
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Indicator:

• Device name

• Switch status (not ready/ON/OFF/TRIPPED)

• Communication status

• Sum alert

• Device type (with background color)

• DP does not exist in the database (device is deleted without adapting the graphics)
After you insert the object, the Properties panel opens.
You can assign a device (DPE) to the graphics object. Right-click the graphics object to select the displayed
measuring points at runtime.

Generic Modbus Device

[sc_GMD_DeviceInfo.tif, 1, en_US]

The display visualizes the values that you select, analogously to the PAC devices.
After you insert the object, the Properties panel opens.
You can assign a device (DPE) to the graphics object. Right-click the graphics object to select the displayed
measuring points at runtime.

General Switch

[sc_GeneralSwitch_DeviceInfo.tif, 1, en_US]

The display visualizes the statuses in graphical and textual form.
You can parameterize the following functions in the Properties panel of the switch:

• Switch ON

• Switch OFF

• Switch Tripped

• Switch Withdrawn

• Switch Close

• Switch Open
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Configuration of the Device

Object/device in the panel view.
Define all the settings here.

Object/device in the QuickTest view.
The previously configured object shows the values
read from the system in the QuickTest view.
If you move the mouse over the object, a tooltip
opens in which the set parameters and the device
type are displayed.

For more information on the functionality of the graphics editor, see Graphics Editor (GEDI).
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Distributed Systems

Overview of Distributed Systems

Distributed systems enable connection of two or more autonomous powermanager systems via a common
network. Each subsystem of a distributed system can be configured either as a single-station system or a
multi-station system. Each system can process and display values and alerts of other systems. Access is only
possible if there is a permanent network connection between the systems.
Within the powermanager, the Distribution Manager is the interface to the other systems.

[sc_DistributionManager, 1, en_US]

Figure 8-20 Distribution Manager

Parameterization of Distributed Systems
You can only operate distributed systems with a separate license. Each powermanager system that you want
to operate within a distributed system must have an appropriate license.
For more information on the type of licenses, see 2.3.2 License Packages.
Distributed systems are parameterized by specifying fewer items in the Config file of your project.
For more information, see 8.10.6 Configuration File for Distributed Systems.
Define the interconnections between all the systems in the distributed system in the configuration files of the
individual systems via the distPeer item.
The following entries exist in the powermanager's configuration file. The entries are examples. Adjust them
accordingly.

8.10

8.10.1
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[general]

distributed = 1

[dist]

#Establishing connection to Host1 with system number 1

#distPeer = "Host1" 1

#Establishing connection to Host2 with system number 2

#distPeer = "Host2" 2

#Establishing connection to Host3 with system number 3

#distPeer = "Host3" 3

#Establishing connection to Host4 with system number 4

#distPeer = "Host4" 4

System Names and System Numbers
Corresponding to the distpeer entries in the configuration file, applicable system names, and numbers are
assigned to the project databases. A system name and a system number can only be used once within a
system network.
The system name and number are assigned when creating a project in the project administration.
The powermanager project have a predefined system name (System1) and system number (1). If you want to
connect multiple projects having the predefined system name and system number, change the system name
and system number of the individual projects.
Use the following command to change the system name and number:

ii
NOTE
Stop the project before you run the following command.

ii
NOTE
powermanager saves the individual datapoints including the system name in the database. If the system
name is changed, it is recommended to reconfigure the datapoints in KPI, Reports (Basic and Advanced),
and Custom panels.

WCCOAtoolSyncTypes –system <system_number> <system_name> -proj <project_name>
Here, <system_number> is the new system number that is assigned to the project,
<system_name> is the new system name that is assigned to the project,
<project_name> is the name of the project.
If you want to run the distributed system as a single-user system again, then set the system number back to 1.

Example
If the system number is 1, the system name is System, and the project name is powermanager, then run the
following command:
WCCOAtoolSyncTypes –system 1 System -proj powermanager
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Updating Archive Structure
To ensure that all the systems are able to read the updated report data, update the archive structure.
To update the archive structure:
² In the menu bar, click Tools > Report and open the excel Report window.

² In the excel Report window, click the Add-Ins tab.

² In the Add-Ins tab, click Report > Configuration > Archive Structure.

² Enter the valid password.
The default password is erAdmin.

² Click OK.

² Click Yes on all subsequent dialogs.

Basics of Distributed Systems

Distributed systems in powermanager enable you to connect two or more autonomous powermanager
systems via a network. You can configure each subsystem of a distributed system either as single-station
system or multiple-station system in each case redundant or not redundant. A subsystem is a server on which
an Event manager is running (it is not necessarily a complete project). In a redundant system, both redundant
running servers are considered as a single system.
The distributed systems in powermanager are intended for the following purposes:

• Connecting several standalone powermanager systems.

• Increased performance (increase of the entire performance and number of the DPEs via load sharing on
several computers).

• Creating one central system and unoccupied subsystems.
Each system can process and display data (values and alerts) of other systems. You can access online values,
alerts, and history of each system using distributed systems in powermanager. When you access remote DPEs
the datapoints of the subsystems are not copied to the local system. Therefore, the datapoints are not multi-
plied and you can only access the system when a connection to this specific system exists.
The distribution manager (Dist manager) builds the interface to other systems. The Dist manager is respon-
sible for the communication with the parameterized subsystems. Therefore, for the proper functionality of the
distributed systems in powermanager, add the Dist manager to the console and start it.
The distributed systems are parameterized easily when creating a project using a wizard or by specifying few
entries in the config file of your project.
For more information, see:
Create a distributed system
8.10.6 Configuration File for Distributed Systems
The following figure shows a possible structure of several powermanager systems connected to each other.

8.10.2
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[sc_DistributedSystems, 1, en_US]

Figure 8-21 Distributed Systems with powermanager

• The figure shows a distributed system consisting of a redundant system (System 1), a multiple-station
system (System 2) and, a single station system (System 3).

• Each system has its own process connection (PLC, DDC, telecontrol head).

• All process data is mapped to datapoints local (in the own system).

• In a plant display, you can show datapoints of the local as well as of the connected systems.

• The network connection between the systems is redundant.

• You can connect 2048 systems.

• A weighting can be assigned to errors occurring in a subsystem. You must parameterize the weighting,
that is, how grave the error is for the specific system. Also, a possible loss of a connection to a subsystem
has an assigned error weighting (like a PLC breakdown).
For more information on the parameterization of weighing for error cases, see System overview panel for
distributed systems.

Advantage of Distributed Systems in powermanager

• Flexibility and scalability

• Increased performance: Parallel processing, load sharing

• Fault tolerance: Availability increase of the complete system

• Parameterize complete identical systems (datapoint types and datapoints) only once. For example, create
the panels and reference the datapoints with $ parameters only once.
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Prerequisites and Installation

Prerequisites

• Complete installation of powermanager.

• An appropriate license for distributed systems.

• The configuration of the languages (it is defined when creating the project) on all systems is similar.

• The access rights are evaluated in the network of a distributed system. Create the same users with same
rights on all systems.

ii
NOTE
Use the following connect and query functions to query datapoint values: :dpConnect(), dpQuery(),
dpQueryConnectAll(), dpQueryConnectSingle(), isAnswer(), and isRefresh().
For more information, see Control Functions.

Installation
Install powermanager on all the systems in a distributed system.
For more information on installing powermanager, see Installation Under Windows.
For more information on configuration of a distributed system with powermanager, see Creating a distributed
system.

Application Planning and Hints on Distributed Systems

Planning of Distributed Systems
The first thing to consider when planning a distributed system, is the topology. Different structures are real-
ized by connecting each system with the other. The topology of a distributed system is described in the config
file (see 8.10.6 Configuration File for Distributed Systems).
Use the following questions to formulate the requirements of the distributed system:

• How many subsystems does the complete system consist of? A subsystem is a server with an Event
manager. In a redundant system, both servers of the redundant pair are counted as one system. Remote
stations are not considered.

• Are commands transferred to the remote systems or is the data of these systems only displayed?

• Is there are a system which is a higher-level system than the other systems. Should the subcontrol rooms
be able to communicate with each other. Which things do you want to handle from the main control
room?

• Are there systems with equal rights, which control one or more systems (manned and unmanned
stations)?

• Should only values of other systems be available on one system (visualization in specific panels, overview
panels) or should the process images of remote systems also be displayed?

• Should parameterization be possible on all systems or only on one system?

• In which systems should the collected data be evaluated (reporting, archiving, processing)?

• Which systems are used at which time and who is using the systems?

• Should the commands between the single systems be controlled?

• Which alerts should be displayed in which systems? Who (which user in which system) must acknowl-
edge them.
You can parameterize the alert classes differently on each system in a distributed system.

• Which bandwidth (capacity of the network connection) is available for connecting single systems?

8.10.3

8.10.4
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Hints and Restrictions When Working with Distributed Systems

Hardware
Following hardware components are recommended for distributed systems:

• Ensure that the network connections between the systems are permanent connections (leased lines).
powermanager does not support switched lines directly. Switched lines are only possible when power-
manager cannot detect that it is a switched line.
Therefore, build the connection independently using the router when data is transferred via the line and
the connection is released after the time-out. If you use switched lines Siemens AG recommends using
hardware routers of Cisco.

• For the construction of computers in distributed systems consider the number of datapoints and
dynamics of the local system and the part of locally used datapoints of other systems. Also, consider the
additional communication overhead.

• For bigger applications (projects with > 20000 DPEs) computers with dual processors are recommended.

Archiving/Reporting
You need a network connection to access historical data of other systems.
The data is located on the particular source systems by default.
If historical values are not saved in the source system, create the datapoints in the system in which the histor-
ical values are saved. Transmit the values via a runtime script with registration on these datapoints. However,
this is not recommended because problems with data and correction values arise.

Rights
If a function is used from several systems, implement the specification and switching of commands manually
(which user interface to use the function on which system at a particular time). All other user interfaces/users
normally do not have any rights in this case.
The access rights are also evaluated in the network of a redundant system. Therefore, it is necessary to create
the same users with the same rights on all systems.

Functions

• For enhanced performance, ensure that CTRL functions avoid intensive calculating and system-wide
queries. Also, large number of dpConnect() calls on the datapoints of a remote system overload the
computer and the network.

• If you use dpConnect() to access datapoints, ensure that the datapoints are located on the same system.

• If you use dpGet() or dpSet() to query or set several datapoints, ensure that the datapoints are located on
the same system.

• The dpGet() call works only on the local system. If you use dpGet() call to query remote systems, the log
viewer shows the following error message:
WCCOAui (1), 2007.09.26 14:11:19.266, PARAM,SEVERE, 175, this request cannot
address more than one system, DP: dist_789:ExampleDP_Arg1.:_original.._value

WCCOAui (1), 2007.09.26 14:11:19.266, CTRL, WARNING, 76, Invalid argument in
function,

WCCOActrl (2), 2007.09.26 14:24:54.887, PARAM,SEVERE, 175, this request
cannot address more than one system, DP: dist_789:ExampleDP_Arg1.:_orig-
inal.._value

WCCOActrl (2), 2007.09.26 14:24:54.887, CTRL, WARNING, 76, Invalid argument
in function, dpGetAll.txt Line: 14, dpGet

• All nodes of a distributed system must contain the same number of languages.
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• You cannot set the following parts of the General config from a UI on the remote system:
Description, format, unit, and alias
If you want to set these parts do it via a control datapoint and an easy runtime script that runs the
command local. However, the configs can be parameterized via a remote UI (VISION, PARA, GEDI) on
each system via the network.

• The functions dpCreate(), dpDelete(), dpGetAlias(), dpGetAllAliases(), dpGetDescription(), dpGetAllDe-
scriptions(), dpGetFormat() work cross the system boundaries. When you use these functions for queries
on remote systems, specify the system name for the datapoint.

• You can create, change, or delete the datapoints in Module PARA only on the local system.

• The configurations (saved default settings) of event and alert panel, trend, group datapoints, and so on,
are saved on the system on which the configurations were created.
For more information, see Alert and event panel.

• Sum alerts (alerts) cannot handle alerts from 2 or more different systems simultaneously.

• The initialization of the Dist Manager and its connection establishment takes longer than the start of the
first user interface or runtime script (CTRL) when starting the system. If these build connections (dpCon-
nect() with hotlinks) to datapoint elements on remote systems the connection is not established until the
Dist Manager starts. Else, the datapoints of remote systems are identified as not available.

• If you use a dpGet() call on a remote system and the Dist connection does not exist, the dpGet() call
returns 0 (OK). Use getLastError() to query the error.
GetLastError() returns the following error message: Message could not be sent, DP:
System1:ap.:_original.._value, MAN: (SYS: 1 Dist -num 1 CONN: 1), Could not
send message DP_MSG_SIMPLE_REQUEST #326.

ii
NOTE
For more information on functions, see Control Functions.

SQL Queries

• You cannot run SQL queries on two or more systems simultaneously. Also, the alert and event panel
divide such queries in the distributed systems into several queries.

• To run queries, use the appropriate SQL keyword (= REMOTE) across the system boundaries. Use the
keyword REMOTE ALL to query all systems.
For more information, see:
– SQL keyword
– SQL panel

Driver Parameterization
The parameterization of driver datapoints in distributed systems is only allowed on the local system.

Principle and Functionality

A distributed system consists of two projects on different computers with different or same operating system.
The distributed powermanager systems are connected the Dist manager (WCCOAdist). The Dist manager
builds the logical connection to several Dist managers of other powermanager systems. There is one Dist
manager per system and it is responsible for the connection to all other systems.
The redundancy is an exception. In a redundant system, a Dist manager runs on each redundant computer.
The data of other systems is accessed like the data of the local system. Datapoints of remote systems are not
copied to the local system. Thus, you can only access the remote data when the connection to the specific
system exists (when the connection to the subsystem is lost, queries are not possible anymore). Only active
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queried information is transferred (that is, replies to queries that were executed on a subsystem via dpGet(),
dpGetPeriod(), dpConnect() calls).
The Dist Manager is responsible for the following tasks in a distributed system:

• Connection establishment to other powermanager systems as well as monitoring of the connections.

• Exchange of the DP identification on all systems.

• Transmission of messages.
Each system in a distributed system must have a unique system name and a unique system number. The
manager number of the Dist Manager is assigned automatically when the Data Manager starts. The manager
number also represents the system number of the particular system.
The DP identification of the systems is exchanged when a subsystem and the Dist Manager start. For perform-
ance reasons, each DP of a system is accessed in powermanager internal via a number instead of the name.
This number is the DP identification (= Id). The names are converted internal to IDs via tables.
The following information is used when converting the names:

• Datapoint types: There is an internal table per DPT. This table contains the name of datapoint types and
elements.

• Datapoints: There is an internal table with the name per DP.

• Datapoint elements: There is an internal table per DPE. The table contains the description, unit, format,
and alias.

• System name

• Config and attribute names: The config and attribute names are fixed. You cannot change them in the
project.

In bigger projects, the DP Id is bigger, with size up to several MBs. The access to DPs (for example, with CTRL)
is not possible without this Id.
For more information, see DP identification.

Datapoints/System Name
The first part of each datapoint identifier (datapoint name) in powermanager contains the system name
(default is the local system name). All datapoints within the system contain the same system name. Therefore,
each involved system must have a unique system name and a unique system number. Datapoints of remote
systems are addressed using the system name and a colon.

Example
"System3:ExampleDP_Trend1.:_original.._value"
If you refer to a datapoint in a script (UI, CTRL) without a system name, powermanager uses the local system
name. All scripts and all panels that process or display data of other systems must use complete datapoint
identifiers.

Example
The following function call in a script only returns datapoints (that match the pattern) of the system where the
function was called:
dpNames("*","ExampleDP_Bit");
The following call in a script returns the datapoints (that match the pattern) of all systems:
dpNames("*:*","ExampleDP_Bit");

ii
NOTE
The system name is not used hard coded in project-specific scripts. In the datapoint lists which are
imported via the ASCII manager, specify the datapoint identifiers without system name, although the data-
points are imported to other systems.
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The datapoint types and datapoints must be different in the subsystems. The DP identification is exchanged
when the connection to other systems is established via the Dist manager. Therefore, you can access all
remote DPEs (for example, with dpGet(), dpGetPeriod(), dpConnect(), dpSet(), and so on). However, the data-
points of remote systems are not copied to the local system. Therefore, the datapoints are not multiplied and
you can only access the datapoints of a subsystem when a connection to the system exists. You can use the
DPEs on the remote systems like the local DPEs (the connected systems and DPTs/DPEs are visible in the PARA
module).
If the connection to a subsystem is lost, this is visible via the invalid bit of the original value for the attributes
_original.._invalid and _original.._bad as well as via the online value for the attributes _online.._invalid and
_online.._bad . For more information, see _original and _online.
Query these attributes to know the connection status. This means that all dpConnect() functions with reply
(second parameter is TRUE) to a subsystem return a hotlink with a null value and the status bits are set so that
the value is marked as invalid. Furthermore, the dpConnects with a reply return an error (can be queried via
getLastError() ) with code 144. This applies also to the functions dpQueryConnectAll() and dpQueryConnect-
Single().

Topology of a Distributed System
You can structure the distributed systems in powermanager hierarchically. One system is on the top of the
hierarchy, the further systems are located in the levels below. The system on the top is the server and the
systems below are the clients. This structure simplifies the parameterization of distributed systems. The
following figure shows a distributed powermanager system in hierarchical form.
In the figure above, the System 1 is server for all other systems and accepts connections of these systems.
System 2 connects to System 1 and is the server for the systems below (system 4 and system 5).

[sc_Hierarchical_structure, 1, en_US]

The advantage of this kind of structure is the parameterization of distributed systems with this configuration.
When the parameters are set, it is sufficient to specify the connection in one direction. System 1 is defined first
under the Settings of the new own project via Creating a distributed system with the wizard. The second
step is to create the further subsystems and parameterize their connections to other systems. This is made in
the wizard via the connected systems part. For more information, see Example of a redundant distributed
system.
If the connection to a system is built, it is bidirectional and the systems at the ends of the connection see each
other (if the connection from system 4 to system 2 is established both can communicate with each other and
are visible in the system overview panel). This kind of structure ensures that new lower-level systems are
included in the topology restarting the server (Dist Manager). For information on how configuration of a hier-
archical structure looks like in the config file, see 8.10.6 Configuration File for Distributed Systems.
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ii
NOTE
Connect the powermanager systems that exchange messages with each other directly. The messages are
not routed (for example, as shown in the preceding figure, the system 4 cannot exchange any messages
with the system 3). If the connection to a system is built once, it is bidirectional and the systems at the
ends of the connection discover each other. Therefore, the parameterization of the connection in one
direction is sufficient.

Forwarding of Messages
The following paragraphs describe the messages and how they are forwarded (queries on subsystems) in
distributed systems. The following figure displays the principle of distributed systems.

[sc_DistributedSystems2, 1, en_US]

Figure 8-22 Distributed System in powermanager

System 3 is a single station system, system 2 a multiple-station system, and system 1 is configured redundant.
All three systems are connected via the local network. The network connection to the three computers used in
this distributed system can be redundant. The three systems can have their own process connection.
For more information on creating a distributed system using powermanager, see Creating a distributed
system.
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When using this configuration the messages are forwarded as follows (the forwarding of messages is
described using system 3 and system 2):

• A CTRL script is started on system 3. The CTRL script queries values of DPEs on the system 2 (for example,
via dpGet(), dpGetPeriod(), dpConnect()).

• The CTRL manager sends a message to the Event manager of the local system. The Event manager
forwards the message to the local Dist manager. The Dist manager again forwards the message to the
Dist manager of system 2. The Dist manager on the system 2 forwards the message to the local Event
manager that evaluates the message.

• The reply to the query is sent in reverse direction. The Event Manager on the system 2 forwards the
queried value to the Dist Manager. The Dist Manager on the system 2 forwards the value to the Dist
Manager on the system 3 (which sent the original query). The Dist Manager on the system 3 forwards the
value to its Event manager and this forwards it again to the source. The source is the CTRL manager
which processes the reply to the query.

ii
NOTE
If the connection between the Dist Managers of the two systems is lost when dpConnect() registrations
exist. the registrations remain. When the connection is established again, the values of existing registra-
tions are updated for all registered managers.

Each manager in powermanager is identified via the manager type and number, system number, and replica.
Therefore, you can identify each manager in a distributed system. Via this manager identifier, forward
messages to other managers in a subsystem without a direct connection between the source and target
manager. Therefore, when a message is sent, all managers located between the source and target manager
only forward the message and do not deal with the content. In a redundant system (for example, like in the
figure System 1), the messages are forwarded via the Dist Managers of the subsystems in the distributed
system. The Dist Manager of the active computer sends the message to the active Event Manager in case of
redundancy. The split mode in a redundant system is an exception. Since both Event Managers of the redun-
dant system are active in the split mode, determine the active Dist Manager in the system overview panel.

Configuration File for Distributed Systems

This chapter describes the necessary entries that are generated automatically when creating a distributed
project. The entries are set in the config file located in proj_path/config/.
Following entries required for a distributed system:
Entry Possible values Description
[general]
distributed

1 or 0 Mandatory entry. This entry defines a distributed system. A distrib-
uted system requires the distributed = 1 entry in the
[general] section. This value can also be overwritten for indi-
vidual Managers.
[ctrl_1]
distributed = 0
In this case, the Control Manager with the number 1 cannot access
the DPs of other systems (DP identification is not communicated to
this Manager).

[dist]
distPort

Port number.
The default value
is 4777.

Defines the port numbers used by the Dist Manager to accept
connections from other systems. The default value is 4777. Do not
define port numbers if your projects run on different computers.
However, if your projects run on the same computer, define the port
numbers.
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Entry Possible values Description
[dist]
distPeer

- distPeer = "host1[:port1][$host2[:port2]]" system number
Defines the hosts and the system number to which the Dist
Manager establishes the connection as the "client" (the other system
is the "server"). If the other system is redundant, powermanager
separates both host names using $.

Example 1

[sc_2DistributedSystems, 1, en_US]

Figure 8-23 Distributed System Consisting of Two Systems

To create a distributed system containing two different systems connected with each other (System 1 and
System 2) following entries are necessary on the two systems:

System 1 (Host name Host1):

[general]

distributed = 1

#The System 1 does not need any distPeer entry since it is a server for

#the System 2

System 2 (Host name Host2):

[general]

distributed = 1

[dist]
distPeer = "Host1" 1 #Connect to Host1 (of System 1), system number 1

Example 2

[sc_4DistributedSystems, 1, en_US]

Figure 8-24 Distributed System Consisting of Four Systems
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To create a distributed system containing four different systems (System 1, System 2, System 3, and System
4), the following entries are necessary:

ii
NOTE
In this example, System 4 is server for all other systems, System 3 is client to System 4 and server for
System 1 and System 2, System 2 is client to System 3 and System 4, and server for System 1. System 1 is
client to all other systems.

System1 (Host name Host1):

[general]

distributed = 1

[dist]

distPeer = "Host2" 2 #Connect to Host2 (of System 2), system number 2

distPeer = "Host3" 3 #Connect to Host3 (of System 3), system number 3

distPeer = "Host4" 4 #Connect to Host4 (of System 4), system number 4

System2 (Host name Host2):

[general]

distributed = 1

[dist]

distPeer = "Host3" 3 #Connect to Host3 (of System 3), system number 3

distPeer = "Host4" 4 #Connect to Host4 (of System 4), system number 4

System3 (Host name Host3):

[general]

distributed = 1

[dist]

distPeer = "Host3" 3 #Connect to Host3 (of System 3), system number 3

System4 (Host name Host4):

[general]

distributed = 1

Alternatively (all four systems as server and client)
# Alternatively, you can configure all four systems as server and client.
# The advantage of this configuration is that the dist section of the
# config file is the same on all systems. In this configuration all dists
# try to establish the connection to the partner. This does not have any
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# effects in practice
# In this case the config file of all 4 systems could look like the
# following:

[general]

distributed = 1

[dist]

distPeer = "Host1" 1 #Connect to Host1 (of System 1), system number 1

distPeer = "Host2" 2 #Connect to Host2 (of System 2), system number 2

distPeer = "Host3" 3 #Connect to Host3 (of System 3), system number 3

distPeer = "Host4" 4 #Connect to Host4 (of System 4), system number 4
#The entry specifying that a dist tries to connect itself (for example, distPeer = "Host1" 1 on #the computer
1) is ignored.

Example 3
Consider a distributed system containing 7 different systems arranged in a hierarchical structure.
All systems are connected to System 1, System 5 is connected to System 2, and Systems 6 and 7 are
connected to System 3.
In a hierarchical structure, the best solution is that the top-level system is server for all other systems, the
bottom-level systems are clients to all other systems and the medium-level systems are servers for all systems
below and clients to all system above. This has two advantages: you need less config entries, and if you add
lower-level systems, you do not have to change the config file of the higher-level systems (and therefore, you
do not have to restart the higher-level systems).

[sc_7DistributedSystems, 1, en_US]

Figure 8-25 Distributed System Consisting of Seven Systems
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System 1 (Host name Host1):

[general]

distributed = 1
System 1 does not need any distPeer entry since it is a server.

System 2 (Host name Host2):

[general]

distributed = 1

[dist]
distPeer = "Host1" 1 #Connect to Host1 (of System 1), system number 1

System 3 (Host name Host3):

[general]

distributed = 1

[dist]

distPeer = "Host1" 1 #Connect to Host1 (of System 1), system number 1

System 4 (Host name Host4):

[general]

distributed = 1

[dist]
distPeer = "Host1" 1 #Connect to Host1 (of System 1), system number 1
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System 5 (Host name Host5):

[general]

distributed = 1

[dist]

distPeer = "Host1" 1 #Connect to Host1 (of System 1), system number 1

distPeer = "Host2" 2 #Connect to Host2 (of System 2), system number 2

System6 (Host name Host6):

[general]

distributed = 1

[dist]

distPeer = "Host1" 1 #Connect to Host1 (of System 1), system number 1

distPeer = "Host3" 3 #Connect to Host3 (of System 3), system number 3

System7 (Host name Host7):

[general]

distributed = 1

[dist]

distPeer = "Host1" 1 #Connect to Host1 (of System 1), system number 1
distPeer = "Host3" 3 #Connect to Host3 (of System 3), system number 3
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ii
NOTE
Use WCCOAtoolSyncTypes to change the system number and name.
Use the following command to start and stop the project using PVSStoolSyncTypes:

WCCOAtoolSyncTypes -system 3 newSysName -proj "Demo_3.5"
As shown above, specify first the system number and then the system name.
In CONTROL, use the functions getSystemName() and getSystemId() to query the system number and
name:

main()

{

int sysId;

string sysNam;

sysNam = getSystemName();

DebugN("NAME IS:",sysNam);

sysId=getSystemId(sysId);

DebugN("ID IS:",sysId);
}

Summary

Distributed systems in powermanager enable you to connect two or more autonomous powermanager
systems via a network. You can configure each subsystem of a distributed system as single-station system or
multiple-station system, in each case redundant or non-redundant. A subsystem is a server on which an Event
manager is running (not necessarily a complete project). In a redundant system, both redundant running
servers are considered as one system.
Each system can process and display data (values and alerts) of other systems. You can also access online
values, alerts, and history of each system using distributed systems in powermanager. When you access
remote DPEs, the datapoints of the subsystems are not copied to the local system. Therefore, the datapoints
are not multiplied and you can only access the system when a connection to this specific system exists.
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Archive Settings
The archive configuration is modified in powermanager V3.5.

Configurations for New Projects and Projects Updated from Previous Versions
The following tables show the recommended configurations for each archive manager for the projects
updated from the previous versions of powermanager and new projects considering the number of devices in
the system.

Table 8-4 Recommended Archive Configurations for 100 Devices

Archive Name 100 Devices (Default)
DP
Elements

DP
Number

Frequency Change Free
Entries

Deletion Compres-
sion Time
Offset

1 Instantaneous Values 1 3800 5000 24x daily 10 2400 720
2 Instantaneous Values 2 4600 5000 24x daily 10 2400 300
3 Power Demand

Consumption Values
5000 4000 1x weekly 720 260 300

4 Commands 2600 500 1x monthly 10 12 300
5 Binary Status 500 500 1x monthly 10 12 300
6 Energy Consumption

Values
22 000 800 1x monthly 10 60 3600

7 Instantaneous Values 3 4500 5000 24x daily 10 2400 1800
8 Instantaneous Values 4 5000 5000 24x daily 10 2400 300
9 Manual Measuring Values 500 3000 1x monthly 10 60 3600

Polling rate for Instanta-
neous values

1 s

Polling rate for Energy
values

10 s

Driver Smoothing Disabled

Table 8-5 Recommended Archive Configurations for 200 Devices

Archive Name 200 Devices
DP
Elements

DP Number Frequency Change Free
Entries

Deletion Compres-
sion Time
Offset

1 Instanta-
neous
Values 1

7600 2500 24x daily 10 2400 720

2 Instanta-
neous
Values 2

9200 2500 24x daily 10 2400 300

3 Power
Demand
Consump-
tion Values

10 000 4000 1x daily 120 2000 300

4 Commands 5200 500 1x monthly 10 12 300
5 Binary

Status
1000 500 1x monthly 10 12 300

8.11
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Archive Name 200 Devices
DP
Elements

DP Number Frequency Change Free
Entries

Deletion Compres-
sion Time
Offset

6 Energy
Consump-
tion Values

42 000 800 1x monthly 10 60 3600

7 Instanta-
neous
Values 3

9000 2500 24x daily 10 2400 1800

8 Instanta-
neous
Values 4

10 000 2500 24x daily 10 2400 300

9 Manual
Measuring
Values

1000 3000 1x monthly 10 60 3600

Polling rate
for Instanta-
neous
values

2 s

Polling rate
for Energy
values

10 s

Driver
Smoothing

Disabled

Table 8-6 Recommended Archive Configurations for 500 Devices

Archive Name 500 Devices
DP
Elements

DP Number Frequency Change Free
Entries

Deletion Compres-
sion Time
Offset

1 Instanta-
neous
Values 1

19 000 1000 24x daily 10 2400 720

2 Instanta-
neous
Values 2

23 000 1000 24x daily 10 2400 300

3 Power
Demand
Consump-
tion Values

22 000 2000 1x daily 120 2000 300

4 Commands 13 000 500 1x monthly 10 12 300
5 Binary

Status
2500 500 1x monthly 10 12 300

6 Energy
Consump-
tion Values

35 000 800 1x monthly 10 60 3600

7 Instanta-
neous
Values 3

22 500 1000 24x daily 10 2400 1800

8 Instanta-
neous
Values 4

25 000 1000 24x daily 10 2400 300
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Archive Name 500 Devices
DP
Elements

DP Number Frequency Change Free
Entries

Deletion Compres-
sion Time
Offset

9 Manual
Measuring
Values

2500 3000 1x monthly 10 60 3600

Polling rate
for Instanta-
neous
values

5 s

Polling rate
for Energy
values

20 s

Driver
Smoothing

Enabled 1 %

Table 8-7 Recommended Archive Configurations for 1000 Devices

Archive Name 1000 Devices
DP
Elements

DP Number Frequency Change Free
Entries

Deletion Compres-
sion Time
Offset

1 Instanta-
neous
Values 1

38 000 500 24x daily 10 2400 720

2 Instanta-
neous
Values 2

46 000 500 24x daily 10 2400 300

3 Power
Demand
Consump-
tion Values

45 000 950 1x daily 120 2000 300

4 Commands 26 000 500 1x monthly 10 12 300
5 Binary

Status
5000 500 1x monthly 10 12 300

6 Energy
Consump-
tion Values

45 000 800 1x monthly 10 60 3600

7 Instanta-
neous
Values 3

45 000 500 24x daily 10 2400 1800

8 Instanta-
neous
Values 4

50 000 500 24x daily 10 2400 300

9 Manual
Measuring
Values

5000 3000 1x monthly 10 60 3600
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Archive Name 1000 Devices
DP
Elements

DP Number Frequency Change Free
Entries

Deletion Compres-
sion Time
Offset

Polling rate
for Instanta-
neous
values

10 s

Polling rate
for Energy
values

20 s

Driver
Smoothing

Enabled 1 %

Additionally, the following conditions apply to projects that are updated from previous versions:

• If the number of devices in the project ≤ 200
– The archive configurations of the existing devices are unchanged.
– A predefined set of datapoints for each device is archived for new devices.

• If the number of devices in the project > 200
A predefined set of datapoints for each device is archived for existing and new devices.

The following table contains the list of the predefined datapoints that are archived:

Table 8-8 Predefined Datapoints

Main Group Subgroup Element Name
PAC1200 - Controller Energy Values Active energy import tariff1
PAC1200 - Sensors Energy Values Active energy import
PAC1500 Energy Values Collective active energy import tariff1
PAC2200 Power Interval cumulated_active_power_import_EM

Energy Values active_energy_import_tariff_1
PAC3100 Power Interval cumulated_active_power_import_EM

Energy Values active_energy_import_tariff_1
PAC3200 Power Interval cumulated active power import

Energy Values active energy import tariff 1
PAC3200T Power Interval cumulated_active_power_import_EM

Energy Values active_energy_import_tariff_1
PAC4200 Energy active_energy_import_tariff_1

Power Interval cumulated active power import
Power Interval information_flag_bytes_act_period
Power Interval real_load_profile_period_length_act_period
Power Interval real_load_profile_subinterval_length_act_period
Power Interval OID_act_period_unique_period_entry_identification_index

PAC5200; PAC 5100; P850;
P855

Power Interval avg_collective_active_power_EM
Energy Values active_energy_import_tariff_1

SEM3 - Controller Energy Values Total system active energy
SEM3 - Sensors Energy Values Active energy import tariff1

Energy Values Total active power demand
3VA27; 3WL10 Energy Values active_energy_import_tariff_1
3VAETU8 Power Interval cumulated_active_power_import_act_period

Energy Values active_energy_import_tariff_1
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Main Group Subgroup Element Name
3WL Energy Values active_energy_import
7KT1651 Energy Values active_energy_import_tot
7KT1661 Energy Values active_energy_import_tot
7KT1665 Energy Values active_energy_import_tot
7KT1682 Energy Values active_energy_import_tot
GMB Power Interval cumulated_active_power_import_EM

Energy Values active_energy_import_tariff_1

ii
NOTE
The Energy and the Power Interval values are archived for each existing device. Siemens recommends
reviewing the archive configuration after the upgrade to V3.5.
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SENTRON MindApp
The device values recorded in powermanager can be transferred to SENTRON MindApp. For this, the SENTRON
MindApp component of powermanager has a JSON import/export functionality. Initially, a request file
containing the following is created from powermanager:

• Details of all the devices in the system

• Device types

• Topology information
The request JSON file is generated using the export JSON option.
The request JSON file exported can be viewed in the SENTRON MindApp. You can select the devices and the
data to be transferred to SENTRON MindApp during the onboarding process. A response JSON file is then
generated from SENTRON MindApp and this JSON file can then be imported back to powermanager.
Once the response JSON file is imported, the selected devices in the response JSON file are onboarded to the
SENTRON MindApp and the data transmission from powermanager to SENTRON MindApp is initiated. The data
transmission occurs based on the intervals specified in the response JSON file.

Configuring the SENTRON MindApp Functionality
To transfer the values to SENTRON MindApp, you must first export the request JSON file. To do this, proceed
as follows:
² In the project tree view, right-click the project tree root.

² In the context menu, click System settings.
The System settings page opens.

² Click the MindApp Configuration tab.

8.12

Settings and Configurations
8.12 SENTRON MindApp

340 powermanager,  , Help
E50417-H1076-C550-A7, Edition 06.2019



[sc_mindsphere, 1, en_US]

² Under Export JSON File, click Export.
² Click OK in the Information pop-up window.
The request JSON file is created.

Import the Response JSON file to Complete the Process

² In the project tree view, right-click the project tree root.

² In the context menu, click System settings.
The System settings page opens.

² Click the MindApp Configuration tab.

Settings and Configurations
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² Under Import JSON File, select the file to be imported and click Import.
² In the Information pop-up window, click OK.
The devices and their onboarding status and last transferred status are displayed in a table.

ii
NOTE
If you try to import a JSON file after a successful import, the system displays a warning message. If you
select to continue, the existing configuration will be lost.

Settings and Configurations
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Extended Help
For additional information on powermanager components such as Administration panel, Console panel,

System management, click  in the Administration panel or the Console panel.

9.1

Extended Help
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